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User manual

STM32CubelDE user guide

Introduction

STM32CubelDE is an all-in-one multi-OS development tool, and is part of the STM32Cube software ecosystem. It contains an
advanced C/C++ development platform supporting software development of STM32-based products.

This document details the STM32CubelDE features and usage, including how to get started, create and build projects, debug
with standard and advanced techniques, and many other software analysis solutions. STM32CubelDE is based on the Eclipse
C/C++ Development Tools™ (CDT™) and GCC toolchain, which cannot be entirely described in this user manual. Additional
information on Eclipse® is available from the STM32CubelDE embedded help system. Special documents covering the details
of the toolchain and GDB servers are included within the product.
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For further information contact your local STMicroelectronics sales office.


https://www.st.com/en/product/stm32cubeide?ecmp=tt9470_gl_link_feb2019&rt=um&id=UM2609
https://www.st.com/stm32cube
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Getting started

STM32CubelDE supports STM32 products based on the Arm® Cortex® processor. Refer to STMicroelectronics
documents listed in Section 11 References for details.

Note: Arm is a registered trademark of Arm Limited (or its subsidiaries) in the US and/or elsewhere.

arm

1.1 Product information

STM32CubelDE is an advanced C/C++ development platform with peripheral configuration, code generation,
code compilation, linking, and debug features. It is based on the Eclipse®/CDT™ framework and GCC toolchain
for the development, and GDB for the debugging. It allows the integration of the hundreds of existing plugins that
complete the features of the Eclipse® IDE.

STM32CubelDE integrates ST MCUFinder (ST-MCU-FINDER-PC) and STM32CubeMX functionalities to offer
all-in-one tool experience. It makes it easy to create new STM32 MCU or board projects and build them using the
included GCC toolchain.

STM32CubelDE includes a build analyzer and a static stack analyzer that provide the user with useful information
about project status and memory requirements.

STM32CubelDE also includes standard and advanced debugging features including views of CPU core registers,
memories, and peripheral registers, as well as live variable watch, and serial wire viewer interface. A fault
analyzer displays error information if an error is triggered by the STM32 processor during a debug session.

Figure 1. STM32CubelDE key features
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1.1.1 System requirements
STM32CubelDE is tested and verified on the Microsoft® Windows®, Linux®, and macOS® operating systems.

Important: ~ STM32CubelDE supports only 64-bit OS versions. For more details about supported versions of operating
systems, refer to [ST-02].

Note: macOS® is a trademark of Apple Inc., registered in the U.S. and other countries and regions.
Linux® is a registered trademark of Linus Torvalds.

1.1.2 Downloading the latest STM32CubelDE version
The latest version of STM32CubelDE is available for free download from the www.st.com/stm32softwaretools
website.

1.1.3 Installing STM32CubelDE

The STM32CubelDE installation guide [ST-04] gives directions on how to install on supported versions of
Windows®, Linux® and macOS®. It is possible to have several versions of STM32CubelDE installed in parallel.
Read the installation guide if STM32CubelDE is not already installed or if a new version must be installed.
Installing updates and additional Eclipse plugins in this manual also provides information on how to install
updates.

1.1.4 License

STM32CubelDE is delivered under the Mix Ultimate Liberty+OSS+3rd-party V1 software license agreement
(SLA0048).

For more details about the license agreement of each component, refer to [ST-02].

1.1.5 Support

There are several different support options provided by STMicroelectronics. For instance, the ST Community is
offering places to meet people with similar mind-set all over the world at any time. Choose the support option by
visiting www.st.com/content/st_com/en/support/support-home.html.

1.2 Using STM32CubelDE

1.21 Basic concept and terminology
The basic concept using STM32CubelDE and Eclipse® terminology is outlined in this section.

Workspaces

When starting STM32CubelDE, a workspace is selected. The workspace contains the development environment
to be used. Technically, the workspace is a directory that may hold projects. The user may access any project
within the active workspace.

A project contains files, which may be organized into sub-directories. Files existing somewhere else on the
computer can also be linked to the project.

A single computer may hold several workspaces at various locations in the file system. The user may switch
between workspaces, but only one workspace can be active at a time. Switching workspace is a quick way of
switching from one set of projects to another.

In practice, the workspace and project model facilitate a well-structured hierarchy of workspaces, containing
projects, which in turn contain files.

Information center

The first time STM32CubelDE is started and a workspace is selected, the Information Center is opened. The
Information Center provides quick access to start a new project, get access to videos, read STM32CubelDE
documentation, or get access to ST support and community. The Information Center can be easily accessed at
any time via the Information Center toolbar button or from the Help menu.
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Perspectives, menu bar, toolbar

When the Information Center is closed, STM32CubelDE displays a perspective, which contains a menu bar,
toolbar, views and editors. Each perspective is optimized for a special type of work. For instance, the C/C++

perspective is meant for creating, editing and building projects. The Debug perspective is intended to be used
when debugging code on hardware.

Each perspective can be customized according to the user's need. It is possible to reset the perspective at any

time if, for instance, too many views are opened or if the views are reordered. It is also possible to create new
perspectives.

Views and editors

A perspective normally displays many views. Each view is developed to present specific information, which for
instance can be collected from the project or from an embedded system under debug.

A perspective has one editor area. The editor can be used to edit project files. Many files can be edited in different
tabs in the editor.

STM32CubelDE window

Figure 2. STM32CubelDE window
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1.2.2 Starting STM32CubelDE
Start STM32CubelDE by performing the following steps depending on the operating system used.

Windows®

If a desktop shortcut is created during the installation of the product, the shortcut can be used to start

STM32CubelDE. The product can also be started from the Windows® start menu under STMicroelectronics
programs.

Otherwise:

1.  Locate where STM32CubelDE is installed, for instance in C: \ST\STM32CubeIDE 1.0.2
2. Open the STM32CubelDE folder

3. Startthe stm32cubeide.exe program

Linux® or macOS®

When using Linux® or macOS®, the program can be started in a similar way by opening the STM32CubelDE
folder where the product is installed.

STM32CubelDE Launcher

When the product is started, it displays the STM32CubelDE Launcher dialog with workspace selection. The first
time the product is started, it presents a default location and workspace name. The dialog enables the user to
select the name and location of the active workspace for holding all the projects currently accessible by the user.
Any newly created project is stored in this workspace. The workspace is created if it does not yet exist.

Note: If Windows® is used, avoid locating the workspace folder too many levels below the file system root to avoid
exceeding the Windows® path length character limitations. Build errors occur if the file paths become longer
than what Windows® can handle.

Figure 3. STM32CubelDE Launcher — Workspace selection

[CE sTM32CubelDE Launcher X

Select a directory as workspace

STM32CubelDE uses the workspace directory to store its preferences and development artifacts.

LWL EIL-HMIC:\Users\abc\STM32Cubel DE\workspace_um V‘ | Browse...

[JUse this as the default and do not ask again

» Recent Workspaces

| Launch | | Cancel

Click on the [Launch] button to launch STM32CubelDE. The first time, it opens the Information Center, which is
described in Section 1.3 Information Center.
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1.23 Help system
The Help menu provides several different help systems as seen in Figure 4. The Information Center contains links
to all available STM32CubelDE documentation. It is also recommended for new users to try different Eclipse®
built-in help systems to get an understanding of Eclipse® basics.

Figure 4. Help menu

irce Refactor Navigate Search Project Run Window Help
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@ Help Contents
% Search
Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
“x Tips and Tricks...
Cheat Sheets...

1.3 Information Center
The Information Center provides quick access to:
Start a new project
Import an existing project
Get access to videos
Read STM32CubelDE documentation
Get access to Getting Started with STM32CubelDE (STM32CubelDE quick start guide [ST-03])
Explore the STM32 MPU and MCU wikis
Get access to STMicroelectronics support and community on Twitter™, Facebook™, YouTube™, or ST
community at community.st.com
8.  Explore the STMicroelectronics application tools

It is not required to read all material before using the product for the first time. Rather, it is recommended to
consider the Information Center as a collection of reference information to return to, whenever required.

Noakowbh-=

1.3.1 Accessing the Information Center
The Information Center can easily be accessed at any time, from any perspective, using the [Information Center]

toolbar button & _ This icon is located at the right of the toolbar. It is also possible to open the Information Center
from the [Help]>[Information Center] menu command.

Figure 5. Help - Information Center menu
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v | 8 Information Center 4R
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1.3.2 Home page

When the Information Center is opened, the Home page is displayed. It contains links to start a new project,
import projects, read documentation and access STMicroelectronics support and community.

Figure 6. Information Center - Home page
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When using an old workspace, the Information Center may not display valid information, showing “This page can’t
be displayed” or opening old manuals when accessing documents. In such case, reload the page by clicking on

the [Home] button @ at the top right corner of the Information Center window.
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Videos

The Information Center also contains a video browser page, which is opened from the Home page when clicking
on the Access to videos link.

Figure 7. Information Center — Video browser page

[ workspace - STM32CubelDE - m] X
Eile Edit Source Refactor Navigate Search Project Run  Window Help

5 @) Information Center 52

@ & smazcubelDE Home

How to use STM32CubelDE

Find out more information on our website: CubelDE

To read our blog: hitp://bit Iy

STM32CubelDE is an advanced C/C++ development platform with IP configuration, code
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Scroll through the Videos page and click on a video thumbnail in the list to open it in a web browser. The videos
are listed in groups:

. STM32CubelDE Tutorials

. STM32CubeMX

. Discover your STM32 with STM32CubelDE

To navigate back to the Home page, press STM32CubelDE Home at the top left of the Information Center.

Perspectives, editors and views
STM32CubelDE is a powerful product with many views, loaded with various features. Displaying all views
simultaneously would overload the user with information that may not be relevant to the task at hand.

To overcome such a situation, views can be organized in perspectives, where a perspective contains a number
of predefined views and an editor area visible by default. A perspective typically handles one development task,
such as C/C++ Code Editing or Debugging.
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1.4.1 Perspectives

The perspectives can be customized according to the user's need; Views can be moved, resized and new views
can be opened. It is possible to reset the perspective at any time if, for instance, too many views are opened or if
the views are reordered. The perspective is reset by right-clicking the perspective icon in the toolbar and selecting
[Reset] from the list. This resets the views; Added views in the perspective are closed and the default views are
moved to their original location.

Figure 8. Reset perspective

ccess| | & || % 0 @8
Customize...
Save As...
Reset

Close

Show Text

As seen in Figure 8, it is also possible to customize a perspective and save the perspective with a new name.

Switching from one perspective to another is a quick way to hide some views and display others. To switch
perspective, select the [Open Perspective] toolbar buttons at the right of the toolbar.

Figure 9. Toolbar buttons for switching perspective

| @0

Another way to switch perspective is to use the menu command [Window]>[Perspective]>[Open
Perspective]>[Other...] and select the perspective to use.

1.4.1.1 C/C++ perspective

The C/C++ perspective is intended for creating new projects, editing files, and building the project. The left part
of the perspective contains the Project Explorer view. The editor is located in the middle. The right part contains
some views for the project (Outline and Build Targets views). At the bottom in the example illustrated in Figure 10,
there are the Problems, Tasks, Console and Properties views. At the lowest right, the Build analyzer and Static
stack analyzer views are displayed.
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Figure 10. C/C++ perspective
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Debug perspective
The Debug perspective is intended for debugging the code. The Debug perspective is normally opened
automatically when a new debug session is started. Later, when the debug session is closed, the perspective
is switched back to the C/C++ perspective.
Figure 11. Debug perspective
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Device Configuration Tool perspective

The Device Configuration Tool perspective contains the STM32CubeMX device configuration tool integrated in
STM32CubelDE. This perspective is used for device configuration. When an * . ioc file is opened in an editor

and the Device Configuration Tool perspective is used, the device can be configured in this perspective. How the
device configuration is made is described in [ST-14].

Figure 12. Device Configuration Tool perspective

[ worksoace_um - Devica Configuration Toal - STMA2CubelDE - a x

File Edt Nevigste Sesrch Project Aun Window Help

R L R R T P R R

£ Project Explorer 2% 79 mhu

~ [ NICLED- FamRE
» i Bnares

B Inchuckes
v 8 Cor
e
- e
» 3 maine
& stz ol ropc

Analog >
Timers

Comecivty

Mutimedia

Computing

= Debug

# NUCLED #4901 RE2ifaunch

I NUCLEO-Fa01RE e

8 STNAZFATTRETY FLASHI 51 Bue Fuskf ]
s STM32FATTRETK RaMId

Middieware

STM32F401RETx
LQFP64

s v (009

e -
S

Remote System Explorer perspective

The Remote System Explorer perspective is basically used when developing STM32 Arm® Cortex® MPU-based
systems. The Remote Systems view is used to view files and the Remote Shell view is used to run commands.
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Figure 13. Remote System Explorer perspective

mworkspace,urm - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - [m] X
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v Ef Local 20 /** W mainh ~
© % Local Files 3 B LT T L LT TR 8 malloch
> My Home 4 T Ofile i ® huart2 | UART Har
v o Drives 5 @brlef ot Malv program body ) ) ) ) ) @ © VERSION_NUMBEF
3 Qe 6 B e e © € CRC NUMBER
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* i |
> 2D\ ; 7 @attention ® “BUILD_ID : const u
@ Di o
VGLocal Shells 9 * <h2><center>&copy; Copyright (c) 2019 STMicroelectronics. ° Distance : uint32.{
Focal 10 * All rights reserved.</center></h2> b Seconds : uint32. 4
11 * ++ SystemClock_Conf
oS .
12 * This software component is licensed by ST under BSD 3-Clause license, ﬂSMXfGNOJ”'t(""'d
13 * the "License"; You may not use this file except in compliance with the 7 MX_USART2_UART
14 * License. You may obtain a copy of the License at: ® ip:int
15 * opensource.org/licenses/BSD-3-Clause ® ramx:int
e . ® mylP_read() : int
17 R KRR K R K K K KK R R K R R K R K KK KR R s B aDAM raadn - in
< > < >
8 Remote System Details 2] Tasks | [E: Remote Shell &2 L EPEEE Y =0
B Local i2 |
[w)09/19/2019 @6:34 PM 424,456 stm32cubeide.exe ~
Q09/19/2619 06:43 PM 464 stm32cubeide.ini
[w09/19/2019 @6:34 PM 129,544 stm32cubeidec.exe
09/23/2619 10:33 AM 600,878 uninstall.exe
< > 8 File(s) 1,306,519 bytes
= = 10 Dir(s 599,160,823,808 bytes free
=] Properties 52 (3, Remote Scratchpad = 2 T Y
RERR Y B C:\ST\STM32CubeIDE_1.1.0.19w38_targetplatform_2019-09\STM32CubeIDE>
Property Value
Name C\ST\STM32CubelDE_1.1.0.19w38._... P C:\ST\STM32CubeIDE_1.1.0.19w38_targetplatform_2019-09\STM32CubeIDE> ©
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Type prompt
Command ol K
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The Remote Systems view contains buttons to open a new connection via FTP, Linux®, Local, SSH, Telnet and
others.

Figure 14. New connection

[Z New Connection O X

Select Remote System Type

Local file system on this computer

System type:

v [ General
T FTP Only
ﬁ Linux
=l Local
3 SSH Only
GTeInet Only (Experimental)
Uniz Unix
i Windows

@
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1.4.2 Editors

The editor area in a perspective is used by editors. Any number of editors can be opened simultaneously but only
one can be active at a time. Different editors can be associated with different file extensions. Example of editors
are; c-editor, linker script editor, ioc-file editor for STM32CubeMX device configuration.

To open a file in the editor, double-click on the file in the Project Explorer view or open the file via the [File] menu.
When a file is modified in the editor,it is displayed with an asterisk (*) indicating that the file has unsaved changes.

1.4.3 Views

Only the most common views associated with the perspective are displayed by default. There are many more
views in the product supporting different features. Some of these views only provide valid data when a debug
session is ongoing, while others always display data.

Views can be opened from the [Window]>[Show View] menu by selecting one of the views in the list.

Figure 15. [Show View] menu

Eworkspace_um - NUCLEO-F401RE/Core/Src/main.c - STM32CubellC

File Edit Source Refactor Navigate Search Project Run Window

Nyl vy _ v @ig v el v [ New Window

& Project Explorer = & B ¥°=0 @y 2 ’
v [T NUCLEO-F401RE Appearance ’

i Build Analyzer Show View >

) Build Targets Perspective 5

1 C/C++ Projects o

I Console Alt+Shift+Q, C LD ’

¢ Include Browser Preferences
Navigator o h

© Outline Alt+Shift+Q, 0 <h2><center>&

" Problem Details 2 : All rights re
Problems Alt+Shift+Q, X 2 * This software

1 Project Explorer 3 * the "License"

I Properties 4 * License. You

~ Search Alt+Shift+Q, S 5  *

i SFRS 6 :**************
Static Stack Analyzer ; y

e 9 /* USER CODE END
Other... Alt+Shift+Q, Q

‘ z1l /* Includes -----
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The above list of views in Figure 15 is still not complete. It contains only the most common views for the work
task related to the perspective currently selected. To access even more views, select [Other...] from the list. This
opens the Show View dialog box. Double-click on any view to open it and access its additional features.

Figure 16. Show View dialog

[ZE show View O X

type filter text

> = C/C++

> = Connections

> = General

> = Debug

> = Device Configuration Tool
> & Help

> & Make

» = Remote Systems
v = SWV
“L SWV Data Trace
l.- SWV Data Trace Timeline Graph
l- SWV Exception Timeline Graph
B SWV Exception Trace Log
& SWV ITM Data Console
= SWV Statistical Profiling
B SWV Trace Log
> = Team

Open _ Cancel

The views can be resized and their positions can be changed: Simply drag the view to a new place in
STM32CubelDE. The view can also be dragged outside the STM32CubelDE window on the screen. Such
detached views are shown in separate windows. Detached views works like the other views but are always shown
in front of the workbench. Detached views can be attached again by dragging the tab in the detached view into
the STM32CubelDE window.

To restore the perspective to original state, right-click the perspective icon in the toolbar and select [Reset] from
the list. Another way to reset the perspective is to use the menu [Window]>[Perspective]>[Reset Perspective].
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1.4.4 Quick Access edit field

The magnifying glass in the toolbar opens the Quick Access text box, where any search phrase or keyword can
be entered. GUI objects like menu commands, toolbar buttons, preference settings or views can be found using
the text box. As any search string is typed, the Quick Access shows all the GUI objects that match the criteria, in
real time. Type a couple of characters or more and see how the list of results is refined correspondingly on-the-fly.

The Quick Access is a time saver when looking for a specific GUI object that cannot be found quickly otherwise,
such as a preference setting deeply buried in the configuration dialogs. It is also convenient to retrieve a menu
command or toolbar button hidden in the currently active perspective.

For example, in Figure 17, the search string “SWV” entered in the Quick Access provides immediately the list of
matching views, GUI commands and preference settings. To open the view or preference setting, click on the GUI
object in the search result list.

Figure 17. Quick access

. Q g G+
SWV -]
Views ‘4 SWV Data Trace (SWV)
L= SWV Data Trace Timeline Graph (SWV)
L= SWV Exception Timeline Graph (SWV)
& SWV Exception Trace Log (SWV)
B SWV ITM Data Console (SWV)
£ SWV Statistical Profiling (SWV)
£ SWV Trace Log (SWV)
@ Config - Configure SWV
® Show In (SWV Data Trace Timeline Graph)
@ Show In (SWV Data Trace)
® Show In (SWV Exception Timeline Graph)
@
@
@
@
e
@
@
@
@
®
e

Commands

Show In (SWV Exception Trace Log)
Show In (SWV ITM Data Console) bl
Show In (SWV Statistical Profiling)
Show In (SWV Trace Log)
Show View (SWV Data Trace Timeline Graph) - Shows a particul
Show View (SWV Data Trace) - Shows a particular view
Show View (SWV Exception Timeline Graph) - Shows a particul:
Show View (SWV Exception Trace Log) - Shows a particular viev
Show View (SWV ITM Data Console) - Shows a particular view
Show View (SWV Statistical Profiling) - Shows a particular view
Show View (SWV Trace Log) - Shows a particular view

Help % Search 'SWV' in Help
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1.5 Configuration - Preferences

STM32CubelDE can be customized in many ways. The menu [Window]>[Preferences] is used to open the
Preferences dialog. In this dialog, the left pane is used to navigate to certain preference pages. There is also a
filter field, which can be used to narrow down the content displayed. The arrow controls on the upper-right side
of the dialog can be used to navigate back and forth across pages. The right pane contains the setting of the
displayed preferences. Make any preferred change and press [Apply] to update the setting.

[Restore Defaults] resets all changes. The preference settings are stored in a metadata folder in the workspace
of the application. Section 1.7 Managing existing workspaces in this user manual provides information on how to
backup preferences and copy preferences across workspaces.

Figure 18. Preferences

E Preferences O X
|type filter text | C/C++ GOvoo v w
> General
> C/C++ General settings for C/C++ development:
> Help _ _
> Install/Update Outline view
> Remote Development [ Follow unindexed header files when producing the outline view

> Remote Systems
> Run/Debug
> STM32Cube
> Team Refactoring C/C++ code

Note: Enabling this preference may have negative impact on performance.

Terminal [] save all modified resources automatically prior to refactoring

Rename in editor without dialog

C/C++ dialogs

Clear all 'do not show again' settings and show all hidden dialogs again

‘ Restore Defaults H Apply ‘

@ [\Q ﬁ | Apply and Close | ‘ Cancel ‘

It is advised to walk through the preferences pages and get an understanding of the possible configuration
options. The following sections present some of them.
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1.5.1 Preferences - Editors

The editor can be configured in many ways. For instance, the menu selection [General]>[Editors]>[Text Editors]
provides a Preferences pane containing general editor settings such as:

. Displayed tab width

. Insert spaces for tabs
. Highlight current tab

. Show line numbers

. Others
Figure 19. Preferences - Text Editors
L preferences O X
line Text Editors Loy
v General
Compare/Patch Some editors may not honor all of these settings.
v Fditors See ‘Colors and Fonts' to configure the font
Text Editors ee 'Colors and Fonts' to configure the font.
Workspace o hi o
v C/C++ Undo history size: 200

v Editor Displayed tab width:

Scalability D Insert spaces for tabs
Syntax Coloring Highlight current line
[IShow print margin
Print margin column; 80
Allow editors to override the margin column
[ show line numbers
Show range indicator
[Ishow whitespace characters (configure visibility)

Show affordance in hover on how to make it sticky

When mouse moved into hover: Enrich after delay -~

Enable drag and drop of text
M Warn before editing a derived file
Smart caret positioning at line start and end

Appearance color options:

Line number foreground Color:

Current line highlight

Print margin

Find scope

Selection foreground color
Selection background color
Background color
Foreground color
Hyperlink

More colors can be configured on the 'Colors and Fonts' preference page.

‘ Restore Defaults ‘ ‘ Apply ‘

@ Eﬁﬂ ﬂ’z‘ﬂ | Apply and Close | ‘ Cancel ‘
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1.5.2 Preferences - Code style formatter
It is possible to configure the editor to use special formatting.

The menu selection [C/C++]>[Code Style]>[Formatter] provides a Preferences pane containing settings to set an
active profile.

Figure 20. Preferences - Formatter

[T preferences O X
|type filter text | Formatter Py
Perspectives ~
Project Natures Configure Project Specific Settings...
Search Active profile:
> Security K&R [built-in] v Edit. Remove
» Startup and Shutdown
Ul Responsiveness Monitoring | New... ‘ ‘ Import... |
> User Storage Service Preview:
Web Browser /% ~
» Workspace * A sample source file for the code formatter preview
v C/C++ */
Appearance #include <math.h>
> Build
Code Analysis class Point {
v Code Style public:
Code Templates Point(double x, double y) :
Formatter x(x), y(y) {
Name Style }
> Organize Includes double distance(const Point& other) const;
Core Build Toolchains
> Debug double x;
v Editor double y;
» Content Assist 1 v
Folding
Hovers
Mark Occurrences v ‘ Restore Defaults ‘ | Apply ‘
@ M ﬂ’“ﬂ | Apply and Close | ‘ Cancel |
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At this point, if [Edit...] is pressed, a new dialog is opened, where the selected profile can be updated according
to specific coding rules. This is displayed in Figure 21.

Figure 21. Preferences - Code style edit

[ profile ‘GNU [built-in]' m} X

Profile name: ‘GNU [built-in] Export...

Indentation ~ Braces White Space New Lines Control Statements Line Wrapping Comments Off/On Tags

Brace positions Preview: [Jshow invisible characters

Class declaration: Next line v /* ~
* Braces

Namespace declaration: Next line v */

Function declaration: Next line v #include <math.h>

Blocks: Next line indented v int digits[] =
{e,1,2,3,4,5,6,7,8,91};

Blocks in case statement: Next line indented v P T T T T ’

‘switch' statement: Next line indented v zlass Point

Initializer list: ‘Next line indented v public:
Point (double x, double y) :
x (x), y (y)

[Keep empty initializer list on one line

{
}
double
distance (const Point& other) const;
int
compareX (const Point& other) const;
double x;
double y;
s

® Apply OK ‘ Cancel
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1.5.3 Preferences - Network proxy settings

STM32CubelDE uses the Internet for instance to get access to STM32 devices information. If a proxy server
is used for Internet access, some configuration settings are required in STM32CubelDE. The proxy settings are
set in the Preferences pane obtained through [General]>[Network Connections]. To change the settings, set

[Active provider] to Manual and update the Proxy entries for HTTP and HTTPS with specific Host, Port, User
and Password using the [Edit...] button.

Figure 22. Preferences - Network Connections

[T preferences [m} X
Network Network Connections SoHo
v General

v Network Connections Active Provider: Manual v
SSH2
Proxy entries
Schema Host Port Provider Auth User Password Edit...
HTTP Manual No Clear
HTTPS Manual No
SOCKS Manual No
[J HTTP  Dynamic Dyna.. Native No
Proxy bypass
Host Provider Add Host...
localhost Manual Edit
127.0.0.1 Manual
Remove
Restore Defaults ‘ Apply
® m ﬁzﬂ Apply and Close | ‘ Cancel
Note: If there is a problem to save the proxy settings, the reason can be a corrupt secure storage file. Proceed as

follows to solve the problem:
1. Close all running STM32CubelDE applications

2. Renamefile C: \Users\user name\.eclipse\org.eclipse.equinox.security\secure stora
ge to a new name

3. Restart STM32CubelDE

4.  Update the proxy network settings, with user and password information, and save them to create a new se
cure storage file
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Preferences - Build variables
The STM32CubelDE preferences feature build variables that are only visible in the IDE.

The menu selection [C/C++]>[Build]>[Build Variables] provides a Preferences pane with Build Variables, which
can be used as ${VAR} in STM32CubelDE. Enable [Show system variables] to display all available variables.

Figure 23. Preferences — Build variables

[ preferences *
type filter text Build Variables M
3 Genpral
w CiCes Namie Type Valse Add._
Appearanoe DeverData String Cywindows\Systemn 32\ Dinvers\DriverData Bt
~ Buld eclipse_home String <ECLIPSE DYNAMIC VARIABLE>
Buld Targets eny_var String <ECLIPSE DYNAMIC VARIABLE> e
Build Variables FPS_BROWSER_APP_PROFILE_STRING String Infernet Exploser
Console FPS_BROWSER_USER_PROFILE_STRING String Deefault
Environment gnu_arm_emibedded_comgiler_path String <ECLIPSE DYNAMIC VARIABLE>
Logging gru_tooks_for_stm32_compiler_path String <ECLIPSE DYNAMIC VARLABLE=
~ Makefile Editor HOMEDRIVE Steing c
Sutings 7] Show system varisbies
Setfings
Code Analysis
5 Code Style Build Variables are IDE anby variables, which can be used for siring substitution when defining external bulder configuration,
Core Build Toolchains such as environment variable value or command line parameter in form of ${VAR], intemal builder may use them directly,
b
itk = Restore Defailts Apply
D e Apply and Cloge Cancel

Table 1. Examples of toolchain build variables

gnu_tools_for_stm32_compiler_path

gnu_arm_embedded_compiler_path

stm32cubeide_make_path

Path to GNU Tools for STM32 toolchain.
Path to GNU Arm Embedded toolchain.

Path to make and BusyBox.

A pre-build step example using build variables to display toolchain version is given in Figure 24.

Figure 24. Pre-build step using build variables

v C/C++ Build
Build Variables
Environment

Run/Debug Settings

[ Properties for NUCLEO-FA0TRE O X

type filter text Settings 5w v 8

> Resource a
Builders

Configuration: |Debug [ Active ]

82 | ‘ Manage Configurations...

® Tool Settings #* Build Steps

Build Artifact Binary Parsers @ Error Parsers

Logging
Settings Pre-build steps
> C/C++ General Commang:
CMSIS-SVD Settings ‘ ${gnu_tools_for stm32_compiler pathj\arm-none-eabi-gcc.exe —-version - |
Project References Description:

‘ Display toolchain version

Post-build steps

Command:

Description:

Apply and Close | | Cancel
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1.6 Workspaces and projects
The basic concepts of workspaces and projects compares as follows:

. A workspace contains projects. Technically, a workspace is a directory containing project directories or
references to them.

. A project contains files. Technically, a project is a directory containing files that may be organized in
sub-directories.

. A single computer may hold several workspaces at various locations in the file system. Each workspace may
contain several projects.
. The user may switch between workspaces, but only one workspace can be active at one time.

. The user may access any project within the active workspace. Projects located in another workspace cannot
be accessed, unless the user switches to that workspace.

. The files included in a project do not need to be physically located in a folder in the project but can be
located somewhere else and linked into the project.

. Switching workspaces is a quick way of shifting from one set of projects to another. It triggers a quick restart
of the product.

In practice, the project and workspace model facilitates a well-structured hierarchy of workspaces, containing
projects, containing files.

1.7 Managing existing workspaces

The workspace can be selected when starting STM32CubelDE. It is also possible to switch to another workspace
during the use of STM32CubelDE. In this case STM32CubelDE restarts after the new workspace is selected. To
restart STM32CubelDE with a new workspace, select menu [File]>[Switch Workspace].

The workspaces known to STM32CubelDE can be managed by selecting [Window]>[Preferences] then, in the
Preferences dialog, selecting [General]>[Startup and Shutdown]>[Workspaces]. In the right pane, it is possible
to enable [Prompt for workspace on startup] and set [Number of recent workspaces to remember] to the
desired value.

Figure 25. Preferences - Workspaces

[T Preferences ] X
type filter text Workspaces pvopvw
v General ~

> Appearance Prompt for workspace on startup

Compare/Patch Number of recent workspaces to remember: | 10 5~
Content Types
> Editors
Globalization
Keys
Link Handlers
> Network Connections
Perspectives
Project Natures
Search
> Security
v Startup and Shutdown
Workspaces
Ul Responsiveness Monitoring
> User Storage Service
Web Browser
> Workspace
> C/C++
> Help
> Install/Update
> Remote Development
> Remote Systems

Recent workspaces

Remove

> Run/Debug v Restore Defaults Apply
® QI @ Apply and Close Cancel

It is also possible to select and remove recent workspaces from the list of recent workspaces. However, removing
a workspace from that list does not remove the files. Neither does it remove the files from the file system.
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1.71 Backup of preferences for a workspace

It is generally a good practice to take a copy of the existing preferences for a workspace. It can be especially
useful to recreate the workspace after a crash without the time-consuming process to redo the settings manually.

In the menu, select [File]>[Export]. Then, in the panel, select [General]>[Preferences]. Press the [Next] button
and, in the next page, enable [Export All] along with a correct filename.

1.7.2 Copy preferences between workspaces
To copy workspace preferences from one workspace to another, an existing export of preferences must first be
created as explained in Backup of preferences for a workspace.
Then select [File]>[Switch Workspace] and the new workspace. STM32CubelDE restarts and opens with the
new workspace.
In the menu, select [File]>[Import] and in the panel select [General]>[Preferences]. Press the [Next] button
and, on the next page, enable [Import All] and enter the file name. The preferences are now the same in both
workspaces.

1.7.3 Keeping track of Java heap space

To keep track on how much Java heap space is used, select the [Window]>[Preferences] menu. In the
Preferences page, select the [General] node and then enable [Show heap status]. The currently used and
available Java heap space is then displayed in the STM32CubelDE status bar. The garbage collector can also be
triggered manually from the status bar.

Figure 26. Display of Java heap space status

m Preferences u X
type filter text General QoY
v General ~

> Appearance Always run in background
Compare/Patch [JKeep next/previous editor, view and perspectives dialog open
Content Types Show heap status

> Editors

Workbench save interval (in minutes): ‘ 5

Globalization
Open mode

Keys
Link Handlers @® Double click

> Network Connections O single click
Perspectives Select on hover

2::2? Natures Open when using arrow keys
> Security
v Startup and Shutdown
Workspaces
Ul Responsiveness Monitoring
> User Storage Service
Web Browser
> Workspace
> C/C++
> Help
> Install/Update
> Remote Development

Note: This preference may not take effect on all views

> Remote Systems
> Run/Debug W

@ @ @ Apply and Close Cancel

Restore Defaults Apply

1.7.4 Unavailable workspace

Only one instance of STM32CubelDE can access one workspace at a time. This is to prevent conflicting changes
in the workspace. If STM32CubelDE is started with a workspace that is already used by another instance of the
program, the following error message is displayed.
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Figure 27. Workspace unavailable

mWorkspace Unavailable X

@ The default workspace 'C:/Users/ ~  /STM32CubelDE/workspace_um' is in use or cannot be
created. Please choose a different one.

‘ Retry ‘ | Choose |

If this message is displayed, choose a different workspace, or return to the already running STM32CubelDE.

1.8 STM32CubelDE and Eclipse® basics

STM32CubelDE contains so many features that it is easy to miss some really useful capabilities. Noteworthy
features are spell checking of C/C++ comments, word- and code completion, content assist, parameter hints and
code templates. The editor also includes an include-file dependency browser, code navigation using hypertext-
links, bookmark and to-do lists, and powerful search mechanisms. The next sections remind some of the useful
tools that can be easily missed.

1.8.1 Keyboard shortcuts

It is convenient to use keyboard shortcuts instead of the mouse. One important shortcut to know is the shortcut
Ctri+Shift+L. This shortcut opens a cheat sheet with all available shortcuts.

Figure 28. Shortcut keys

Activate Editor F12 LA

Backward History Alt+Left

Build All Ctrl+B

Build Target Build Shift+F9

Close Ctrl+F4

Close All Ctrl+Shift+F4

Collapse All Ctrl+Shift+Numpad_Divide

Content Assist Ctrl+Space

Context Information Ctrl+Shift+Space

Copy Ctrl+Insert

Cut Shift+Delete

Debug F11

Delete Delete

Expand All Ctrl+Shift+Numpad_Multiply

Find Text in Workspace Ctrl+Alt+G

Find and Replace Ctrl+F

Forward History Alt+Right

Last Edit Location Ctrl+Q

Maximize Active View or Editor Ctrl+M v
Press 'Ctrl+Shift+L' to open the preference page

Pressing Ctrl+Shift+L in this sheet opens the Keys pane in the Preferences dialog.
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Figure 29. Shortcut preferences

[T Preferences O X
‘type filter text Keys (=R =0 2 4
v General
7 Appearance Scheme: ‘Default v
Compare/Patch
Content Types ‘ type filter text
> Editors ~
Globalization Command Binding When Category User XD
Keys Activate Editor F12 In Windows Window
Link Handlers Add Block Comment Ctrl+Shift+/ C/C++ Editor C/C++ Source
> Network Connections Add Bookmark Edit
Perspectives Add Expression Group > Local Variable Run/Debug
Project Natures Add Expression Group > Registers Run/Debug
Quick Search Add Include Ctrl+Shift+N C/C++ Editor C/C++ Source
Search Add Memory Block Ctrl+Alt+M In Memory View Run/Debug
> Security Add RegisterGroup Register Grouping co...
> Startup and Shutdown Add Task... Edit
Ul Responsiveness Monit Add to Working Set Edit
> User Storage Service Align const qualifiers Ctrl+Shift+A C/C++ Editor C/C++ Source
Web Browser Apply Patch... Team
> Workspace Back Navigate v
> C/C++
7 Help Copy Command ‘ ‘ Unbind Command ‘ ‘ Restore Command Filters... ‘ ‘ Export CSV...
> Install/Update
> Remote Development
> Remote Systems Name: Activate Editor
» Run/Debug Description: | Activate the editor Conflicts:
7 STM32Cube Command When
> Team
Terminal Binding: | F12 | <
When: ‘In Windows v ‘
[ Show key binding when command is invoked
< N ‘ Restore Defaults ‘ ‘ Apply ‘
@ @ ﬁ | Apply and Close | ‘ Cancel ‘

The Keys pane offers the possibility to examine the shortcuts in detail and change the scheme (default, GNU
Emacs, or Microsoft® Visual Studio®), reconfigure shortcut keys, and others.
Table 2 presents the default bindings of some of the keys to mention.

Table 2. Key shortcut examples

Keyboard shortcut overview

Ctri+Shift+L List keyboard shortcuts | Lists all the defined keyboard shortcuts.

Navigation in files and C symbols

Ctrl+Shift+R Open resource Finds files from any perspective.

Searches for a keyword in a defined scope with the possibility

Ctri+H Search for keyword fo use reg. exp.
Alt+Enter View properties Views the properties for the selected resource.

Ctrl+Page up or Ctrl+Page down
Alt+— or Alt+—

Switch editor Switches to an open editor to the left or to the right.

Moves to an open editor by filtering text or selecting in the

Ctrl+E Select editor
menu.

Ctrl+Shift+T Search for elements _Searches for elements (such as functions, symbols, or others)
in workspace resources.

Ctri+Q Go to the last edit Goes to the editor, and to the position in this editor, where the

last edit was done.

UM2609 - Rev 6 page 25/245




3

UM2609

STM32CubelDE and Eclipse® basics

UM2609 - Rev 6

Navigation through file information

Navigates through large files from perspectives lacking an

Ctrl+O Quick outline ; .
outline view.
Ctri+L Go to line Goes to a line in the editor.
Ctri+F Search inside context | Searches within the file currently active in the editor.
Ctri+Alt+l Open include browser | Opens the include browser for the current resource.
Ctri+Alt+H Open call hierarchy Shovys how the function calls are made to and from a selected
function.
Ctri+Space Code completion Code completion using the parameter hints from the context

Parameter hints.

Code formatting and refactoring

Shift+Alt+A Toggle block select Edits one column across multiple rows.

Ctri+l Indent line Indents a source code line according to defined format rules.
. Format the selected .

Ctrl+Shift+F code Formats the source code according to defined format rules.

Shift+AIt+R Quick renaming Renames any C symbol across all the files in all open

projects.

Version control

Ctrl+Alt+C Commit resources Commits the modified files within the active context.

F11 Debug project Starts a debug session of the project currently active.

F8 Resume Continues the debugging process until the next breakpoint.

F5 Step into Steps into the next method call at the currently executing line
of code.

F6 Step over Steps over the next method call at the currently executing line
of code.

F7 Step return Returns from a method that has been stepped into.

Shift+F5 Reverse step into Steps into the last method call at the currently executing line
of code.

Shift+F6 Reverse step over Steps over the last method call at the currently executing line
of code.

Ctrl+R Run to a line Runs to the position of the cursor in the code.

Ctri+F2 Terminate Stops the debugging process.

Ctri+Alt+B Skip breakpoints Skips all breakpoints.

Good to know

Allows the users to define their own keyboard shortcuts. Also
[Window]>[Preferences]>[General]>[Keys] allows the choice of other keyboard shortcut schemes: GNU
Emacs, or Microsoft® Visual Studio®, or others.
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Editor zoom in and zoom out

It is possible to increase or decrease the default font size for text editors by pressing Ctrl++ and Ctrl+-:
. Ctrl++ : zoom in text
. Ctrl+- : zoom out text

If a keyboard with a numeric keypad is used and the + or — keys are pressed on the numeric keypad, use the
Shift key in addition to make the zoom work (Ctrl+Shift+ or Ctrl+Shift-).

Figure 30. Editor with text zoomed in

[ workspace_um1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - o X
File Edit Source Refactor Navigate Search Project Run Window Help
- HES - @i QG- [-C- i i®y - JRIE 1% - 00y @ Quick Access | ¢ (3| [E@ %
(25 Project Explorer ©¢ B® v -o = 0 | Bz outline 3 © Build Targets =0
> [EmyLib ~ ElRR o % ¥
v [ NUCLEO-F401RE . @ Distance : uint32_t -
» * Configure the system clock * N
> 3 Binaries ® Seconds: uint32 t
> Elincludes Sys‘temClock Config( ); +}sSystemcwock,Ccnﬁgqvcid).vum
v (B Core - ++5 MX_GPIO_Init(void) : void
> Einc ++5 MX_USART2_UART Init(void) : void
v s /* USER CODE BEGIN SysInit */ @ ipint
> [g mainc ® ramx:int
> [€] stm32f4xx_hal_msp.c ) ® mylP_read() : int
> [8 stm32f4xe ite /* USER CODE END SysInit */ © myRAM._read( : int
> [€ syscalls.c @ _binary_data_start : int
> [€ sysconfc L. . . . © _write(int, char”, int) : int
> [& sysmem.c /* Initialize all configured peripherals */ © main(void): int
> [€] system_stm32fdxx.c MX GPTO Tnit(): v @ SystemClock_Config(void) : void
> (= Startup < > © © MX_USART2_UART_Init(void) : void v
> B Drivers = =
> & bebug 9 Problems &) Tasks B) Console 5% [ Properties T B v [3v = O [ Build Analyzer 5% == Static Stack Analyzer o v=0
> (= Debug2 No consoles to display at this time. NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13 PM
> (& Release
[CINUCLEO-F401RE elf.cfg Memory Regions - Memory Details
5] NUCLEO-F401RE elfJaunch Region Startaddress  End address  Size Free
[ NUCLEO-F401RE oc EERAM 0x20000000  0x20018000 96 KB 94.27 KB
5 readme.txt EEFLASH 0x08000000  0x08010000 64 KB 537KB
& STM32F401RETX_FLASH_IPCodelnFlash.d EEFLASHD  0x08010000 008010800  2KB 199 KB
5 STM32F401RETX_FLASH_ORGd EEFLASHYV  0x0801f800 0108020000 2KB 199 KB
5 STM32F401RETX_FLASH_RAM_CODEId
& STM32F401RETX_FLASHId
\ﬂ STM32F401RETX_RAM.Id
> [ STM32F401_Ac6
< >
Writable Smart Insert 169:16:4028 a

Quickly find and open a file

Pressing Ctrl+Shift+R to find and open a file quickly is one of the featured easily missed. Type a couple of
characters part of the name of the file to open. It is possible to add the * and ? search wildcards as appropriate.
The editor then lists the matching filenames. Select the desired file in the search result list, and open the file using
any of these three ways:

. [Show In]: sends the file to one of the views chosen in the drop-down list (such as the #include file
dependency browser view)

. [Open With]: opens the file in the editor selected in the drop-down list
. [Open]: probably the most commonly used option, simply opens the file in the standard C/C++ editor
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Branch folding

A block of code enclosed within #1if and #endif can be folded. To activate the functionality, go to
[Window]>[Preferences], then [C/C++]>[Editor]>[Folding] and check the [Enable folding of preprocessor
branches (#if/#endif)] checkbox. Once the checkbox is checked, the editor must be restarted. Close the file,
open it again, and the small icon in the left margin of the editor showing that the functionality is activated.

Figure 31. Editor folding

[ Project Explorer &%
> [EmyLib
v [ NUCLEO-F401RE
> {‘;"Binaries
> [l Includes
v [ Core
> e
A=
> [£] main.c
> g stm32f4xx_hal_msp.c
> [€ stm32fdxc_itc
> [ syscalls.c
> [g] sysconf.c
> [g sysmem.c
> [] system_stm32fxx.c
> (= Startup
> [ Drivers
> (= Debug
> (= Debug2
> [=Release
[FINUCLEO-F401RE elf.cfg
=/ NUCLEO-F401RE.elf.launch
[ NUCLEO-F401RE.ioc
|2 readme.txt
[T STM32F401RETX_FLASH_IPCodelnFlash.ld
|1 STM32F401RETX_FLASH_ORG.Id
[T STM32F401RETX_FLASH_RAM_CODE.Id
|1 STM32F401RETX_FLASH.Id
[T STM32F40TRETX_RAM.Id
> [ STM32F401_Ac6

[T workspace_um?1 - NUCLEO-FAQTRE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help
Hu R AR R A0 A ER N YRV R

B® Y =0

B~ @ it @y IRE T8~ ooy e

[& mainc 97 =]
161 ~

162  /* USER CODE BEGIN Init */

163

164 /* USER CODE END Init */

165

166 /* Configure the system clock */
167 SystemClock_Config();

168

169 /* USER CODE BEGIN SysInit */
17e

171 /* USER CODE END SysInit */
172

173 /* Initialize all configured peripherals */
174 MX_GPIO_Init();

175© #ifdef TEST_MALLOC

176 mem3=malloc(12);

177 mem4=malloc(12);

178 mem5=malloc(12);

179 mem6=malloc(12);

180 mem7=malloc(12);

181 #endif

182

183 MX_USART2_UART_Init();
184 /* USER CODE BEGIN 2 */

185

186 mem=malloc(12);

187 mem2=malloc(12): v

< >
2 Problems ¥ Tasks EJ Console 53 [ Properties = O [@ Build Analyzer 52 == Static Stack Analyzer
#EY
No consoles to display at this time. PM
Memory Regions  Memory Details
Writable Smart Insert 1:1:0

NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13

- m] X

(quidcacesss || 18 [B4

Outline %2 @ Build Targets =8
R o % ¥

& mainh

& malloch

® huart2 : UART_HandleTypeDef

@ © VERSION_NUMBER : const uint32_t

® © CRC_NUMBER : const uint32._t

® “BUILD_ID : const uint16_t

® Distance : uint32 t

@ Seconds: uint32_t

++ SystemClock_Config(void) : void

++5 MX_GPIO_Init(void) : void

++ s MX_USART2_UART_Init(void) : void

ip:int

ramx : int

mylP_read() : int

myRAM_read() : int

_binary_data_start : int

_write(int, char*, int) : int

main(void) : int

SystemClock_Config(void) : void

® S MX_USART2_UART_Init(void) : void

© ¥ MX_GPIO_Init(void) : void

@ Error_Handler(void) : void

/ assert_failed(uint8_t*, uint32_t) : void

®v-o

Block selection mode

Alt+Shift+A toggles the selection mode between normal and block. When the block mode is enabled, use either
the mouse or the Shift+Arrow keys of the keyboard to select a block of text.

Use of the block selection mode

To start using the block selection mode, press Alt+Shift+A. Click somewhere in the text and drag down. A column
is then marked as shown in Figure 32.
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Figure 32. Editor block selection

25 Project Explorer i & v=0o

> [EmyLib
v [ NUCLEO-F401RE

> #¥ Binaries

> [l Includes

v [ Core

> e
v [=Src
> @ main.c

> g stm32f4xx_hal_msp.c
> [€] stm32fdxc_itc
> [ syscalls.c
> [ sysconf.c
> [ sysmem.c

> [] system_stm32fxx.c
> (= Startup
(2 Drivers
(= Debug
(zDebug2
[ Release
[FINUCLEO-F401RE elf.cfg
NUCLEO-F401RE.elf.launch
[T NUCLEO-F401RE.ioc
2 readme.txt
|3 STM32F401RETX_FLASH_IPCodelnFlash.Id
|1 STM32F401RETX_FLASH_ORG.Id
|3 STM32F401RETX_FLASH_RAM_CODE.Id
|1 STM32F401RETX_FLASH.Id

vvivy

mworkspace,urm - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

MRS R BN G E SO ik i@y RE T H ey O

[€] main.c 0%
/* USER CODE BEGIN Init */
/* USER CODE END Init */

/* Configure the system clock */
SystemClock_Config();

/* USER CODE BEGIN SysInit */

/* USER CODE END SysInit */

174 MX_GPIO_Init();
175 #ifdef TEST_MALLOC
mem3=malloc(12);
mem4=malloc(12);
memS=malloc(12);
mem6=malloc(12);
mem7=malloc(12);
181 #endif

MX_USART2_UART_Init();
/* USER CODE BEGIN 2 */

mem=malloc(12);
mem2=malloc(12):
<

=0

~

/* Initialize all configured peripherals */

>

- m] X

(quicaceess || 18 [B4

@) Build Targets =
ElRR o ¥ ¥

2= outline ¢

& mainh

& malloch

@ huart2 : UART_HandleTypeDef

@ © VERSION_NUMBER : const uint32_t
© ° CRC_NUMBER : const uint32.t

@ ©BUILD_ID : const uint16_t

® Distance : uint32. t

® Seconds: uint32_t

+ SystemClock_Config(void) : void
47 MX_GPIO_Init(void) : void

++ s MX_USART2_UART _Init(void) : void
ip:int

ramx : int

mylP_read() : int

myRAM _read() : int
_binary_data_start : int

_write(int, char*, int) : int
main(void) : int
SystemClock_Config(void) : void
°f MX_USART2_UART_Init(void) : void
°f MX_GPIO_Init(void) : void

@ Error_Handler(void) : void

/ assert_failed(uint8_t*, uint32_t) : void

54 STM32F401RETX_RAM.Id 1 Problems | Tasks B Console 2 [ Properties =0 Build Analyzer 52 == Static Stack Analyzer #v=0
> DsT32r401 Act B~ NUCLEO-FAOIRE.elf - /NUCLEO-FA01RE/Debug - Sep 23, 2019 2:05:13
No consoles to display at this time. PM
Memory Regions  Memory Details
 Wiitable | Smart Insert 176:3 (0] a
Add some text and see that this text is entered in all marked rows. As an example, the text “4y ”is added and
displayed in Figure 33.
Figure 33. Editor text block addition
[Z workspace_um1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - [m] X

INigid:

B® v=0

O-ER®-&% -~
5 Project Explorer i
> [ mytLib
v [ NUCLEO-F401RE
> $% Binaries
> [l Includes
v (£ Core
> =Inc
v (=S
> [€] mainc
> [i£] stm32f4xx_hal_msp.c
> [ stm32fdxc_itc
> [ig] syscalls.c
>
>

[& sysconf.c
[£] sysmem.c
> g system_stm32fdxx.c
> (= Startup
> [ Drivers
> (= Debug
> (= Debug2
> (= Release
[FINUCLEO-F401RE €lf.cfg
NUCLEO-F401RE.elf.launch
[ NUCLEO-F401RE.ioc
readme.txt
[ 38 STM32F401RETX_FLASH_IPCodelnFlash.ld
54 STM32F401RETX_FLASH_ORG.Id
34 STM32F401RETX_FLASH_RAM_CODE.Id
52 STM32F401RETX_FLASH.Id
[3h STM32F401RETX_RAM.Id
> [ STM32F401_Ac6

File Edit Source Refactor Navigate Search Project Run Window Help

TE v @G ritvi®s i dRIE N

€] *main.c &2
/* USER CODE BEGIN Init */
/* USER CODE END Init */

/* Configure the system clock */
SystemClock_Config();

/* USER CODE BEGIN SysInit */
/* USER CODE END SysInit */

174 MX_GPIO_Init();
1756 #ifdef TEST_MALLOC

176 My_em3=malloc(12);
177 My_mem4=malloc(12);
178 My_mem5=malloc(12);
179 My_fmem6=malloc(12);

My_pem7=malloc(12);
181 #endif

MX_USART2_UART_Init();
/* USER CODE BEGIN 2 */

186 mem=malloc(12);
187 mem2=malloc(12):
<

1 Problems & Tasks B Console 2[5 Properties

No consoles to display at this time.

=E-

REEASCICAIORu. il ]

=0

~

/* Initialize all configured peripherals */

= 0
Ind

Writable Smart Insert 180

:6[0]

PM

Memory Regions

5= Outline &2

6 Build Analyzer ©% == Static Stack Analyzer
&) y: y:

NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13

Memory Details

{Quick Access | {| g [ %6

@ Build Targets =8
BV o % v

' mainh

= malloch

® huart2 : UART_HandleTypeDef

@ © VERSION_NUMBER : const uint32_t

@ © CRC_NUMBER : const uint32_t

@ “BUILD_ID : const uint16.t

@ Distance : uint32_t

® Seconds: uint32_t

++ SystemClock_Config(void) : void

+ s MX_GPIO_Init(void) : void

H B MX_USART2_UART_Init(void) : void

ip:int

ramx : int

mylP_read() : int

myRAM_read() : int

_binary_data_start : int

_write(int, char®, int) : int

main(void) : int

SystemClock_Config(void) : void

ef MX_USART2_UART _Init(void) : void

© 9 MX_GPIO_Init(void) : void

@ Error_Handler(void) : void

A& assert_failed(uint8_t*, uint32_t) : void

®v=-o
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Selection and edition of areas

Select a block. In Figure 34, the block starting with “mem3” to “mem7” is selected.

Figure 34. Editor column block selection

mwcrkspace_um1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - [m] X

File Edit Source Refactor Navigate Search Project Run Window Help

H-HRS /- B NGO - &[Gt iBds

) DHUER R r=Ras il [quickAccess | 5|14

/* USER CODE BEGIN SysInit */

[¢5 Project Explorer 52 BS® Y =0 [ manc 2 = O | %2 outline X @ Build Targets =0
> [ myLib 161 ~ BN o % Y
v [ NUCLEO-F401RE 162  /* USER CODE BEGIN Init */ 2 mainh
> # Binaries 163 2 malloch
> [lincludes /* USER CODE END Init */ @ huart2 : UART_HandleTypeDef
v B Core ) ) ) © © VERSION_NUMBER : const uint32_t
> @ inc /* Configure the system clock */ ® © CRC_NUMBER : const uint32.t
v Esre systemClock Config(); ® ©BUILD_ID : const uint16_t
> [ main.c @ Distance : uint32_t

> [g stm32f4xx_hal_msp.c
> [ stm32fdxc_itc

® Seconds: uint32 t

/* USER CODE END SysInit */ ++ SystemClock_Config(void) : void

> [ syscalls.c 45 MX_GPIO_Init(void) : void
> [ sysconf.c /* Initialize all configured peripherals */ 45 MX_USART2_UART_Init(void) : void
> [ sysmem.c MX_GPIO_Init(); ® ip:int
> [] system_stm32f4xx.c 175© #ifdef TEST_MALLOC ® ramx:int
> (= Startup 176 My malloc(12); ® mylP_read() : int
> [ Drivers My. malloc(12); ©® myRAM_read() : int
> [=Debug My malloc(12); ® _binary_data_start : int
> = Debug2 My, malloc(12); ® _write(int, char, int) : int
> (= Release My. malloc(12); © main(void) : int
[FINUCLEO-F401RE €lf.cfg 181 #endif ® SystemClock_Config(void) : void
2/ NUCLEO-F401RE.elflaunch 182 . © ¥ MX_USART2_UART_Init(void) : void
[ NUCLEO-F401RE ioc 183 MX_USART2_UART_Init(); © % MX_GPIO_Init(void) : void
) readme.txt 184 /* USER CODE BEGIN 2 */ ® Eror Handler(void) : void

185
186 mem=malloc(12);

187 mem2=malloc(12): v
< >

[T STM32F401RETX_FLASH_IPCodelnFlash.Id
|3 STM32F401RETX_FLASH_ORG.Id

[T STM32F401RETX_FLASH_RAM_CODE.Id
|3 STM32F401RETX_FLASH.Id

A assert_failed(uint8_t*, uint32_1) : void

[T STM32F401RETX_RAM.Id 21 Problems ¥ Tasks B Console 53 [ Properties =8 Build Analyzer 2 == Static Stack Analyzer = v=0
> MsTvs2r401 Acs #E Y NUCLEO-FAOTRE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13
No consoles to display at this time. PM
Memory Regions  Memory Details
‘ Writable ‘ Smart Insert 180: 10 [20] e - a

Copy the selected block by using Ctrl+C. This copied text can then be inserted elsewhere. To do so, type
Alt+Shift+A to toggle the selection mode back to the normal mode, move the cursor to another line, and type
Ctrl+V to paste the copied columns to the new lines.

UM2609 - Rev 6
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Figure 35. Editor column block paste

25 Project Explorer i &® v =0

> [EmyLib
v [ NUCLEO-F401RE
> #¥ Binaries
> [l Includes
v [ Core
> e
v [=Src
> @ main.c
> g stm32f4xx_hal_msp.c
> [€] stm32fdxc_itc
> [ syscalls.c
> [ sysconf.c
> [ sysmem.c
> [] system_stm32fxx.c
> (= Startup
(2 Drivers
(= Debug
(= Debug2
[ Release
[FINUCLEO-F401RE elf.cfg
=/ NUCLEO-F401RE.elf.launch
[T NUCLEO-F401RE.ioc
2 readme.txt
[T STM32F401RETX_FLASH_IPCodelnFlash.ld
|1 STM32F401RETX_FLASH_ORG.Id
[T STM32F401RETX_FLASH_RAM_CODE.Id
|1 STM32F401RETX_FLASH.Id
[T STM32F40TRETX_RAM.Id
> [ STM32F401_Ac6

vvivy

mworkspace,urm - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

(HN-EHR® Q@ N@ g e[ @ i i@y [ IRE TSy B

[€] *main.c %
My_mem6=malloc(12);
My_mem7=malloc(12);
81 #endif

MX_USART2_UART_Init();
/* USER CODE BEGIN 2 */

mem=malloc(12);
mem2=malloc(12);
90© #ifdef OLD
mem3=malloc(12);
mem4=malloc(12);
memS=malloc(12);
mem6=malloc(12);
mem7=malloc(12);
96 #endif

/* USER CODE END 2 */
mem3

mem4

mem5

memé

mem7

/* Infinite loop */
/* USER CODE BEGIN WHILE
<

2 Problems ¥ Tasks B Console &2 [

No consoles to display at this time.

Writable Overwrite

*/

=0
#E-N

Properties

PM

Memory Regions  Memory Details

202:7:4577

=0

>

~

Build Analyzer 52 == Static Stack Analyzer

NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13

- m] X

(quicaceess || 18 [B4

@) Build Targets =
ElRR o ¥ ¥

2= outline ¢

& mainh

& malloch

@ huart2 : UART_HandleTypeDef

@ © VERSION_NUMBER : const uint32_t
© ° CRC_NUMBER : const uint32.t

@ ©BUILD_ID : const uint16_t

® Distance : uint32. t

® Seconds: uint32_t

+ SystemClock_Config(void) : void
47 MX_GPIO_Init(void) : void

++ s MX_USART2_UART _Init(void) : void
ip:int

ramx : int

mylP_read() : int

myRAM _read() : int
_binary_data_start : int

_write(int, char*, int) : int
main(void) : int
SystemClock_Config(void) : void
°f MX_USART2_UART_Init(void) : void
°f MX_GPIO_Init(void) : void

@ Error_Handler(void) : void

/ assert_failed(uint8_t*, uint32_t) : void

®v=-o

Compare files

To compare two files easily in STM32CubelDE:
1. Select the two files in the Project Explorer view

2. Click on one file
3. Press Ctrl
4 Click on the other file

Both files are now marked in the Project Explorer view
5. Right-click and select [Compare With]>[Each Other]

It is possible to configure how the comparison of files is managed. For instance, ignoring white space
can be enabled from the preferences. Open the Preferences page using [Window]>[Preferences], select
[General]>[Compare/Patch], and enable [Ignore white space].

page 31/245



https://www.st.com/en/product/stm32cubeide?ecmp=tt9470_gl_link_feb2019&rt=um&id=UM2609

m UM2609

STM32CubelDE and Eclipse® basics

Figure 36. Editor - Compare files

[ workspace_um?1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - m] X
File Edit Source Refactor Navigate Search Project Run Window Help
(MY HRS KRR Ni@ A E-S [ v@ritsvi@yvi AZLE T ECEy Y20 Quick Access | i [ |[EE %
B Project Explorer 53 BES Y =0 @ manc 2 = 8 | % outline X ® Build Targets =0
> =Inc ~ My_mem6=malloc(12); ~ BN o % v
v &S My_mem7=malloc(12); 2 mainh
> [€ main.c #endif 2 malloch
> [€] stm32f4xx_hal_msp.c @ huart2 : UART_HandleTypeDef
> [ stm32fxx_itc @ © VERSION_NUMBER : const uint32_t
> [g] syscalls.c USART2_UART_Tnit(); @ © CRC_NUMBER : const uint32_t
> [gsysc  New > - - = 2 @ ©BUILD_ID : const uint16_t
(G5 USER CODE BEGIN 2 */ o cons uinte
> [dsysn  Open ® Distance : uint32.t
. _> SD:;yst. el AltShiftsW> Lnmalloc(12) @ Seconds u|nt32,l. )
k B artup Copy Ctl+C  pm2=malloc(12); ﬂs SystemClock_Config(void) : void
> (2 Drivers ef OLD 4+ MX_GPIO_Init(void) : void
> (= Deb Paste crlsv 45 MX_USART2_UART_Init(void) : void
ebu - . nit(voiq) : vor
9 ¥ Delete Delete pM3=malloc(12); S - -
> [ Debug2 — , pma=malloc(12); ® ip:int
> (= Release m5=malloc(12); = @® ramx:int
[Fnucteo-r  Move- m6=malloc(12); ® mylP_read) : int
NUCLEO-f ~ Rename.. F2 bm7=malloc(12); ® myRAM_read() : int
[ZINUCLEO-F iy Import.. if @ _binary_data_start : int
readme.tx iZy Export... USER CODE END 2 */ ® _write(int, char*, int) : int
[3s STM32FAC &) Refresh r5 PM3 © main(void) : int
[ STM32F4C . s amd ® SystemClock_Config(void) : void
4 STM32F4C = S ) pmS © ¥ MX_USART2_UART_Init(void) : void
[5h STM32F4c  "ESOUree Lontigurations Emé ® S MX_GPIO_Init(void) : void
[ STM32F4C_ Team > pm7 © Eror_Handler(void) : void
v [ sTM32F401_  Compare With > Each Other A assert_failed(uint8_t*, uint32_1) : void
> #¥ Binaries Replace With > Local History... e .
> fllincludes  #7 Run C/C++ Code Analysis 5
> [Bsrc =
> (Bstartup 21 Problems ] Tasks B Console 53 [=] Properties =] Build Analyzer 52 == Static Stack Analyzer #v=0
> Debu -
& Debug B~ NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13
? [Einc No consoles to display at this time. PM
|34 LinkerScript.d
[F]sTM32F401_Ac6 Debug.cfg . Memory Regions Memory Details
[] 2 items selected [
The File Differences editor opens and compares both files.
Figure 37. Editor - File differences
mwnr(sww,wv\ - Twe-way compare of 'NUCLEO-Ra01RE/Cora/Srcfsyscalls.c with "NUCLEC-F401REore/Secfsysmrem < - STM32CubelDE a x
e Edit ot Refecter Nawgate Search Pret Run Windon Help
=R I RE S SN Y R R RAE ST PR PO (R ToRon o [ Y- e hecezs 3 4 R4
[ Project Explorer i3 BE Y O [@emaine £ Compare (NUCLED. MOTRECore/Sre/syscallsc - NUELEO-F01RE CoreSresaysmer.c) 5 P 8= outine B @ i Targets v
> Moyt G Thers s e st il Ut provces on cuiline
o [EUCLED Fa0 s v 14 Trarslstion Unit -
> 48 Bineries e
e
~ e .
o et © OBl B < 4
> Emene NUCLED-FM RECarerSjsyseal s MUCLEG-F07 A/ Cam Sredsysmem.e |
» & sd2tdn halrzpe v e .
RO R 2 2 -
» [E |5 5
» (& wpwers [ = Fe Tywealls c [ Symmon © 1
] B <o o
o[£ system sm32idwee Auther 1 Awte-generated by STM32CubelDE 6%t Auther i fwte-generated by STMZ2CubelDE
> (& Starkuz Thid
> B Drivers Abstracl @ STMI2CUBETOC Mininal System calls file + [ 87 Mbstract STHIICubeTDE Minimal Sys| femary_calls +1Li
e bug N LN
Lo, For nore information about which c-functions 1o+ For more information about which c-functions
- need which of these lowlewel functions i need which of these lewlsvel functions
HUCLED TR el please consult the Newlib libc-manual ha*t please consult the newlib libc-manual
H haee
. ioer
= ! Distriburion: The file is distribured as s, without any warr| 15** Distribution: The Tile is distributed as is, without any us H
5 STMI2S0TRETY FLASH IFCode nFlash of any kind by of any kind 1l
i STMIIRANTRFTY FASH ORI e |'|
@ STMRTRT 851 Rt £O0FIA A -
ba -+ H
& STMIZFAOTRETX RAMIG 217% <hzr<centersBoopy) COPYRIGHT{c) 2018 STH: csc/cente]  p1vr copy: COPYRIGHT(c) 2818 STHicroslectranicse/cel
v [0 sTMs2rs01 Ack 27 R2**
> 4 B 237 Redistribulion and w0 souree and binary fores, with or wit| 23" Redistribution and e in source and binary farme, wiih or |
5 Ellnchades 3a% are permitted prowided that the following conditions are mct ha*+ are permitted provided that the following conditions arc me
> B + 1. Redistributions of source code nust retain the above copy| b5+* 1, Hedistributions of source code must retain the above ot
s Eenp This 45T af conditions and The follawing disclatner bivt | thas 1ist of congitions snd The follouing disciaiver
» & Debug 277 2. Redisteibutions in bi fer e bove £ 7% 2. Redistrabutions in binary form mest reproduce the abovi
L 2= dhis it of condi o | hee T rd the ol lowing disclaier it
ut Linkerscriptld 2954 and/or ather materials rhad and/or other mater: provided with the distribution.
B 3@ 3. Neither th of & 30 ** 3. Nedther the of STMicreelectd war the «
LJsmhosan. s Deoiaca Jmt 7 may be used ta endaree an prarte producte devived from t| | <t ey ba used o ndores or promote produces derved frol
227 without specific prior weiiten pernission Catt without specific prioe writien permission.
33 by
3=+ THLS SOFTWARE 1S PROVIDED BY THE CUPYRIGHT HOLDERS AND CONTRIE R4+ THIS SOFTWARE [5 PROVIOED BY THE COPYRLGHT HOLDERS AND CONTI
1 Problems & Tsks & Conscla 22 [ Sroperties M- = 7 uikdAnshyzor 22 Setic Stack Analyzor gv=r
Mo onsoles Lo displey ol this lime. 'NUCLEO-F401RE elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13 PM
Miemory Regions oo e
Focion Saaddrs T s e fea Ve [r—— z
wrann oo neowemo gk ke e 1
e oewowa somiom e sike 10 Wb 1o
LA O 0T00e0 06 0800 2KE 159 KE L) LS M
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Use the navigation buttons to navigate between differences, or simply navigate in the view using the scroll bar to
see the file differences.
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1.8.7 Local file history
It is recommended to maintain projects with a version control system such as Apache® Subversion® (SVN) or

Git™. Still, STM32CubelDE contains a local file with the history of edited files, which can be useful if some
investigation is needed after a file has become not functional. The workspace preferences contain a Local History

page.
Figure 38. Local history
L preferences O X
local % Local History Py
v General
Globalization Limit history size
v Workspace Days to keep files: ‘ 7 |
Local History ] ] il ‘ |
v C/C++ Maximum entries per file: | 50
v Editor Maximum file size (MB): ‘ 1 |
Syntax Coloring
Note: The ‘Maximum entries per file' and the 'Days to keep files' values
are only applied when compacting the local history on shutdown.
‘ Restore Defaults ‘ ‘ Apply
® m ﬂ’z‘ﬂ | Apply and Close | ‘ Cancel
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To show the local history of a file:

1. Select the file in the Project Explorer view
2. Right-click

3.  Select [Team]>[Show local History]

Figure 39. Show local history

[ workspace_um?1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - [m] X
File Edit Source Refactor Navigate Search Project Run Window Help
D EGB R BIN@GE (@i i@ ARE 1070 Quick Access | 5[4
[25 Project Explorer % EHS Y 70 [d mainc Z B 2= outline 2 @ Build Targets O
> [Emylib ~ 1 /* USER CODE BEGIN Header */ A BN o % ¥
v [ NUCLEO-F401RE 20 /** U mainh ~
> $% Binaries 3 :****** SeBSEMEERRRSEELELLLEERSIISL LSS SS RS s s s s s s s o malloch
> @l Includes 4 " @file : main.c @ huart2 : UART HandleTypeDef
v (2 Core 5 ) @b"lef_ o Mal”_"""g"a’”_b"dy . ® © VERSION_NUMBER : const uint32_
P RSP PR .
> [ZInc . ttenti ® “ CRC_NUMBER : const uint32_t
v &= Src Z . @attention ® ©BUILD_ID : const uint16_t
> in. @® Di :
" %"t‘a';, New > kh2s<centers&copy; Copyright (c) 2019 STMicroelectronics. . Distance - in(32.¢
stm34 Open All rights reserved.</center></h2> N Seconds : uint32_t
> @stm32 Show | Alt+Shift+W> ++ SystemClock_Config(void) : void
ow In +Shift+ s N
> [g] sysca This software component is licensed by ST under BSD 3-Clause license, +HMX_GPIO Init(void) : void
> @ Open With > o8 PP
sysco the "License"; You may not use this file except in compliance with the ++7 MX_USART2_UART_Init(void) : voic
> [ sysm[E] Copy Crl+C | jcense. You may obtain a copy of the License at: ® ip:int
> [g syster [ Paste Crl+V opensource.org/licenses/BSD-3-Clause ® ramx:int
> (= Startup & Delete Delete @ mylP_read() : int
> @B Drivers ST N T ® myRAM_read( : int
> (= Debug Move... @ _binary_data_start : int
> (Debug2 Rename... > BER CODE END Header */ ® _write(int, char®, int) : int
v [ Release g Import @ main(void) : int
> (= Core Z) BEn cludes i —————————————eiets @ SystemClock_Config(void) : void
> (= Drivers fudegarngh © § MX_USART2_UART_Init(void) : voic
> $NUCLED £ Refresh ol ude <malloc.h> v & 3 MX_GPIO_Init(void) : void v
D@makefile Index > > < >
ZINUCLEO R Configurati - = =
% EEES EEM D 2 Tacle Bl Concala 52 properties = Build Analyzer 5% == Static Stack Analyzer #v=0
=/ NUCLEO ™ Heam > Show Local History -
objects!  Compare With 5 o B v ¥~ NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Sep 23, 2019 2:05:13
[& objects.r y pply Fatch... PM
@ . Replace With >
[y sourcesd ‘ Share Project.. :
NUCLEO-FA' Run C/C++ Code Analysis Memory Regions  Memory Details
NUCLEO-F4 _ Properties Alt+Enter Region Start address End address Size Free ~
m NUCLEO-F401RE.ioc EEHRAM 0x20000000 0x20018000 96 KB 94.27
readme.txt LASH 0x08000000 0x08010000 64 KB 537
@ STM32F401RETX_FLASH_IPCodelnFlash.Id EEHFLASH D 0x08010000 0x08010800 2KB 199 ¥
[T STM32F401RETX_FLASH_ORG.Id 9 < >
l£] /NUCLEO-F401RE/Core/Src/main.c [
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The History view opens and displays the file history.

Figure 40. File history

[ workspace_um?1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - a X
File Edit Source Refactor Navigate Search Project Run Window Help
Or-HRS - ARG G S @it @y IRETY - 0C-2- 0 [auick Access || 83| #
(75 Project Explorer % HES Y T 0 [@ manc = O 2= outline 82 @ Build Targets " O
> [EmyLib N 1 /* USER CODE BEGIN Header */ ~ AR o % v
~ FENUCLEO-F401RE 20 /** = mainh ~
> 3§ Binaries 3 L L L T T T e 8 malloch
1 |
> &l Includes 4 *@file : main.c @ huart2 : UART HandleTypeDef
v (& Core 5 @brief : Main program body ® © VERSION_NUMBER : const uint32_
N R e R oc
(=Inc ; * @attention CCRC,NUMBER : const uint32_t
v (&= Src s . ® “BUILD_ID : const uint16_t
> in. y @® Di :
s %rr:al;zcm hal 9 * <h2><center>&copy; Copyright (c) 2019 STMicroelectronics. ° Dlstance:umtaz,t
stm xx’_a’msP‘c 10 * All rights reserved.</center></h2> . Seconds : uint32.t
> [i€] stm32f4xx_itc 11 * ++ SystemClock_Config(void) : void
s ittvoid) -
> [g] syscalls.c 12 * This software component is licensed by ST under BSD 3-Clause license, HSMXfGP]an't(‘w'd)""°‘dA
> @5)’5C°"f-c 13 * the "License"; You may not use this file except in compliance with the ++7 MX_USART2_UART_Init(void) : voic
> [£ sysmem.c 14 * License. You may obtain a copy of the License at: ® ip:int
> [£] system_stm32f4xx.c 15 = opensource.org/licenses/BSD-3-Clause ® ramx:int
> (= Startup 16 * @ mylP_read() : int
> 2 Drivers 17 R R R KRR K KRR R R KK © myRAM read(): int
> (= Debug 18 */ @ _binary_data_start : int
> (z=Debug2 19 /* USER CODE END Header */ @ _write(int, char®, int) : int
v [ Release 20 @ main(void) : int
> (=Core 21 /% Includes --oo-ooocoooooooooooooooooooooooooooooooooooooooooooooooooes @ SystemClock Config(void) : void
> (= Drivers 22 #:.mclude main.h ® S MX_USART2_UART_Init(void) : voic
> %5 NUCLEO-FA01RE.elf - [arm/le] 23 #include <malloc.h> v © ¥ MX_GPIO_Init(void) : void v
| & makefile 3 2 g 4
=l NUCLEO-F401RE list - = =
NUCLEO-F401RE map 181 Problems ] Tasks B Console &2 [ Properties B [ Build Analyzer == Static Stack Analyzer B History 53 =
] objects list ad=Rdwid S D EE
D@objects.mk No consoles to display at this time. main.c
| & sources.mk Revision Time
NUCLEO-F401RE.eIf.cfg E 9/24/19, 3:51 PM
NUCLEO-F401RE.elf.launch 5 9/24/19, 1:57 PM
[ NUCLEO-F401RE.ioc 5 9/20/19, 2:54 PM
readme.txt
@ STM32F401RETX_FLASH_IPCodelnFlash.ld
@ STM32F401RETX_FLASH_ORG.Id v
| Writable | Ovenwrite 22:18:802 a

In the case presented in Figure 40, there are three revisions of main. c. Double-click on a file in the History view
to open it in the editor.
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Right-click on a file in the history and select [Compare Current with Local] to compare it with the current version

of the file.
Figure 41. Compare current history with local history
[ workspace_um?1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE - a X
File Edit Source Refactor Navigate Search Project Run Window Help
AR AR RS A ER N 7R R AR AR A CRSE R 1 PR ENT= = I SRR SR A R AR Al il i | Quick Access 5 R s
(25 Project Explorer % BS Y <0 [@manc = B = outline 2 @ BuildTargets " O
> [Emylib ~ 1 /* USER CODE BEGIN Header */ ~ ElLR o ¥ v
v [ NUCLEO-F401RE 20 /** U mainh ~
> 3§ Binaries 3 i*******x*******x*******x*******x*******x*******x*******x*******x*****w o malloch
> &l Includes 4 gzllef : main.c oo @ huart2 : UART HandleTypeDef
C 5 * rie : Main program body c .
v (B core 6 ok ok Kok KKK ok ok ok o ok oK KR K K ok KR K K K ok ok ok ok K K K K ok K K K K ok K Kok K .GVERSION*NUMBER'(OHS( uint32 |
> [=Inc . ttenti ® “ CRC_NUMBER : const uint32_t
v = Src ; . @attention ® ©BUILD_ID : const uint16_t
> in.« y @® Di :
s %rr:al;zcm hal 9 * <h2><center>&copy; Copyright (c) 2019 STMicroelectronics. ° Dlstance:umtaz,t
stm xx’_a’msP‘c 10 * All rights reserved.</center></h2> . Seconds : uint32.t
> @stm32f4xx7|t.c 11 * ++ SystemClock_Config(void) : void
s itvoid) -
> [g] syscalls.c 12 * This software component is licensed by ST under BSD 3-Clause license, HSMX,GP]OJnIt(VOId).\‘/O\dA
> @5)’5C°"f-c 13 * the "License"; You may not use this file except in compliance with the ++7 MX_USART2_UART_Init(void) : voic
> [£ sysmem.c 14 * License. You may obtain a copy of the License at: ® ip:int
> [€] system_stm32faxx.c 15 * opensource.org/licenses/BSD-3-Clause ® ramx:int
> (= Startup 16 * @ mylP_read() : int
> @ Drivers B I T R © myRAM read(): int
> (= Debug 18 */ @ _binary_data_start : int
> (= Debug2 19 /* USER CODE END Header */ @ _write(int, char®, int) : int
v [ Release 20 @ main(void) : int
> (=Core 21 /% Includes --oo-ooooooooooooooooooooooooooooooooooooooooooooooooooooes @ SystemClock Config(void) : void
> (= Drivers 22 #:.mclude main.h ® S MX_USART2_UART_Init(void) : voic
> %5 NUCLEO-FAOTRE elf - [arm/le] 23 #include <malloc.h> v © % MX_GPIO_Init(void) : void v
| & makefile 3 2 g >
=l NUCLEO-F401RE list - = =
NUCLEO-F401RE :ap 181 Problems ] Tasks B Console &2 [ Properties =] Build Analyzer z= Static Stack Analyzer [ History 57 =
2} objects ist nd=Rain 4 SB[ D EEE
D@objects.mk No consoles to display at this time. main.c
| & sources.mk Revision Time
NUCLEO-F401RE.eIf.cfg E 9/24/19, 3:51 PM
NUCLEO-F401RE.elf.launch B 9/24/19, 1:57 PM
[T NUCLEO-F401RE.ioc 5 9/20/19, 2:54 PM v
readme.txt op With >
3 STM32F401RETX_FLASH_IPCodelnFlash.Id L :
5 STM32F401RETX_FLASH_ORG.ld . ComparelCiientwith]Focs]
o Get Contents
-
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This opens the File Differences editor and displays the file changes.

Figure 42. Compare local file differences

mwcrkspace,urm - Compare /NUCLEO-F401RE/Core/Src/main.c Current and Local Revision - STM32CubelDE - a X
File Edit Source Refactor Navigate Search Project Run Window Help
(N EHRB R @ NG E S G- iR i IRET Y Coy O OELR Quick Access | 9 [ 4 [T
i b Bg® v=0 i 20 i ision 53 = B | 5z outline X @ =g
- - o =
[ Project Explorer % 153 3 main.c Z0 Compare main.c Current and Local Revision % Outline &% Build Targets
> mmyLib ~ [g c Compare v
v ENBC_LEO_'F‘WRE v [& Translation Unit There is no active editor that provides an
> isj Binaries ® main outline.
> @l Includes
v [ Core
> inc
v = Src
> [i£] main.c [£] C Compare Viewer ¥
> g stm32f4xx_hal_msp.c D
& [
> [ stm32f4xx_it.c Ml 4 2 D
> @ syscalls.c Local: main.c Local history: main.c Sep 20, 2019, 2:54:18 PM
> [@ sysconfc 171 /* USER CODE END SysInit */ 171 /* USER CODE END SysInit */ |
> [€] sysmem.c 172 172
173 /* Initialize all configured peri 173 /* Initialize all configured
> [] system_stm32f4xx.c N .
> (= Startu 174 MX_GPIO_Init(); 174 MX_GPIO_Init();
s Bon P [V #ifdef TEST _MALLOC 175 MX_USART2_UART_Init();
rivers f¥q My_mem3=malloc(12); 176 /* USER CODE BEGIN 2 */ =
7 (& Debug ivod My _memd=malloc(12); 177
> (z=Debug2 ik My_memS=malloc(12); 178 mem=malloc(12);
Vv [&-Release f¥El My _mem6=malloc(12); 179 mem2=malloc(12);
> [=Core JEL] My _mem7=malloc(12); 180 #ifdef OLD
? (= Drivers pEiR#endif 181 mem3=malloc(12);
> %5 NUCLEO-F401RE.elf - [arm/le] 182 182 memd=malloc(12): v
| & makefile | S > < >
=l NUCLEO-F401RE list - = =
NUCLEO-F401RE :ap 1?1 Problems ¥ Tasks B Console &2 [E] Properties B [ Build Analyzer == Static Stack Analyzer B History 53 =]
2] objectslist al=Rln R S| |D B
D@objects.mk No consoles to display at this time. main.c
| & sources.mk Revision Time
NUCLEO-F401RE.eIf.cfg E 9/24/19, 3:51 PM
NUCLEO-F401RE.elflaunch = 9/24/19, 1:57 PM
[T NUCLEO-F401RE.ioc 5 9/20/19, 2:54 PM
readme.txt
@ STM32F401RETX_FLASH_IPCodelnFlash.ld
|3 STM32F401RETX_FLASH_ORG.Id v
Left: 185 : 1, Right: 175 : 1, incoming deletion #1 (Left: 175 : 184, Right: before line 175) Statis: offline (-]
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2 Creating and building C/C++ projects

As mentioned in Section 1.6 Workspaces and projects, a workspace is a directory containing projects. The first
time a workspace is created, it is empty without any projects. The projects need to be created or imported in the
workspace. This section contains information on how to create projects in the workspace and build projects. It
also covers how to import and export projects.

2.1 Introduction to projects

A project is a directory in the workspace containing files that may be organized in sub-directories. It is possible
to access any project within the active workspace. The files included in a project do not need to be physically
located in a folder in the project but can be located somewhere else and linked into the project. Projects located
in another workspace cannot be accessed, unless the user switches to that workspace or import some of these
projects into the workspace in use.

It is possible to rename and delete a project. If a workspace contains many projects, it is also possible to close
some of them to make the work easier. Closed projects can be reopened again at any time.

This section focuses on the two types of STM32 projects supported by STM32CubelDE:
. Executable programs
. Static library projects

However, the EcIipse® C/C++ Development Toolkit (CDTT"'), which STM32CubelDE is based on, contains also
basic project wizards, which can be used to create C managed build, C++ managed build, and makefile projects.

The STM32 projects can be:

*  CorC++

. Generated executable or library file

. Based on STM32Cube (using STM32 firmware library package) or empty projects

STM32 projects also support an advanced umbrella project structure, where one project contains many projects,
for instance one project per core for multi-core devices.

2.2 Creating a new STM32 project

221 Creating a new STM32 executable project

The easiest way to create a new STM32 C/C++ project is to use the STM32 project wizard. It is selected through
the menu [File]>[New STM32 Project].

Another way to create a new C/C++ project is to open the Information Center and press [Start new STM32

project]. As mentioned in Section 1.3 Information Center, the Information Center can be opened using the
button on the toolbar or via the menu [Help]>[Information Center].

Both ways initialize and launch the STM32 Project Target Selection tool.
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Figure 43. STM32 target selection
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The MCU/MPU selector and Board Selector tabs can be selected at the top of the window. Use the first tab to
create project for a specific device and the second if a project for a specific board is needed.

This section presents the creation of a project for the NUCLEO-F401RE board using the Board Selector.

Among the different filters available for use on the left of the window, type “4071”in the Part Number Search field to
filter the boards with names containing this string. In Figure 44, two boards are listed, a Nucleo board board and a
Discovery board. The NUCLEO-F401RE board is selected.

Figure 44. STM32 board selection
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Five tabs, Features, Large Pictures, Docs & Resources, Datasheet, and Buy, offer the possibility to display
detailed information about the selected board or device. For instance, documentation available for the board

is displayed and can be opened when Docs & Resources is selected. When Datasheet is selected, the board
datasheet is downloaded from STMicroelectronics web site.

Pressing [Next] when the NUCLEO-F401RE board is selected opens the Project setup page.

Enter a project name and select the desired setting for the project in the dialog boxes. The project named
“‘NUCLEO-F401RE” is filled in as an example in Figure 45.

Figure 45. Project setup

[Z sT™32 Project

Project Setup
Setup STM32 project

Project Name: | NUCLEO-F401R]
Use default location

Location: C:/Users/johansse/STM32CubelDE/workspace_um Browse...
Options
Targeted Language
@ C O C++
Targeted Binary Type
@® Executable O Static Library

Targeted Project Type
® sTM32Cube O Empty

@ ‘ < Back " Next > ‘ | Finish | ‘ Cancel

According to the settings in Figure 45, the project is meant to be stored in the default location with the following
options set:

. C project

. Executable binary type

. STM32Cube targeted project type

Press [Next] to open the Firmware Library Package Setup page.
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Figure 46. Firmware library package setup

[ sT™32 Project

Firmware Library Package Setup

Setup STM32 target's firmware

Target and Firmware Package

Target Reference: NUCLEO-F401RE

Firmware Package Name and Version: STM32Cube FW_F4 |V1.24.1 ~

Firmware package Repository

Location:
C:\Users\johansse\STM32Cube\Repository

See 'Firmware Updater' for settings related to firmware package installation

Code Generator Options

O Add necessary library files as reference in the toolchain project configuration file
Copy all used libraries into the project folder

® Copy only the necessary library files

@

Finish ‘ ‘ Cancel

In this page, it is possible to select the STM32Cube firmware package to use when creating the project. In this
case, the default settings are used. Press [Finish] to create the project.

As a result, the following dialog is displayed.

Figure 47. Initialization of all peripherals

m Board Project Options:

|@ Initialize all peripherals with their default Mode ?

| Yes | ‘ No ‘

Press [Yes] since it is a good practice to get the software needed to initialize the peripherals.
This opens the new dialog shown in Figure 48.
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Figure 48. STM32CubeMX perspective opening

mOpen Associated Perspective? X

@ This kind of project is associated with the STM32CubeMx perspective. Do you want to open this
perspective now?

[JRemember my decision

Opening the STM32CubeMX perspective is a good decision if there are any needs to configure the device.

Enable [Remember my decision] if the question msut not be asked the next time a new project is created. Press
[Yes] to continue.

At this point, the project creation starts. The time it takes depends on the amount of files that need to be
downloaded to create the project.

Figure 49. Project creation started

[ sTm32 Project

Firmware Library Package Setup

Setup STM32 target's firmware

Target and Firmware Package
Target Reference: NUCLEO-F401RE
Firmware Package Name and Version: STM32Cube FW_F4 V1.24.1 ~

Firmware package Repository

Location:

C:\Users\johansse\STM32Cube\Repository

See 'Firmware Updater' for settings related to firmware package installation

Code Generator Options

Add necessary library files as reference in the toolchain project configuration file
Copy all used libraries into the project folder

Copy only the necessary library files

Perform Project Creation. Please Wait For Completion ...

=)
i

@ < Back Next > Finish Cancel

When the project is created, the STM32CubeMX perspective is opened with a window for configuring the
peripherals, clock, middleware, and power consumption.
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Figure 50. STM32CubeMX

- o x

Seath o
AEID R G R G 5@ jouneeens 18 3 EIGH
(&5 Project Explorer ES b [INJCE IR 07 i

e 100
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The new project is listed in the Project Explorer view with some of the folders and files it contains.

The NUCLEO-F401RE. ioc file contains the configuration settings and is opened in the STM32CubeMX editor.
This editor contains tabs for Pinout & configuration, Clock configuration, Project manager and Tools. When
changes are made in the STM32CubeMX editor, the . ioc file in the tab is marked as changed. If the file is saved,
a dialog opens asking “Do you want to generate Code?”, making it easy to generate new code in the project that
supports the new device configuration. For more information on how to use the STM32CubeMX editor, refer to
[ST-14].

It is possible to create an STM32 project with less files and folders by selecting the targeted project type [Empty]
instead of [STM32Cube] (refer to Figure 45. Project setup). When [Empty] is selected, the generated project

only contains some folders, a device startup file with Reset Handler code and vector table, the main. c file,
and some other c files and linker script files. STM32 header files, system files and CMSIS files must be added
manually. These files can for instance be copied from some other STM32Cube targeted project or from an STM32
example project.

Note: For empty projects, make sure to configure the floating-point unit setting to use software FPU or hardware FPU
according to application requirements. When using hardware FPU, initialize the FPU. For non-empty projects,
the initialization of the FPU is normally done in the SystemInit function infile system stm32fxxx.c. To
notify that the FPU configuration may be needed, the main. c file created in an empty project contains a
compiler warning stating #warning "FPU is not initialized, but the project is compiling
for an FPU. Please initialize the FPU before use."

222 Creating a new STM32 static library project

The method described in Section 2.2.1 Creating a new STM32 executable project can be used also to create a
static library project. However, static libraries are often reused in multiple application projects, possibly targeting
different STM32 products. The STM32 project wizard does not support changing the MCU device. The standard
Eclipse®/CDT™ projects solution with some STM32 related extensions does support changing the MCU device

per build configuration.

The recommended way to create static library projects is therefore to rely on Eclipse®/CDT™ projects as
described below.
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To create an Eclipse®/CDT™, go to [File]>[New]>[C/C++ Project]. This opens the window displayed in Figure 51.

Figure 51. New C/C++ project

[T Mew C/C++ Project O X

Templates for New C/C++ Project

C Managed Build

Make @ A C Project build using the CDT's managed build system.

C++ Managed Build
@’ A C++ Project build using the COT's managed build system.

Makefile Project
@‘ (Experimental) Create a new project that builds with the'make’ build tool using COT's new Core Build System.

@ < Back Next > Finish Cancel

Select either C Managed Build or C++ Managed Build depending on what the project requires and click on [Next].

This brings up the project type selector. The Empty Project type is the only type supporting the MCU ARM GCC
toolchain. Make sure to select Empty Project under the Executable folder and then select the MCU ARM GCC
toolchain as seen in Figure 52.
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Once the project naming and type selection are done, click on [Next].

Figure 52. Project type

C Project

Create C project of selected type

Project name: | myLib

Use default location
C\Users\girdlanm\STM32Cubel DE\workspace_1.7.0\myLib

Browse...
file system: [defatlitsse

Project type:

¥ & Executable Cross GCC
# Empty Project Cygwin GCC
# Hello World ANSI C Project

MCU ARM GCC
* @ Shared Library

> = Static Library
» = Makefile project

Toolchains:

Show project types and toolchains only if they are supported on the platform

< Back | Next > Finish Cancel

This launches a standard Eclipse® project configuration window as shown in Figure 53 Click on [Next]..

Figure 53. Project configuration selection

Select Configurations

Select platforms and configurations you wish to deploy on

Project type:  Executable
Toolchains: MCU ARM GCC
Configurations:

% Debug Select all
A% Release

Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

< Back | Next > Einish Cancel
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In the target selector screen shown in Figure 54, make sure to select the appropriate target by clicking

on the [Select...] button and filtering the correct target for the project. The target selector helps to set the
-mcpu=cortex-mX toolchain flag correctly in the already defined build configurations seen in the previous step
(see Figure 53).

Figure 54. Project default target selector

o] o X

Select default target for the project [ %
The selected target can be changed, per build configuration, later ——

MCU:| ISelectl

CPU: | |

Core: v
()] < Back Next > Finish Cancel
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When clicking on [Select...], the filter dialog shown in Figure 55 shows up, allowing users to filter and select the
correct device.

Figure 55. Project MCU/MPU selector

[l MCU/MPU Selector O X

Please select your STM32 target device

STM32F407

MCU/MPU
STM32F407IEHx
STM32F407IETx
STM32F407IGHx
STM32F407IGTx
STM32F407VETx

 STM32F407VGTx
STM32F407ZETx
STM32F407ZGTx

@ OK | ‘ Cancel
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After the target selection (MCU), the CPU and Core fields are automatically populated in the simple single core
case as shown in Figure 56.

Figure 56. Project target selection

L3 0 X
. —
Select default target for the project |
The selected target can be changed, per build configuration, later —
MCU: | STM32F407VGTx | [Select...
CPU: Cortex-M4 (0) e
Core: 0 2
@ < Back Mext = | Finish l Cancel

For more advanced devices such as multi-core STM32H7 microcontrollers, the user must select the CPU and
Core that the project targets to make sure that the code is built correctly. These settings are also used later
to properly setup debug configurations. Make sure that the settings are as needed for the project and click on
[Finish].

Figure 57. Project target selection (advanced)

o] o X

Select default target for the project [
The selected target can be changed, per build configuration, later '

MCU: | STM32H74521Tx | Select..

CPU: ~|
Core: [CoTtex-MT (0) |
Cortex-Md (1)

i) < Back Mext > Einish Cancel
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After the project creation, it is possible to create different build configurations for different targets as described in
Section 2.3.1.2 . After a new build configuration is created, right-click the project in the Project Explorer, go to
[Properties]>[C/C++ Build]>[Settings]>[Tool Settings]>[MCU Settings], and click on [Select...] to select a new
target for the specific build configuration.

Figure 58. Project target change

[l properties for myLib O X
type filter text Settings o ow v 3
> Resource

Builders - i .Deb [ Active] ] R et g
v C/C++ Build onfiguration: ug ive anage Configurations...
Build Variables
Environment ® Tool Settings # Build Steps Build Artifact b Binary Parsers @ Error Parsers
Logging
Settings # MCU Toolchain [mcu STM32F407VGTx Select...
i i MCU Setti
Tool Chain Edi S € '"QSI cpU Cortex-M4 (0) -
» C/C++ General (2 MCU Post build outputs
Project Natures v & MCU GCC Assembler Core 0 ~
Project Reference: (2 General Floating-point unit None v
i (2 Debuggin
Run/Debug Setti gging Floating-point ABl Software implementation (-mfloat-abi=soft) i
(% Preprocessor
(% Include paths Instruction set Thumb2 v
& Miscellaneous Runtime library Reduced C (--specs=nano.specs) w
¥ ® MCUGCCC il
& General ompler [T]Use float with printf from newlib-nano (-u _printf_float)
2 Debugging [_J Use float with scanf from newlib-nano (-u _scanf_float)
(% Preprocessor
(% Include paths
(2 Optimization
& Warnings
(# Miscellaneous
v 8 MCU GCC Linker
(% General
(% Libraries
(= Miscellaneous

< > Restore Defaults . Apply

@ Apply and Close Cancel

Tip: cot™ projects can also be used to produce target independent applications or executable projects.

2.3 Configure the project build setting

When an STM32 project is created, it contains default C/C++ build settings for the project. There are however
a lot of different options that can be used by GCC, each embedded system having its own requirements. It is
therefore possible to configure the project build settings further than the default build settings.
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It is also common to have different requirements on build settings during different phases of the project
development; for instance during the debugging and release phases. To handle this, different build configurations
for each project are supported by STM32CubelDE. This section presents the build configurations first, and then
the project build settings.

231 Project build configuration

Each build configuration allows different variants of a project and contains a specific build setting. When an
STM32 project is created in STM32CubelDE, two build configurations, Debug and Release, are created by
default. The Debug configuration makes the project built with debug information and without any optimization.
The Release configuration makes the project optimized for smaller code size and with no debug information. By
default, the Debug configuration is set as the active build configuration when the project is created.

It is possible to create new build configurations for a project at any time. Such new build configuration can be
based on an earlier available build configuration.

When building the project, the active build configuration is used and during build the files generated are written
into a folder with the same name as the active build configuration.

Note: The build configuration only handles the build settings. How to configure debug settings is described later in this
manual.
2.3.1.1 Change the active build configuration

To change the active build configuration:
1. Select the project name in the Project Explorer
2.  Use the toolbar in the C/C++ perspective and click on the arrow to the right of the [Build] toolbar button

Q v
3. The build configurations are listed
Select the build configuration to use from the list.

Figure 59. Set the active build configuration using the toolbar

Eworkspacefum - myLib/Sr¢/mylib.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

Nl -{R-EN@Oig-ai~ @ik

&5 Project Explorer (% | Debug

- .
mmyle 3 Release
> @;Archives = FERRERE A

D Y P - e

2 Debug2 (My own debug2 configuration)

Another way to change the active build configuration is to right-click on the project name in the Project Explorer
view, select [Build Configurations]>[Set Active], and select the preferred build configuration.
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Figure 60. Set active build configuration using right-click

Eworkspacefum - myLib/Src/myLib.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

RS- R BiINQ G E -G i-idy !
[ Project Explorer 7 =T
meyLib

> @%Archives

> @Includes
> [ inc
v (Esrc
> g myLib.c
> || syscalls.c
> @ sysmem.c
> [=Debug
“ ENUCLE(\ CAN4ADE
> ﬁ',’ Bina N ’

> |@-]|F‘IC|L Go Into
v £ Core Open in New Window

7 2N copy Ctrl+C
? 2SS [ Ppaste Ctri+V
> =S x Delete Delete
v 2 Driv Source >
>
> gg Move...
> = Deb Rename... F2

mNUCm Import...
STNﬂzﬂ Export...
STV Build Project
Clean Project
& | Refresh F5

Close Project

Close Unrelated Projects

Build Configurations v 1 Debug Set Active >
Build Targets 2 Release Manage...
Index > Build Al
Show in Remote Systems view Clean All
0 Run As > Build Selected...
"til Debug As >
Profile As >
Team >
Compare With >
Restore from Local History...
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It is also possible to select the active build configurations using the menu [Project]>[Build Configurations]>[Set
Active] and select the chosen build configuration.

Figure 61. Set active build configuration using menu

Eworkspacefum - myLib/Src/myLib.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

L—ﬁ,wm‘ Open Project a% v @l}'@'#ﬁ'@@/‘

Close Project

Project Ex & T = 0
T3 Project Exf & Build Al Ctrl+B 5
v E%YL'b Build Config v 1 Debug Set Active >
’ D_;Arch Build Project 2 Release Manage...
? [ Inclu . .
> EBinc Build Working Set > Build by Working Set >
v @Bsrc Clean... Set Active by Working Set >
> @ m ' Build Automatically Manage Working Sets...
> [d sy Build Targets >
> [ sy C/C++ Index >
> [==Debt Generate Report
v EENUCLEC (5 Generate Code
> ﬁ‘: Binal .
o Properties
2.3.1.2 Create a new build configuration
To create a new build configuration:
1. Right-click on the project name in the Project Explorer view
2. Either:
—  Select [Build Configurations]>[Manage... ]
- Use the menu [Project]>[Build Configurations]>[Manage... ]
Both methodes open the Manage Configurations dialog.
Figure 62. Manage Configurations dialog
L. NUCLEO-F401RE: Manage Configurations X
Configuration Description Status
Debug Active
Release
Set Active ‘ ‘ New... ‘ ‘ Delete ‘ ‘ Rename... ‘
| oK | ‘ Cancel ‘
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As shown in Figure 62, some buttons in the dialog are used to manage the configurations:
. [Set Active] is used to change and select another configuration to be active

. [New...] is used to create a new build configuration

. [Delete] is used to delete an existing build configuration

. [Rename...] is used to rename the build configuration

To create a new build configuration, press the [New...] button. This opens the Create New Configuration dialog. In
this dialog, a name and description is entered. The name must be a valid directory name since it is used as the
directory name when building the project with the new configuration.

Figure 63. Create a new build configuration

E Create New Configuration X

Note: The configuration name will be used as a directory name in the file
system. Please ensure that it is valid for your platform.

Name: ‘ Debug2 |

Description: ‘ My own debug configuration |

Copy settings from

® Existing configuration

O Default configuration
Release
O Import from projects - not selected - e
O Import predefined -- not selected -- e
OK | ‘ Cancel

As seen in Figure 63, the new build configuration is based on an existing build configuration. In the case
illustrated, the new configuration is based on the existing Debug configuration. Press [OK] when finished with the
settings.

The Manage Configurations dialog opens and the new debug configuration is displayed.

Figure 64. Updated Manage Configurations dialog

E NUCLEO-F401RE: Manage Configurations X
Configuration Description Status
Debug Active
Debug?2 My own debug con...
Release
Set Active ‘ New... ‘ ‘ Delete ‘ ‘ Rename... ‘
| OK | ‘ Cancel ‘
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Change the active configuration to another configuration if needed and press [OK] to save and close the
configurations dialog when finished managing configurations.

2.3.1.3 Delete a build configuration
To delete a build configuration:
1. Open the Manage Configurations dialog
2.  Select the configuration to be deleted
3. Press the [Delete] button

For instance, if the Debug?2 configuration is selected and [Delete] button is pressed, the following confirmation
dialog opens.

Figure 65. Configuration deletion dialog

[T confirm Delete X

@ Are you sure you want to delete the "Debug2" configuration?

In this case, select [No] to keep the Debug2 configuration.

2.3.1.4 Rename a build configuration
To rename a build configuration:
1. Open the Manage Configurations dialog
2. Select the configuration to be renamed
3. Press the [Rename...] button

For instance, if the Debug2 configuration is selected and [Rename...] button is pressed, the following
confirmation dialog opens.

Figure 66. Configuration renaming dialog

E Rename Configuration X

Note: The configuration name will be used as a
directory name in the file system. Please ensure that it
is valid for your platform.

Name: ‘ ‘DebugZ ‘

Description: ‘ My own debug2 configuration ‘

| oK | ‘ Cancel ‘

Update the name, description, or both and press [OK] to rename the Debug?2 configuration. In this case, press
[Cancel] and keep the name.
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2.3.2 Project C/C++ build settings

Each build configuration contains one project C/C++ build setting. The project C/C++ build setting is updated in
project properties. To update the build setting, right-click on the project name in the Project Explorer view and
select [Properties]or use the menu [Project]>[Properties]. Both these ways open the Properties window for the
project.

Select [C/C++ Build]>[Settings] in the Properties left pane. The right part is then filled with tabs Tool Settings,
Build Steps, Build Artifact, Binary Parsers, and Error Parsers. The first two tabs are the most useful ones.

Figure 67. Properties tabs

E Properties for NUCLEQ-FA01RE

O X
| type filter text Settings D M
> Resource A o
Builders -
v C/C++ Build Configuration: Debug [ Active ] ~ Manage Configurations...
Build Variak
Environmer . ) . . . -
Logai % Tool Settings . Build Steps Build Artifact ks Binary Parsers @ Error Parsers
ogging
Settings # MCU Toolchain Mcu STM32F401RETx
) » .
C/C++ Genera (MCU Settings Board NUCLEO-F401RE
CMSIS-SVD Se =MCU Post build outputs . . )
Project Referer ¥ v % MCU GCC Assembler Floating-point unit FPv4-SP-D16 e
< > o~ " Elnatina_naint ARl [Hardiars lmnlamantatinm L_mmflast_aki—hasdl v N
@

Apply and Close Cancel

Note: Resize the dialog window or use the top-right arrow buttons if all tabs are not visible.

The Settings pane contains a [Configuration] selection to decide if new selections are used in the active

configuration only, in another configuration, in all configurations or in multiple configurations. Press [Manage
Configurations] to open the Manage Configurations dialog.

Figure 68. Properties configurations

m Properties for NUCLEO-F401RE O K
r I I I
| type filter text Settings PYT oY
> Resource A ] I ~ I
Builders
v C/C++ Build Configuration: Debug [ Active ] ~ | Manage Configurations...
Build Variat Delnig || Active ]
Environmer i Debug?2
Logging ® Tool SettingRelease Error Parsers
Setti [ All configurations ]
etings € MCU Toq Multiple configurations...]
» C/C++ Generz ¥ T

=MCU Settinas P

The Tool Settings tab is further split into MCU Toolchain, MCU Settings, MCU Post build outputs, MCU GCC
Assembler, MCU GCC Compiler and MCU GCC Linker.

MCU Toolchain is used to change toolchains. STM32CubelDE includes one version of the GNU Tools for STM32

toolchain. The Toolchain Manager is used to download other GNU ARM Embedded toolchains and to configure to
use local GNU ARM Embedded toolchains.
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Information about patches made in GNU Tools for STM32 can be read in [EXT-12]. The document can be opened
from the Technical Documentation page in the Information Center.

Figure 69. Properties toolchain version

m Properties for NUCLEO-F401RE

O X
r 2 1
| type filter text | Settings v oo o§
> Resource 1A
Builders -
v C/C++ Build Configuration: Debug [ Active |

~  Manage Configurations...
Build Variables

Environment
Logging
Settings
» C/C++ General
CMSIS-SVD Settin
Project Reference
Run/Debug Settin

% Tool Settings # Build Steps Build Artifact i Binary Parsers @ Error Parsers

# MCU Toolchain Select what toolchain to use
#MCU Settings
EMCU Post build outputs
> ®MCU GCC Assembler
> ®MCU GCC Compiler
» ®MCU GCC Linker

®) Use workspace setting (GNU Toals for STM32 (9-2020-q2-update))
OFixed GNU Tools for STM32 (9-2020-g2-update)

Toolchain Manager

Configure the workspace toolchain, and manage installed toolchains.

Open Toolchain Manager...
< > e
@ Apply and Close Cancel
Select [Fixed] to enable the toolchain selection.
Figure 70. Properties toolchain selection
m Properties for NUCLEQO-F401RE O X
r n I
| type filter text | Settings M
> Resource ‘A
Builders -
v C/C++ Build Configuration: Debug [ Active ] ~ Manage Configurations...
Build Variables
Environment )
Loqai % Tool Settings # Build Steps Build Artifact G Binary Parsers @ Error Parsers
ogging
Settings # MCU Toolchain Select what toolchain to use
’ Eﬁ; g ;5\:-‘89;3' _ EMCU Settings O Use workspace setting (GNU Tools for STM32 (9-2020-g2-update))
- ettin ;
broect Reference EMCU Post build outputs @) Fixed 'GNU Tools for STM32 (9-2020-g2-update) -
R0 r: Debug Settin || | B MCU GCC Assembler QU Tools for STM32 (9-2020-g2-update)
9 » ®MCU GCC Compiler Toolchain Manager
> ®MCU GCC Linker Configure the workspace toolchain, and manage installed toolchains.
Open Toolchain Manager...
< > N
@ Apply and Close Cancel

As shown in Figure 70, only the default toolchain GNU Tools for STM32 is available by default. To install
additional toolchains, click on the [Open Toolchain Manager...] button to open the Toolchain Manager.

Section 2.11 Toolchain Manager contains detailed information on how to install, uninstall toolchains and select
the default workspace toolchain.
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MCU Settings displays the selected MCU and board for the project and proposes to select how to handle floating

point, instruction set and runtime library.

Figure 71. Properties tool MCU settings

m Properties for NUCLEO-F401RE

| type filter text | Settings
> Resource
Builders
v C/C++ Build Configuration: Debug [ Active |

Build Variables

Envi t
nvironmen % Tool Settings # Build Steps

Logging
Settings # MCU Toolchain
» C/C++ General (2 MCU Settings

CMSIS-SVD Settin #MCU Post build outputs
Project Reference % MCU GCC Assembler
Run/Debug Settin 2 General
(#Debugging
(= Preprocessor
#lInclude paths
= Miscellaneous
v ®MCU GCC Compiler
= General
(**Debugging
(= Preprocessor
#lInclude paths
(= Optimization
#Warnings
=Miscellaneous
v ®MCU GCC Linker

= General

& Libraries

= Miscellaneous
< > =

~  Manage Configurations...

Build Artifact ¢ Binary Parsers @ Error Parsers

Mcu STM32F401RETx

Board NUCLEO-F401RE

Floating-point unit FPv4-SP-D16

Floating-point ABI Hardware implementation (-mfloat-abi=hard)
Instruction set Thumb2

Runtime library Reduced C (--specs=nano.specs)

[ use float with printf from newlib-nano (-u _printf_float)

[Juse float with scanf from newlib-nano (-u _scanf_float)

Apply and Close

Cancel
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MCU Post build outputs proposes to convert the e1£ file to another file format, show build size information, and
generate list file. The output file can be converted to:

. Binary file

. Intel Hex file

. Motorola S-record file

. Motorola S-record symbols file

. Verilog file
Figure 72. Properties tool MCU post-build settings
m Properties for NUCLEO-F401RE OJ X
|
type filter text Settings Py g
> Resource ‘A
Builders
v C/C++ Build Configuration: Debug [ Active ] ~ Manage Configurations...
Build Variables
Environment .
Logging ® Tool Settings # Build Steps Build Artifact i Binary Parsers @ Error Parsers
Settings € \ICU Toolchain Convert to binary file (-O binary)
7 C/C++ General . = MCU Settings [ convert to Intel Hex file (-O ihex)
CM.SIS-SVD Settin 2MCU Post build outputs 7] Convert to Motorola S-record file (-O srec)
EFOJeCt Referenc.e v EMCU GCC Assembler [ convert to Verilog file (-O verilog)
un/Debug Settin &General
2 Debugging [[]Convert to Motorola S-record (symbols) file (-O symbolsrec)
& Preprocessor Show size infarmation about built artifact
#1nclude paths Generate list file
(= Miscellaneous
v BMCU GCC Compiler
= General
=Debugging
(Preprocessor
ZInclude paths
(*Optimization
#Warnings
(#Miscellaneous
v ®MCU GCC Linker
General
ELibraries
#Miscellaneous
< > v
@ Cancel

page 58/245




UM2609

Configure the project build setting

UM2609 - Rev 6

The MCU GCC Assembler settings contains selections for the assembler. The main node presents all the
assembler command-line options that are currently enabled in the sub-node settings. The sub-nodes are used to
view the current settings or change any settings for the assembler.

Figure 73. Properties tool GCC assembler settings

m Properties for NUCLEO-F401RE OJ X
| type filter text | Settings CYorE
> Resource ‘A
Builders . - -
v C/C++ Build Configuration: Debug [ Active | ~  Manage Configurations...
Build Variables
Environment . o . . i
Logging ® Tool Settings * Build Steps Build Artifact & Binary Parsers © Error Parsers
Settings ® \ICU Toolchain Command:  gcc
’ Eﬁ;;g\?;esra:t. EMCU Settings. All options:  -mcpu=cortex-m4 -g3 -c -x assembler-with-cpp --
; etn EMCU Post build outputs specs=nano.specs -mfpu=fpva-sp-d16 -mfloat-abi=hard -mthumb
Project Reference i MCU GCC Assembler
Run/Debug Settin & General
&Debugging Expert settings:
(= Preprocessar
&Include paths ‘C."mma"d ~ ${COMMAND} ${FLAGS) $(OUTPUT_FLAG) ${OUTPUT PREFIX)${OUTPU
(2 Miscellaneous ine pattern:
v ®MCU GCC Compiler
(= General
(#Debugging
(= Preprocessor
#lInclude paths
(#Optimization
#'Warnings
EMiscellaneous
v ®MCU GCC Linker
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< > v
@ Cancel
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The MCU GCC Compiler settings contains selections for the compiler. The main node presents all the compiler
command-line options that are currently enabled in the sub-node settings. The sub-nodes are used to view the
current settings or change any settings for the compiler.

Figure 74. Properties tool GCC compiler settings
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@ Apply and Close Cancel
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The MCU GCC Linker settings contains selections for the linker. The main node presents all the linker command-
line options that are currently enabled in the sub-node settings. The sub-nodes are used to view the current
settings or change any settings for the linker.

Figure 75. Properties tool GCC linker settings

m Properties for NUCLEO-F401RE OJ X
:type filter text Settings Sholzns o
» Resource }A
Builders
v C/C++ Build Configuration: Debug [ Active ] ~ Manage Configurations...
Build Variables
Environment .
Logging ® Tool Settings * Build Steps Build Artifact & Binary Parsers © Error Parsers
Settings ® \ICU Toolchain Command:  gcc
> Eﬁ;; SG\?;esrd . EMCU Settings_ All options:  -mcpu=cortex-m4 -T"C:\Users\johansse\STM32CubelDE ~
21>V settin EMCU Post build outputs \workspace_umS5\NUCLEO-F401RE\STM32F401RETX_FLASH.Id" --
Project Reference ¥ ®MCU GCC Assembler specs=nosys.specs -W|,-Map="${BuildArtifactFileBaseName}.map" “
Run/Debug Settin & General
- )
& Debugging Expert settings:
(= Preprocessar c J
#Include paths H::’”;;Zm_ ${COMMAND} ${OUTPUT_FLAG} ${OUTPUT_PREFIX}${OUTPUT} ${INPU
(2 Miscellaneous P ’
v ®MCU GCC Compiler
(= General
(#Debugging
(= Preprocessor
#lInclude paths
(#Optimization
#'Warnings
(=Miscellaneous
v ¥ MCU GCC Linker
=General
FLibraries
= Miscellaneous
< > v
@ Apply and Close Cancel
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The Build Steps settings contains fields used to provide pre-build and post-build steps, which run before and after
building the project. Edit the fields to run any pre-build or post-build step.

Figure 76. Properties build steps settings

[T Properties for NUCLEO-F401RE O X
‘type filter text Settings Pvyoovw
> Resource
v C/C++ Build ~
Build Variables Configuration: ‘Debug [ Active ] v ‘ |Manage Configurations...|

Discovery Options
Environment

Logging B3 Tool Settings - Build Steps Build Artifact Binary Parsers €3 Error Parsers -
Settings
> C/C++ General Pre-build steps
CMSIS-SVD Settings Command:

Project Natures ‘
Project References
Run/Debug Settings Description:

‘ e ‘

Post-build steps

Command:
| -]
Description:
| Y]
@ | Apply and Close ‘ | Cancel ‘
Note: It is possible to add more advanced post-build operations using makefile targets as described in Section 2.4.7 .

24 Building the project

To start a build, select the corresponding project in the Project Explorer view and click on the [Build] A~
toolbar button.

Figure 77. Project build toolbar

E workspace_um4 - NUCLEQ-F401RE/Core/Src/main.c - 5TM32CubelDE
File Edit Source Refactor Mavigate Search Project Run Window Help

HuRdFREIR Rl WA - AU ASCRNCRAIE R’ RA R

B Project Explorer 53 | | Build ‘Debug’ for project 'NUCLEO-FAIRE | = =

The build can also be started from menu [Project]>[Build Project]. The [Project] menu contains also some other
usable build commands such as [Build All], [Build Project] or [Clean].

Another way to start a build is to right-click on the project in the Project Explorer view. This opens the context
menu with the [Build] command and some other build options.

During the build, the Console view lists the build process. At the end, when the e1 £ file is created normally, it lists
size information.
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Figure 78. Project build console

[;__Z Problems ¥ Tasks & Console &2 [ Properties G '1/} <-===!>‘ '—E Eﬁ ] =~ l.-ﬁ v = 0
CDT Build Console [NUCLEOQ-F401RE]
arm-none-eabl-gcc “../CoOre/Src/main.c” -mcpuscortex-mé4 -std=gnull -g3 -DUSE_HAL_DRLVER -DSIM32F401XE -DDEBUG -C -L.

arm-none-eabi-gcc "../Core/Src/stm32f4xx_hal_msp.c" -mcpu=cortex-m4 -std=gnull -g3 -DUSE_HAL_DRIVER -DSTM32F401xE -
arm-none-eabi-gcc "../Core/Src/stm32f4xx_it.c" -mcpu=cortex-m4 -std=gnull -g3 -DUSE_HAL_DRIVER -DSTM32F4@1xE -DDEBU
arm-none-eabi-gcc "../Core/Src/syscalls.c" -mcpu=cortex-m4 -std=gnull -g3 -DUSE_HAL_DRIVER -DSTM32F4@1xE -DDEBUG -c
arm-none-eabi-gcc "../Core/Src/sysmem.c" -mcpu=cortex-m4 -std=gnull -g3 -DUSE_HAL_DRIVER -DSTM32F4@1xE -DDEBUG -c -
arm-none-eabi-gcc "../Core/Src/system_stm32f4xx.c" -mcpu=cortex-md -std=gnull -g3 -DUSE_HAL_DRIVER -DSTM32F4@1xE -D|
arm-none-eabi-gcc -o "NUCLEO-F4@1RE.elf" @"objects.list” -mcpu=cortex-m4 -T"C:\Users\johansse\STM32CubeIDE\worksp
Finished building target: NUCLEO-F4@1RE.elf

arm-none-eabi-size  NUCLEO-F481RE.elf

arm-none-eabi-objdump -h -S NUCLEO-F481RE.elf > "NUCLEO-F4@1RE.list"
text data bss dec hex filename
7308 20 1636 8964 2304 NUCLEO-F4@1RE.elf

Finished building: default.size.stdout

Finished building: NUCLEO-F4@1RE.list

12:42:04 Build Finished. @ errors, @ warnings. (took 5s5.932ms)

241 Building all projects

The toolbar contains the [Build all] 1o button, which is used to build the active build configuration for all open
projects in workspace.

It is also possible to use the menu [Project]>[Build All] to start a build of all projects.

Figure 79. Project build all

Eworkspacefum - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help

rj'._m_.\n,| Open Project 5w (&~ @ v
B Close Project =1
Project E X
BB L Build Al Ctrl+B
v E%yl"b Build Configurations >
> HigArch Build Project
> i Inclu . .
Build Working Set >
» [E1nc
Clean...
> [BSrc . .
+ Build Automatically
> [=Debt
W ENUCLEC Build Targets >
> ﬁﬁBinal C/C++ Index >

> i Inclu Generate Report
v 2 Core Generate Code

7 =In
> 7= Sre

Properties

24.2 Build all build configurations

To build all build configurations for a project, right-click the project and select [Build Configurations]>[Build All]
in the context menu.
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Figure 80. Project build-all configurations

5 Project Explorer 52 g == 0 [g
v mmyLib
> ﬁ,Archives
> [l Includes
> [Einc
> [Bsrc
> (= Debug
v [ENUCLED- ~ -
> ﬁ'}Binariw
N @]Includ Go Into
v [ Core Open in New Window

> =InclE) Copy Ctrl+C
v =S¢ Paste Ctrl+V
> (2] 3¢ Delete Delete
> [g] Source >
> g Move...
> @ Rename... F2
> (g
> @ 2 Import..
/5
> EbStau Export...

> [“2 Driver Build Project
> (= Debu Clean Project
> (= Debu( & | Refresh F5
> [=>Releas Close Project
mNUCL Close Unrelated Projects

[1d STM3 Build Configurations > Set Active
[ STM3 Build Targets > Manage...
Index > Build All
Show in Remote Systems view Clean All
0 Run As > Build Selected...
B A N x .

24.3 Headless build

Headless build is intended to be used to build projects that must be integrated into script-controlled builds, such
as nightly builds on build servers for continuous integration process methods or others. The STM32CubelDE GUI
is never displayed in this case, and the user is not requested any manual interaction with STM32CubelDE.

STM32CubelDE includes a headless-build command file to run headless builds. For instance, when using

Windows®, it is located in the C: \sT\ STM32CubeIDE 1.7.0\STM32CubeIDE STM32CubelDE installation
folder. The headless-build.bat file is intended to be run from a command prompt.

Note: Before running any headless build, make sure that the workspace is not opened by STM32CubelDE. If there
is an STM32CubelDE running already using the workspace, it is not possible for the headless-build process to
open and build the project.

To run headless build in Windows®, use the following procedure:

1. Open a command prompt.

2. Navigate to the STM32CubelDE installation directory. Open the folder in which the IDE is stored.
For example: cd C: \ST\STM32CubeIDE 1.7.0\STM32CubelDE

3.  Enter the following command to build the NUCLEO-F401RE project in the workspace
C:\Users\Name\STM32CubeIDE\workspace 1.7.0:

$ headless-build.bat -data C:\Users\Name\STM32CubeIDE\workspace 1.7.0
-cleanBuild NUCLEO-F401RE
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To get help on headless build parameters, use headless build with option —help. Figure 81 shows the result of
command $ headless-build.bat -help.

Headless build

EX Command Prompt — O X

C:\ST>cd STM32CubeIDE_1.7.6.2lalphal

IC:\ST\STM32CubeIDE_1.7.@.21alphal>headless-build.bat -help
Usage: PROGRAM -data <workspace> -application org.eclipse.cdt.managedbuilder.core.headlessbuild [ OPTIONS ]

-data {/path/to/workspace}

-import {[uri:/]/path/to/project}

-importAll {[uri:/]/path/to/projectTreeURI} Import all projects under URI

-build {project_name_reg_ex{/config_reg_ex} | all}

-cleanBuild {project_name_reg_ex{/config_reg ex} | all}

-markerType Marker types to fail build on {all | cdt | marker_id}

-no-indexer Disable indexer

-printErrorMarkers Print all error markers

-1 {include_path} additional include_path to add to tools

-include {include_file} additional include_file to pass to tools

-D {prepoc_define} addition preprocessor defines to pass to the tools

-E {var=value} replace/add value to environment variable when running all tools

-Ea {var=value} append value to environment variable when running all tools

-Ep {var=value} prepend value to environment variable when running all tools

-Er {var} remove/unset the given environment variable

-T {toolid} {optionid=value} replace a tool option value in each configuration built

-Ta {toolid} {optionid=value} append to a tool option value in each configuration built

-Tp {toolid} {optionid=value} prepend to a tool option value in each configuration built

-Tr {toolid} {optionid=value} remove a tool option value in each configuration built
Tool option values are parsed as a string, comma separated list of strings or a boolean based on the options type

C:\ST\STM32CubeIDE_1.7.0.21alphal>

Temporary assembly file and preprocessed C code

Save the temporary assembly file by adding the -save-temps flag to the compiler:
In the menu, select [Project]>[Properties]

Select [C/C++ build]>[Settings]

Open the Tool Settings tab

Add -save-temps in the [C Compiler]>[Miscellaneous] settings

SN

. Rebuild the project
The assembler file is located in the build output directory with name filename. s.
The file filenamz. i containing the preprocessed C code is generated also. It shows the code after the

preprocessor but before the compilation. It is advise to examine the content of this file in case of problems
with defines.

Build logging
To enable or disable project build logging, right-click on the project in the Project Explorer view and select
[Properties]. Then, select [C/C++ Build]>[Logging]. The log file location and name are also specified.

To enable a global build log for all projects in a workspace, select [Window], [Preferences], and open [C/C++,
Build, Logging]>[Enable global build logging].

Parallel build and build behaviour

Parallel build occurs when more than one thread is used at the same time to compile and build the code. Most
often, it reduces build time significantly. The optimal number of threads to use is usually equal to the number of
CPU cores of the computer. Parallel build can be enabled and disabled.

To configure parallel build:

1. Right-click on the project in the Project Explorer view

2. Select menu [Project]>[Properties]

3.  Select [C/C++ Build] in the Properties panel

4.  Open the Behavior tab and configure [Enable parallel build]

The Behavior tab also contains build settings on how to behave on errors, build on resource save, incremental
build, and clean.
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Figure 82. Parallel build

[ Properties for NUCLEO-FAO1RE O X
type filter text ~ C/C++ Build Ly y Y
> Resource
> C/C++ Build
> C/C++ General Configuration: ‘Debug [ Active ] V‘ ‘Manage Configurations...

CMSIS-SVD Settings
Project Natures

Project References E| Builder Settings Behavior Q§° Refresh Policy
Run/Debug Settings

Build settings

Stop on first build error Enable parallel build
® Use optimal jobs (4)
O Use parallel jobs: 4 z
O Use unlimited jobs

Workbench Build Behavior
Workbench build type: Make build target:

[]Build on resource save (Auto build) ‘all ‘ Variables...

Note: See Workbench automatic build preference

Build (Incremental build) ‘all ‘ ‘Variables...‘
Clean ‘ clean ‘ ‘Variables...‘
‘ Restore Defaults ‘ ‘ Apply ‘
@ | Apply and Close | | Cancel ‘

Post-build with makefile targets

It is possible to add advanced post-build scripts by using makefile targets. To do this:
1. Create a new file

2. Nameitmakefile.targets

3. Place it in the root directory of the project

The content of the file must be similar to the example presented below. The example just copies

the e1f generated file to a new file and uses macros BUILD ARTIFACT, BUILD ARTIFACT PREFIX,
BUILD ARTIFACT NAME, and BUILD ARTIFACT EXTENSION, which are generated into the makefile by
STM32CubelDE from v1.5.0.

secure target := \
S (BUILD_ARTIFACT PREFIX) S (BUILD ARTIFACT NAME)-secure. S (BUILD_ARTIFACT EXTENSION)
main-build: $(secure target)

$ (secure_target): $(BUILD ARTIFACT)
# Do what you want here... simple copy file for demo
cp "$<" "$@"

make requires that tabs are used instead of spaces.

Linking the project

This section contains basic information about the linker and linker script files. Detailed information about the linker
can be found in the GNU Linker manual ([EXT-05]), which is accessed from the Information Center. Click on the

[Information Center] toolbar button L] and open the Information Center view. Open the linker documentation
using the [C/C++ Linker The GNU Linker PDF] link.
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Figure 83. Linker documentation

@ o X
) information Center &% REoxra=0

TOOLCHAIN MANUALS (GNU-TOOLS-FOR-STM32.7-2018-Q2-UPDATE)

Description File format

Assembler PDF
The GNU Assembler _

Binary Utilities .
The GNU Binary Utilities _

C Math Library .
The Red Hat newlib C Math Library _

C Preprocessor

PDF
The GNU C Preprocessor *

C Runtime Library

PDF
The Red hat newlib C Library *

C++ Library Manual

HTML
The GNU C++ Library Manual

C/C++ Compiler

PDF
GNU Compiler Collection *

C/C++ Linker

PDF
The GNU Linker T

Debugger

PDF
Debugging with GDB *

GDB Quick Reference Card

PDF
The GNU GDB Reference Card o

Newlib-nano readme

TXT
Newlib-nano C runtime library readme _

Patch List PDF
Patch list for GNU Tools for STM32 _
2
< >
2.51 Run time library

The toolchains included in STM32CubelDE contain two prebuilt run time C libraries based on newlib. One is the
standard C newlib library and the other is the reduced C newlib-nano. Use newlib-nano to achieve smaller
code size. For information about the differences between newlib-nano and the standard newlib, refer to the
newlib-nano readme file ([ST-09]), accessible from the Information Center.

To select the desired run time library for use in the project.

1. Right-click on the project in the Project Explorer view

2. Select menu [Project]>[Properties]

3.  Select [C/C++ Build]>[Settings] in the Properties panel

4 Open the Tool Settings tab, select [MCU Settings] and configure the [Runtime library] setting
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Figure 84. Linker run time library

[ Properties for NUCLEO-FAO1RE O X
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> Resource
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Build Variables
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Configuration: ‘Debug [ Active ] v ‘ ‘Manage Conﬁgurations...‘

Environment

Logging & Tool Settings & Build Steps Build Artifact Binary Parsers 3 Error Parsers -
Settings
> C/C++ General @ MCU Settings Mcu STM32F401RETx
CMSIS-SVD Settings @ MCU Post build outputs Board NUCLEO-F401RE

Project Natures
Project References
Run/Debug Settings

v B3 MCU GCC Assembler
@ General
@ Debugging
(% Preprocessor
@ Include paths
@ Miscellaneous
v i3 MCU GCC Compiler
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(# Debugging
@ Preprocessor
2 Include paths
(% Optimization
@Warnings
@ Miscellaneous
v i MCU GCC Linker
@ General
@ Libraries
@ Miscellaneous

Floating-point unit FPv4-SP-D16

Floating-point ABI ‘Hardware implementation (-mfloat-abi=hard)

Instruction set ‘Thumbz

Runtime library Reduced C (--specs=nano.specs)
[ Use float with prigStandard C

[JUse float with scaf

@

| Apply and Close | | Cancel ‘

When newlib-nano is used while floating-point numbers must be handled by scanf/printf, additional
options are required. The reason is that newlib-nano and newlib handle floating-point numbers differently. In
newlib-nano, formatted floating-point number inputs and outputs are implemented as weak symbols. Therefore,
the symbols must be pulled by specifying explicitly if % is used with scanf/printf using the —u option:

. -u scanf float

. -u printf float

For example, to enable output f1oat with printf, the command line is as follows:

$ arm-none-eabi-gcc --specs=nano.specs -u _printf float $(OTHER LINK OPTIONS)
The options can be enabled using the [Use float ...] checkboxes in [MCU Settings] in the Tool Settings tab.

page 68/245




m UM2609

Linking the project

Figure 85. Linker newlib-nano library and floating-point numbers
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I
type filter text | Settings oYYy
> Resource L
v C/C++ Build - - -
Build Variables  Configuration: Debug [ Active ] ~ Manage Configurations...
Discovery Opti
EnV|r9nment # Toolchain Version & Tool Settings # Build Steps “' Build Artifact = Binary Parsers @ Error Parsers
ogging _
Settings #MCU Settings Mcu STM32F401RETx
» C/C++ General #MCU Post build outputs Board NUCLEO-F401RE
CMSIS-SVD Settin v B MCU GCC Assembler X i i
Project Reference & General Floating-point unit FPv4-SP-D16
Refactoring Histol #Debugging Floating-point ABI Hardware implementation (-mfloat-abi=hard)
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#Miscellaneous : ) ) i
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#Debugging
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= General
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< > e
@ Apply and Close Cancel

2.5.2 Discard unused sections

Linker optimization is the process where the linker removes unused code and data sections, dead code, from
the output binary. Run time and middleware libraries typically include many functions that are not used by all
applications, thus wasting valuable memory unless removed from the output binary.

When using the project wizard to create new projects, the default configuration is that the linker discards unused
sections. To check or change the setting about unused sections, open at any time the build settings for the
project:

Right-click the project in the Project Explorer view and select [Properties]

In the dialog, select [C/C++ Build]>[Settings]

Select the Tool Settings tab in the panel

Select [MCU GCC Linker]>[General]

Configure [Discard unused sections (-WI,--gc-sections)] according to the project requirements

Rebuild the project

R
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Figure 86. Linker discard unused sections
[T Properties for NUCLEO-FAO1RE O X
I Settings LYYy
> Resource
v C/C++ Build ~
Build Variables Configuration: ‘Debug [ Active ] v ‘ |Manage Configurations...

Discovery Options
Environment

;ogging # Toolchain Version & Tool Settings & Build Steps Build Artifact Binary Parsers @ Error Parsers
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CMSIS-SVD Settings (2 MCU Post build outputs - . ]
Project Natures « 15 MCU GCC Assembler System calls ‘Mlnlmal implementation (--specs=nosys.specs)
Project References @General Generate map file (-Wl,-Map=)
Run/Debug Settings @ Debugging [[]Add symbol cross reference table to map file (-WI,--cref)
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(#EInclude paths

@ Miscellaneous . .
v ) MCU GCC Compiler [ Do not use standard start files (-nostartfiles)

@General [ Do not use default libraries (-nodefaultlibs)

@ Debugging [INo startup or default libs (-nostdlib)

@ Preprocessor

(# Include paths

@Optimization

@Warnings

(2 Miscellaneous
v & MCU GCC Linker

@General

@ Libraries

@ Miscellaneous
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[ Verbose (-WI,--verbose)

@

Apply and Close | ‘ Cancel

253 Page size allocation for malloc

When the GNU Tools for STM32 toolchain is used with the standard C newlib library, the page size setting for
malloc can be changed. The newlib default page size is 4096 bytes. If a sysconf () function is implemented
in the user project, this user function is called by malloc r ().

The following example shows how to implement a sysconf () function with a 128-byte page size. Add a similar
function if there is a need for the application to use a smaller page size than the default 4096 bytes.

/**

LR R RS EEE SRS S S S SRR R EEEEEEEEEEEEEEEEEEEEEEEEREEEEEEE RS

**  File : sysconf.c

LR SRR E TR RS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE SRR

**/
/* Includes */
#include <errno.h>

#include <unistd.h>

long sysconf (int name)

{
if (name==_ SC PAGESIZE)
{
return 128;
}
else
{
errno=EINVAL;
return -1;
}
}
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Note: If the “GNU ARM Embedded” toolchain is used, it does not call any sysconf () function implemented in the

application but always uses the default sysconf () function in newlib. Also, no call to sysconf () is made if
the “GNU Tools for STM32” toolchain is used with the reduced C newlib-nano library.

254 Include additional object files

STM32CubelDE makes it easy to include additional object files that must be linked to a project. They can be files

from other projects, precompiled libraries where no source code is available, or object files created with other
compilers.

1. Right-click the project in the Project Explorer view and select [Properties]

In the dialog, select [C/C++ Build]>[Settings]

Select the Tool Settings tab in the panel

Select [MCU GCC Linker]>[Miscellaneous]

Use the [Add...] icon to add additional object files in several possible ways:
—  Enter the filenames in the Add file path dialog

—  Use the [Workspace...] or [File system...] buttons to locate the files

o eN

Figure 87. Linker include additional object files
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255 Treat linker warnings and errors
The GNU linker is normally silent for warnings. One example of such silent warning is seen if the startup code
containing the normal Reset Handler function is missing in the project. The GNU linker in normal silent mode
creates an e1f£ file and only report a warning output in the Console window about the missing Reset Handler.

Example of warning message:

arm-none-eabi-gcc -o "NUCLEO-F401RE.elf" @"objects.list" -mcpu=cortex-m4 -
T"C:\Users\username\STM32CubeIDE\workspace um\NUCLEO-F401RE\STM32F401RETX FLASH.1ld"
--specs=nosys.specs -Wl,-Map="NUCLEO-F401RE.map" -Wl,--gc-sections -static -
mfpu=fpv4-sp-dl6e -mfloat-abi=hard -mthumb -Wl,--start-group -lc -1lm -Wl,--end-group
c:\st\stm32cubeide 1.1.0.19w37\stm32cubeide\plugins\com.st.stm32cube.ide.mcu.extern
altools.gnu-tools-for-stm32.7-2018-g2-update.win32 1.0.0.201904181610\tools\arm-

none-eabi\bin\ld.exe: warning: cannot find entry symbol Reset Handler; defaulting
to 0000000008000000

Finished building target: NUCLEO-F401lRE.elf

In this case, a new e1f file is created but, if the warning is not detected, it will not work to debug the project
because the program does not contain the Reset Handler function. It is possible to configure the linker to treat
warnings as errors by adding the --fatal-warnings option.

When the --fatal-warnings option is used, the linker does not generate the e1f file but displays an error in
the console log:

c:\st\stm32cubeide 1.1.0.19w37\stm32cubeide\plugins\com.st.stm32cube.ide.mcu.extern
altools.gnu-tools-for-stm32.7-2018-g2-update.win32 1.0.0.201904181610\tools\arm-
none-eabi\bin\ld.exe: warning: cannot find entry symbol Reset Handler; defaulting
to 0000000008000000

collect2.exe: error: 1ld returned 1 exit status

make: *** [makefile:40: NUCLEO-F401RE.elf] Error 1

"make -j4 all" terminated with exit code 2. Build might be incomplete.
11:26:30 Build Failed. 1 errors, 6 warnings. (took 7s.193ms)

To use the -W1, --fatal-warnings option:

1. Right-click the project in the Project Explorer view and select [Properties]
In the dialog, select [C/C++ Build]>[Settings]

Select the Tool Settings tab in the panel

Select [MCU GCC Linker]>[Miscellaneous]

Add -wl,--fatal-warnings to the [Other flags] field.

o~ eN
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Figure 88. Linker fatal warnings

[ Properties for NUCLEO-FAO1RE O X

1 Settings Lreovyy
> Resource
v C/C++ Build ~

Build Variables Configuration: ‘Debug [ Active ] v ‘ ‘Manage Conﬁgurations...‘
Discovery Options

Environment
Logging & Tool Settings & Build Steps Build Artifact Binary Parsers 3 Error Parsers -
Settings
> C/C++ General @MCU Settings Other flags @ la @ '§| §|

CMSIS-SVD Settings (2 MCU Post build outputs :
. -WI,--fatal-warnings
Project Natures v 3 MCU GCC Assembler

Project References (# General
Run/Debug Settings (#2 Debugging

(% Preprocessor

2 Include paths

2 Miscellaneous
v i3 MCU GCC Compiler

@ General

(# Debugging

@ Preprocessor

@ Include paths

(% Optimization

@Warnings

(2 Miscellaneous Additional object files LEEARE R
v B MCU GCC Linker

@ General

2 Libraries

(% Miscellaneous

@ Apply and Close | | Cancel

2.5.6 Linker script

The linker script file (. 1d) defines the files to include and where things end up in memory. Some important parts
of the linker script file are described in the next sections. For detailed information about the linker, read the C/C++
linker GNU Linker manual ([ST-05]). This manual is available in the documentation section of the Information
Center. Consider sections 3.6 and 3.7 especially.

The linker script specifies the memory regions and the location of the stack, heap, bss, data, rodata, text,

and program entry. The size of stack and heap are configurable by editing the Min Stack Size and

~Min Heap Size values in the linker script file. However, these values are only used by the linker to validate
that stack and heap fit in memory. When running the program, the stack or heap may require more memory, which
may lead to unexpected results if data is overwritten.

Table 3 presents as an example the typical program and memory layout of an STM32F4 device with 512-Kbyte

flash memory and 96-Kbyte SRAM. The device is based on the Cortex®-M core with 32-bit address space
(0x0000 0000 to OxFFFF FFFF).

UM2609 - Rev 6 page 73/245



UM2609
Linking the project

Table 3. Memory map layout

Example: STM32F4 Files
96-Kbyte SRAM Linker script . 1d,
or .h and . cfiles

Comment

512-Kbyte flash memory

OXFFFF FFFF

0xE000 0000
OXDFFF FFFF

0x6000 0000
OX5FFF FFFF

0x4000 0000
0x2001 8000

0x2000 0000

0x0808 0000

0x0800 0000

Cortex®-M4 internal
peripherals.

External memory
FMC (Flexible
memory controller).

STM32 peripherals.

96-Kbyte SRAM
Stack

Heap

Data

512-Kbyte
flash memory
Data

Program

Interrupt
vector table

.hand . cfiles.

Must be added in linker script,

and .hand . cfiles.

.hand . cfiles.

Linker script
_estack
_Min Stack Size

_Min Heap Size
. _user heap stack

.bss

.data

Linker script
.data
.rodata

ENTRY
Reset Handler®
.text

.isr vector®

SysTick, NVIC, ITM, debug, and others.

NOR flash memory, NAND flash memory, SPI flash
memory, PSRAM, SDRAM, and others.

GPIO, ADC, timers, USB, USART, and others.

The stack contains local data'”)

@)

Heap used by malloc*)
Data

Static global data (.bss and .data)
.bss == Uninitialized data
Cleared to zero by the startup code.

.data == Initialized data
Copied from flash memory to SRAM by the startup code.

Initialized data to copy to SRAM.

Read-only data placed in flash memory.

.text == Program,suchasmain () inmain.c,
SystemInit () insystem stm32f4xx.c,
Reset Handlerin startup stm32*.s,

g _pfnVectorsinstartup stm32*.s,

Vector table in startup stm32*.s.

Color legend

Cortex®-M internal peripherals and STM32 peripherals.

External memory. Normally the linker script, header files, and C files must be updated to use external memories.

Flash memory and SRAM where program, data, heap, and stack are located. Usually, when creating a project with STM32CubelDE, these
flash memory and RAM regions are accessible and usable without any updates of the linker script or other files. The linker script file defines
how to place code, data, heap, and stack in memory.

1. If external memory is used, the memory must be added into the linker script file. See in chapter Section 2.5.7.1 how to add a new memory

region.

S 0 A W N

The stack grows downwards and may go into the heap.
When running the program, the stack or heap may require more memory, which might lead to unexpected results if data is overwritten.
The heap grows upwards and may go into the stack.

The linker script file contains the entry point definition of the program. Normally, ENTRY (Reset Handler).
The interrupt vector table contains the reset value of the stack pointer, the start addresses of the program (Reset Handler), exception

handlers, and interrupt handlers. Normally the Reset Handler code and vector table (g_pfnVectors) are available in file <startup s

tm32xxx.sS>.
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See below the default linker script generated by STM32CubelDE for an STM32F4 device with 512-Kbyte flash
memory and 96-Kbyte SRAM.

The beginning of the code excerpt shows the linker script header, entry, stack, heap and memory definitions.

/**

Ak khkhkhkhkhkh A hkhkhhhAhhhh A hkhhh Ak h kb bk hhrhhhhhh bk hhrh bk hhrhhkhhrhhkhhrhhkhkhrhhkhkdrhkhkhkhrhhrkx

* @file LinkerScript.1ld

* @author Auto-generated by STM32CubeIDE

* Abstract : Linker script for NUCLEO-F401RE Board embedding STM32F401RETx Device from

stm32f4 series
512Kbytes FLASH
96Kbytes RAM

Set heap size, stack size and stack location according
to application requirements.

Set memory bank area and size if external memory is used
Ak Kk kA hkhkhkh A hhhh A hhhh A hhkhh Ak hhh A hhkhkh Ak hhh Ak hhkrkh Ak hhrhhhkhkhkrhhkhkhkrhhhkdkrhkhkhkhkrhkhkhkhrhxkr*k

Qattention

<h2><center>&copy; Copyright (c) 2020 STMicroelectronics.
All rights reserved.</center></h2>

This software component is licensed by ST under BSD 3-Clause license,

the "License"; You may not use this file except in compliance with the

License. You may obtain a copy of the License at:
opensource.org/licenses/BSD-3-Clause

S T T S S S S S S S

*
LRSS RS SR RS E RS EE RS TR RS EE R T EE SRR SRR R SRR SRR EEEEEEEEEEEEEEEEEEEEEEEEEEE S S

*/

/* Entry Point */
ENTRY (Reset Handler)

/* Highest address of the user mode stack */

_estack = ORIGIN (RAM) + LENGTH (RAM) ; /* end of "RAM" Ram type memory */
_Min Heap_Size = 0x200; /* required amount of heap */
_Min Stack Size = 0x400; /* required amount of stack */

/* Memories definition */

MEMORY

{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K

}

The continuation of the code excerpt shows the definition of sections.
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/* Sections */
SECTIONS
{
/* The startup code into "FLASH" Rom type memory */
.isr_vector
{
= ALIGN (4) ;
KEEP (* (.isr vector)) /* Startup code */
= ALIGN (4) ;
} >FLASH

/* The program code and other data into "FLASH" Rom type memory */

.text
{
= ALIGN (4) ;
* (.text) /* .text sections (code) */
* (.text*) /* .text* sections (code) */
*(.glue 7) /* glue arm to thumb code */
*(.glue 7t) /* glue thumb to arm code */

*(.eh_frame)

KEEP (*(.init))
KEEP (*(.fini))

= ALIGN (4);
_etext = .; /* define a global symbols at end of code */
} >FLASH

/* Constant data into "FLASH" Rom type memory */

.rodata
{
= ALIGN (4);
*(.rodata) /* .rodata sections (constants, strings, etc.) */
*(.rodata*) /* .rodata* sections (constants, strings, etc.) */
= ALIGN (4);
} >FLASH
.ARM.extab g 1
= ALIGN (4);
*(.ARM.extab* .gnu.linkonce.armextab.*)
= ALIGN (4);
} >FLASH
.ARM : {
= ALIGN (4);
__exidx_start = .;
*(.ARM.exidx*)
__exidx_end = .;
= ALIGN (4);
} >FLASH

.preinit_array

{

= ALIGN (4);
PROVIDE HIDDEN (_ preinit array start = .);
KEEP (*(.preinit_array*))
PROVIDE_HIDDEN (_ preinit array end = .);
= ALIGN (4);
} >FLASH

.init array
{
= ALIGN (4);
PROVIDE _HIDDEN (__ init array start = .);
KEEP (*(SORT(.init_array.*)))
KEEP (*(.init_array*))
PROVIDE _HIDDEN (__ init array end = .);
= ALIGN (4);
} >FLASH
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.fini_array
{
= ALIGN (4);
PROVIDE HIDDEN ( fini array start = .);
KEEP (*(SORT(.fini array.*)))
KEEP (*(.fini_array*))
PROVIDE HIDDEN ( fini array end = .);
= ALIGN (4) ;
} >FLASH

/* Used by the startup to initialize data */
_sidata = LOADADDR(.data);

/* Initialized data sections into "RAM" Ram type memory */

.data
{
= ALIGN (4) ;
_sdata = .; /* create a global symbol at data start */
*(.data) /* .data sections */
* (.data*) /* .data* sections */
* (.RamFunc) /* .RamFunc sections */
* (.RamFunc¥*) /* .RamFunc* sections */
= ALIGN (4) ;
_edata = .; /* define a global symbol at data end */

} >RAM AT> FLASH

/* Uninitialized data section into "RAM" Ram type memory */
= ALIGN (4) ;

.bss :

{

/* This is used by the startup in order to initialize the .bss section */

_sbss = .; /* define a global symbol at bss start */
__bss start = _sbss;
*(.bss)
¥ (,Jogm™)
* (COMMON)
= ALIGN (4) ;
_ebss = .; /* define a global symbol at bss end */
__bss end = _ebss;
} >RAM

/* User _heap_ stack section, used to check that there is enough "RAM" Ram type memory left

*/
._user_heap stack
{
= ALIGN(8);
PROVIDE ( end = . );
PROVIDE ( _end = . );
= . + Min Heap_ Size;
= . + Min Stack Size;
. = ALIGN (8);
} >RAM

/* Remove information from the compiler libraries */
/DISCARD/

.ARM.attributes 0 : { *(.ARM.attributes) }

2.5.6.1 The ENTRY command defines the start of the program
The first instruction to execute in a program is defined with the ENTRY command.
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Example:

/* Entry Point */
ENTRY (Reset Handler)

The ENTRY information is used by GDB so that the program counter (PC) is set to the value of the ENTRY address
when a program is loaded. In the example, the program starts to execute from Reset Handler when a step or
continue command is given to GDB after a load.

Note: The start of the program can be overridden if the GDB script contains a monitor reset command after the load
command. Then the code starts to run from reset.

2.5.6.2 Stack location
The stack location is normally used by the startup file using the _estack symbol. The startup code normally

initializes the stack pointer with the address given in the linker script. For Cortex®-M based devices, the stack
address is also set at the first address in the interrupt vector table.

Example:

/* Highest address of the user mode stack */

_estack = ORIGIN (RAM) + LENGTH (RAM) ; /* end of "RAM" Ram type memory */
2.5.6.3 Define heap and stack minimum sizes

It is common to define in the linker script the heap and stack minimum sizes to be used by the system.

Example:
_Min Heap Size = 0x200; /* required amount of heap */
_Min Stack Size = 0x400; /* required amount of stack */

The values defined here are normally used later in the linker script to make it possible for the linker to test if the
heap and stack fit in the memory. The linker can then issue an error if there is not enough memory available.

2.5.6.4 Specify memory regions
The memory regions are specified with names ORIGIN and LENGTH. It is common also to have an attribute list

“_» “_n

specifying the usage of a particular memory region, such as (rx) with “r” standing for read-only section and “x
for executable section. It is not required to specify any attribute.

Example:

/* Memories definition */

MEMORY

{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K

}

2.5.6.5 Specify output sections (.text and .rodata)

The output sections define where the sections such as “.text’, ‘.data’ or others are located in the memory. The
example below tells the linker to put all sections such as . text, .rodata and others in the flash memory region.
The glue sections mentioned in the example are used by GCC if there are some mixed code in the program. For
instance, the glue code is used if some Arm® code makes a call to thumb code or vice versa.
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Example:

/* Sections */
SECTIONS
{
/* The startup code into "FLASH" Rom type memory */
.isr vector
{
= ALIGN (4);
KEEP (* (.isr vector)) /* Startup code */
= ALIGN (4);
} >FLASH

/* The program code and other data into "FLASH" Rom type memory */

.text
{
= ALIGN (4) ;

* (.text) /* .text sections (code) */
* (.text*) /* .text* sections (code) */
*(.glue 7) /* glue arm to thumb code */
*(.glue 7t) /* glue thumb to arm code */
*(.eh frame)

KEEP (*(.init))
KEEP (*(.fini))

= ALIGN (4) ;
Cetext =7 /* define a global symbols at end of code */
} >FLASH
2.5.6.6 Specify initialized data (.data)

Initialized data values require extra handling as the initialization values must be placed in the flash memory and
the startup code must be able to initialize the RAM variables with correct values. The example below creates
symbols sidata, sdataand edata. The startup code can then use these symbols to copy the values from
flash memory to RAM during program start.

Example:

/* Used by the startup to initialize data */
_sidata = LOADADDR (.data);

/* Initialized data sections into "RAM" Ram type memory */

.data
{
= ALIGN (4) ;
_sdata = .; /* create a global symbol at data start */
*(.data) /* .data sections */
*(.data*) /* .data* sections */
* (.RamFunc) /* .RamFunc sections */
* (.RamFunc¥*) /* .RamFunc* sections */
= ALIGN (4) ;
_edata = .; /* define a global symbol at data end */

} >RAM AT> FLASH

2.5.6.7 Specify uninitialized data (.bss)
Uninitialized data values must be reset to 0 by the startup code: the linker script file must identify the locations
of these variables. The example below creates symbols sbss and _ebss. The startup code can then use these
symbols to set the values of the uninitialized variables to 0.

UM2609 - Rev 6 page 79/245




m UM2609

Linking the project

Example:

/* Uninitialized data section into "RAM" Ram type memory */
. = ALIGN(4) ;
.bss :

{

/* This is used by the startup in order to initialize the .bss section */

_sbss = .; /* define a global symbol at bss start */
__bss start = sbss;
*(.bss)
*(.bss*)
* (COMMON)
. = ALIGN (4) ;
_ebss = .; /* define a global symbol at bss end */
__bss end = ebss;
} >RAM
2.5.6.8 Check if user heap and stack fit in the RAM

One section of the code is normally dedicated to linker checks about the fact that the needed heap and stack fit
into the RAM together with all other data.

Example:
/* User heap stack section, used to check that there is enough "RAM" Ram type memory left
=y
._user_heap_stack :
{
. = ALIGN (8);
PROVIDE ( end = . );
PROVIDE ( end = . );
. = . + Min Heap Size;
. = . + Min Stack_Size;
. = ALIGN (8) ;
} >RAM
Note: The stack is placed on top of RAM and heap after data with a gap in between. See Table 3. Memory map layout.
2.5.6.9 Linker map and list files

When building a project generated with STM32CubelDE, a map and a list file are created in the debug or
release build output folders. These files contain detailed information on the final locations of code and data in the
program.

The Build Analyzer view can be used to analyse the size and location of a program in detail. Read more about
this in Section 8 Build Analyzer.

2.5.7 Modify the linker script

This section presents common use cases requiring to edit the linker script. Editing and managing the script allows
for more exact placements of the code and data.
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2.5.7.1 Place code in a new memory region

Many devices have more than one memory region. It is possible to use the linker script to specifically place code
in different areas. The example below shows how to update a linker script to support code to be placed in a new
memory region named IP_CODE.

Example:
Original MEMORY AREA

/* Memories definition */

MEMORY
{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K
}
Add IP_CODE into MEMORY AREA
/* Memories definition */
MEMORY
{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 256K
IP _CODE (rx) : ORIGIN = 0x8040000, LENGTH = 256K
}
Place the following code a bit further down in the script, between the .data { ... } andthe .bss { ... }

section in the linker script file:

Example:

.ip code
{

*(.IP_Code*) ;
} > IP_CODE

This tells the linker to place all sections named . IP_Code* into the IP_CODE memory region, which is specified
to start at target memory address 0x804 0000.

In the C code, tell the compiler which functions must go to this section by adding
__attribute ((section(".IP Code"))) before the function declaration.

Example:

__attribute ((section(".IP Code"))) int myIP read()

{
// Add code here...
return 1;

The myIP read () function is now placed in the IP_CODE memory region by the linker.
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2.5.7.2 Place code in RAM

To place code in the RAM, some modifications of the linker script and startup code are needed. The example

below describes the changes to be applied when the internal RAM is split into a few sections and the code is
placed and executed in one of the internal RAM sections.

Define a new memory region in the MEMORY {} region in the linker script:
Original MEMORY AREA

/* Memories definition */

MEMORY

{
RAM (xxrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K

}

Split RAM into memory areas RAM1l, RAM CODE, RAM

/* Memories definition */

MEMORY

{
RAM1 (xxrw) : ORIGIN = 0x20000000, LENGTH = 16K
RAM CODE (xXrw) : ORIGIN = 0x20004000, LENGTH = 16K
RAM (xxrw) : ORIGIN = 0x20008000, LENGTH = 64K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K

Define an output section for the code in the linker script. This must be placed with a Load Memory Address (LMA)
belonging to the flash memory, and a Virtual Memory Address (VMA) in RAM:

/* load code used by the startup code to initialize the ram code */
_siram code = LOADADDR (.RAM CODE) ;

.RAM CODE :
{
= ALIGN (4) ;
_sram code = .; /* create a global symbol at ram code start */
* (.RAM Code) /* .RAM Code sections */
* (.RAM Code*) /* .RAM Code* sections */
= ALIGN (4) ;
_eram code = .; /* define a global symbol at ram code end */

} >RAM CODE AT> FLASH

The RAM code area must be initialized and code copied from the flash memory to the RAM code area. The
startup code can access the location information symbols _siram code, _sram code and eram code.

Add load address symbols for RAM _CODE into the startup file:
/* Load address for RAM CODE */
.word _siram_code;

.word _sram_ code;
.word _eram code;
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Add a piece of code into the startup code to copy the RAM code from the flash memory (LMA) to the RAM (VMA):

Reset Handler:
1dr sp, = estack /* set stack pointer */

/* Copy the ram code from flash to RAM */
movs rl, #0
b LoopRamCodeInit

RamCodeInit:
ldr r3, = siram code
1ldr r3, [r3, rl]
str r3, [r0, rl]

adds rl, rl, #4

LoopRamCodeInit:
ldr r0, = sram code
ldr r3, = eram code

adds r2, r0, rl
cmp r2, r3
bcc RamCodeInit

/* Copy the data segment initializers from flash to SRAM */
movs rl, #0
b LoopCopyDatalInit

CopyDatalInit:

In the C code, instruct the compiler about which functions must go to this section by adding
__attribute  ((section(".RAM Code"))) before the functions declarations:

__attribute ((section(".RAM Code"))) int myRAM read/()
{

// Add code here...

return 2;

}

Refer to [ST-12] for information on how to execute application code from CCM RAM using STM32CubelDE. It
contains examples on how to setup the linker script and startup code to execute a function or an interrupt handler
from RAM. The example in the chapter 4 of [ST-12] can be used as an inspiration on how to add other RAM
regions and setup code sections to be located in RAM.
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2.5.7.3 Place variables at specific addresses

It is possible to place variables at specific addresses in the memory. To achieve this, the linker script must be
modified. The example presented in this section places constant variables handling a product VERSION NUMBER,
CRC_NUMBER, and BUILD_ID in memory.

The first step is to create a new memory region in the linker script:

Original MEMORY AREA

/* Memories definition */

MEMORY
{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K
}
Add a new 2K FLASH V memory region at end of flash
/* Memories definition */
MEMORY
{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K-2K
FLASH V (rx) : ORIGIN = 0x807F800, LENGTH = 2K
}
At this point, the memory section must be added:
Place the following a bit further down in the script, between the .data { ... } and the .bss
{ ... } section
.flash v

{
*(.flash v¥);
} > FLASH V

This instructs the linker to place all sections named flash v* into the f1ash_ v output section in the FLASH Vv
memory region, which is specified to start at target memory address 0x807 F800.

A section can be called almost anything except some predefined names such as “data”.

Now, the variables that must be located into the FLASH v memory must be defined with attributes in the C files:

__attribute ((section(".flash v.VERSION"))) const uint32 t VERSION NUMBER=0x00010003;
__attribute ((section(".flash v.CRC"))) const uint32 t CRC_ NUMBER=0x55667788;
__attribute ((section(".flash v.BUILD ID"))) const uintl6 t BUILD ID=0x1234;

Important: Unless the variable is referenced in the code, the linker is allowed to garbage collect it.
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When debugging this example and examining the memory, it can be observed that:

. Address 0x807 £800 contains VERSION NUMBER
. Address 0x807 £804 contains CRC_NUMBER
. Address 0x807 £808 contains BUILD ID

Figure 89. Linker memory output

0] o X
ﬂ Memory &2 101 1010 |_|<> d‘ﬁE |§|§|<}_=-4>| EE' > - = A
Monitors + & & ‘0x807f800 : 0x807F800 <Hex> = l ar New Renderings...‘
@ 0x807f800 Address © - 3 4 -7 8 - B Cc-F A
©0807F800 03000100 88776655 3412FFFF  FFFFFFFF
m FEFFFEFEFFE FEFFFEFEF FEFEEEFFE FEFEEEFFE v

If the inserted data order in the flash memory is important, map the order of the variables in the linker script.

This makes it possible to define the variables in any file. The linker outputs the variables in the defined order
independently on how the files are linked. As a result, if the CRC_NUMBER is calculated in some way after the
linker has built the file, the CRC_NUMBER can be inserted into the flash memory file by another tool:

Decide the order in the linker script by adding the specially named sections in order
BUILD ID, VERSION NUMBER, CRC NUMBER, and others(*).

.flash v :

* (.flash v.BUILD ID*);
*(.flash v.VERSIONY*) ;
*(.flash v.CRC*);

* (.flash_v*);

> FLASH V

When debugging this example and examining the memory, it can be observed that:
. Address 0x807 £800 contains BUILD ID

. Address 0x807 £804 contains VERSION NUMBER

. Address 0x807 £808 contains CRC_NUMBER

Figure 90. Linker memory output specified order

ine} m| X

00 Memory 2 1019 1910 Lloﬁ‘iﬁé E|i|<=:l>|EEI' — = 5
Monitors 4 3¢ %  0x807f800 : 0x807F800 <Hex> 3 i New Renderings..

@ 0x807f800
@ 0x807f800

Address
©887F800

e -3
34120000

4 -7
93000100

8 -8B
88776655

cC-F ~
FFFFFFFF

2.5.7.4 Linking in a block of binary data

It is possible to link in a block of binary data into the linked file. The example below describes how to include a . .
/readme. txt file.

Example:

File: readme.txt
Revision: Version 2
Product news: This release ...
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One way to include this in the project is to make a reference in a C file to include it using the incbin directive
and the allocatable (“a”) option on the section:

asm(".section .binary data,\"a\";"
".incbin \"../readme.txt\";"

)i

The new section binary data is then added into the linker script with instructions that the section must be put
in the flash memory. The KEEP () keyword can be used to surround an input section so that the linker garbage
collector does not eliminate the section even if not called:

.binary data

{
_binary data start = .;
KEEP (* (.binary data));
_binary data end = .;

} > FLASH

This block can then be accessed from the C code:

extern int binary data start;
int main (void)
{
/* USER CODE BEGIN 1 */
int *bin area = & binary data start;

The binary data, in this case the readme file, can be observed in the Memory view when the project is debugged.

Figure 91. Linker memory displaying file readme

@ o X
ﬁ Memory o 101 1910 "_‘() ﬁ|4>E‘ @ﬂ%‘ Ea v — =78
Monitors + & & |0x800261c : 0x800261C <Hex> i | 4F New Renderings... 0x800261c <Floating... |0x800261c : 0x80026... 47 New Renderings...
@ 0x800261c Address @ - 3 4 -7 8 - B C-F A || ©x8800261C 656C6946 6572203A File : re ~
08002610 90220008 B9010008 95010008 0x08002624  656D6461 7478742E adme  .txt
08002620 3A207265 61646D65 2E747874  200DOA52 0x0800262C  520A0D20 73697665 ..R evis
08002630 65766973 696F6E3A 20566572  73696F6E ©0x08002634  3AGE6F69 72655620 ion: ver
08002640 2032200D OAS50726F 64756374  206E6577 ©x0800263C  6E6F6973 6D203220 sion 2
08002650 733A2054 68697320  72656C65 61736520 ©x08002644  6F72500A 74637564 -Pro duct
08002660 2E2E2E@D OAG30000 00OCEBEO  0OO024F4 ©x0800264C  77656E20 54203A73 new  s: T
08002670 00100000 00010000 00180000 20000000 6x@88002654 20736968 656C6572 his rele
08002680 00040300 206C0300  20D40300 20000000 ©x6866265C 20657361 @D2E2E2E ase
08002690 00000000 00000000 00000000 00000800 v || @xe8002664 GoG0E3CA 00000C00 e s v

Locate uninitialized data in memory (NOLOAD)

There is sometimes a need to have variables located into the flash memory, or some other non-volatile memory,
which must not be initialized at startup. In such cases, it is possible to create a specific MEMORY AREA in the
linker script (FLASH_D) and use the NOLOAD directive in the section using the area.

Example:

The MEMORY AREA can be defined like this

/* Memories definition */

MEMORY

{
RAM (xrw) : ORIGIN = 0x20000000, LENGTH = 96K
FLASH (rx) : ORIGIN = 0x8000000, LENGTH = 512K-4K
FLASH D (rx) : ORIGIN = 0x807F000, LENGTH = 2K
FLASH V (rx) : ORIGIN = 0x807F800, LENGTH = 2K

}
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Add a section for FLASH_D using the NOLOAD directive. This can be done using the following code a bit further
down in the linker script:

Place the following a bit further down in the script

.flash d (NOLOAD)
{

*(.flash d¥);
} > FLASH D

Finally, data can be used somewhere in the program by adding a section attribute when declaring the variables
that must be located in the FLASH D memory.

__attribute ((section(".flash d"))) uint32 t Distance;
__attribute ((section(".flash d"))) uint32 t Seconds;
25.8 Include libraries

To include a library into a project:

1. Right-click the project where the library must be included in the Project Explorer view and select
[Properties]

In the dialog, select [C/C++ Build]>[Settings]

Select the Tool Settings tab in the panel

Select [C Linker]>[Libraries]

Add the library name to the [Libraries] field.

Make sure the libray name is added and not the path. According to the GCC convention, the library name is

”

its filename without the “1ib™ prefix and “. a” extension.

a0 nN

Example: for a library file named 1ibmyLib. a, add the library name myLib.
If by any chance the library name do not comply with the GCC convention, the full library name can be

entered, preceded by a colon “:

Example: for a library file named STemWin524b CM4 GCC.a, add the library
name :STemWin524b_CM4_GCC.a.

6. Inthe [Library Paths] list, set the library location path. Do not include the name of the library in the path.

Example: $ {workspace loc:/myLib/Debug} is the path to the archive file of the library project myLib
residing in the same workspace as the application project.

7. Enable [Place libraries in a linker group (-WI,--start-group $(LIBS) -WI,--end-group)] if libraries need to
be linked several times to resolve circular dependencies.
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Figure 92. Include a library
m workspace_um7 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search Project Run Window Help
HrlR B~ ~RiiGi@ v Sy vEvigvO~QRrdIviJRETIH vy~ O
& Project Explorer = E N
v Emylib [ Properties for NUCLEO-FA0TRE O X
> B8 Archives
¥ @lnc > Resource
» B myLibh Builders
~ @8 Sc v C/Ct+ Build Configuration: Debug [Active ] VHManage Configurations...
» B mylib.c Build Variables
: s z;z::!incc f;;i;;:'g;"em ® Tool Settings # Build Steps " Build Artifact & Binary Parsers @ Error Parsers
> ¢ Debug Settings € MCU Toolchain Libraries (-1) aa8id
« EINUCLEOTAOTRE | , /ey congral | | MU Setings
> 4 Binaries CMSIS-SVD Settit 2 MCU Post build outputs
> & Includes Project Reference: v B MCU GCC Assembler
v (2 Core Run/Debug Settir 2 General
> & lInc & Debugging
> = myThreadSa 2 Preprocessor
v & Src ¢ Include paths
> [@ main.c & Miscellaneous
> g stm32fax v ® MCU GCC Compiler
> 2 stm32fdx & General
> 18 syscalls.c & Debugging
> [E sysmem. (= Preprocessor
> 2 system_s & Include paths
> = Startup 2 Optimization
» 2 Drivers

(8 Warnings Library search path (-L) & 85l L

~ = Debug &5 Miscellaneous "${workspace_loc;/myLib/Debug}”
> = Core ~ & MCU GCC Linker
» = Drivers 2 General
> 3 NUCLEO-F4! % Libraries
L& makefile 2 Miscellaneous
2 NUCLEO-F4!

NUCLEO-F4
[ NUCLEQ-F4!
E objectslist
[® objects.mk
[® sources.mk

v

= Release
2 NUCLEO-F401R
X NUCLEO-F401R
2 NUCLEO-F401R

[& STM32F401RET [ Place libraries in a linker group (-Wl,--start-group $(LIBS) -WIl,--end-group)
[ STM32F401RET Use C math library (-WI,--start-group -lc -Im -WI,--end-group)
© STM32F401Empty
@ STM32F401RE em < [ > RestoreDefaults || Apply
@ | Apply and Close | | Cancel ‘

The source folders for the header files must also be added to the [Include paths] field:
1. Select [MCU GCC Compiler]>[Include paths]
2. press the [Add...] button and add the paths to the source folders for the header files in the library
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Figure 93. Add library header files to the include paths
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v m myLib Discovery Options
> @%Archives Environment
> [ Includes Logging i Tool Settings & Build Steps ' Build Artifact Binary Parsers & Error Parsers bl 4
v (Zinc Settings
> [ myLib.h > C/C++ General (E2MCU Settings Include paths (-1) 8 8§ Y
v CMSIS-SVD Settings 2 MCU Post build output
@Bsre ) 9 = ost bulld outputs /Drivers/CMSIS/Include
> [ myLib.c Project Natures v B3 MCU GCC Assembler = - . "
Project References  General ${workspace_loc:/myLib/Inc}
> [ syscalls.c ' ! %7 eneral ./Drivers/STM32F4xx_HAL_Driver/Inc
> m sysmem.c Refactoring History &'3 Debugging ./Core/Inc
v (= Debug Run/Debug Settings (% Preprocessor ./Drivers/CMSIS/Device/ST/STM32F4xx/Include
> E=Src EInclude paths ../Drivers/STM32F4xx_HAL_Driver/Inc/Legacy
> /[ libmyLib.a (2 Miscellaneous
(& makefile v & MCU GCC Compiler
i
= objects.list %_: General )
[ & objects.mk %Z Debugging
E@ sourcesmk % Preprocessor
v FTINUCLEO-F401RE £ leludle i
o
> ﬁj Binaries Eym Edit directory path X
> [n} Includes 5
v Ec i ;
E}?Ezrle Y Directory:
nc H [w X p B
N % ‘ ${workspace_loc:;/myLib/Inc} ‘
> [= Startup %
> (2 Drivers -
> (= Debug
>
(& Debug? Cancel Workspace... File system...
> (72 Dalasca
<
JiE NUCLEO-F401RE H

Note: Libraries added by include paths are considered as static libraries because they are provided by external

parties. The header files are not rescanned as the content must not have changed for external header files. If
external libraries must be treated as normal source folders, the folders must also be added as source folders to
the project.

Refer to Section 2.5.9 Referring to projects for more information if a project is referring to another project, a
library or a normal project.

259 Referring to projects

Whenever a project is using code from another project, both projects must be referring to each other.
For a project to refer to a specific build of another project:

1.  Select instead [Project]>[Properties]

2. Select [C/C++ General]>[Paths and Symbols]

3.  Open the References tab
4

select the [Configuration] that the current project is referring to
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Figure 94. Set project references

[ Properties for NUCLEO-FAO1RE O X

type filter text Paths and Symbols LYYy

> Resource

> C/C++ Build ~

v C/C++ General
> Code Analysis

Configuration: ‘Debug [ Active ] v ‘ ‘Manage Configurations...

Documentation

File Types (2 Includes # Symbols i Libraries (B Library Paths (2 Source Location | References
Formatter
Indexer [JF401 Expand All
Language Mappings > [] NUCLEO-F401RE
Paths and Symbols > [J STM32F4xx-Nucleo Collapse All
Preprocessor Include Patl v [ myLib
CMSIS-SVD Settings [ [Active] Move Up
Project Natures Debug Move Down
Project References [[] Release
Refactoring History
Run/Debug Settings
= ~ ‘ Restore Defaults ‘ ‘ Apply ‘ v
@ | Apply and Close | | Cancel ‘
Note: When multiple projects are used as references, use the [Move Up] and [Move Down] buttons to setup the
priorities.

There are many advantages to set project references correctly:
. The projects involved are not rebuilt more than necessary.

. The indexer is able to find functions from the library and open them. To use this possibility, press the Ctrl key
and, in the editor, click the library function where it is used to open the library source file in the editor.

. It is possible to create the call hierarchy for the functions in the library. To find the call hierarchy, mark the
function name and press Ctrl+Alt+H to display the call hierarchy in the Call Hierarchyview.

If a library project is added as a reference, all the correct settings in the Paths and Symbols property page for the
library is set. The tool settings that depend on this property page are adjusted also.

This is the recommended method of adding libraries developed locally. For more information about adding
libraries, refer to Section 2.5.8 Include libraries.

Another way to have projects referring to each other is as follows:
1. Select [Project]>[Properties]
2.  Select [Project References]

3.  Select and mark the project for reference
With this method, however, it is not possible to refer to different build configurations and libraries are not set up
automatically.

2.6 1/0 redirection

The C run time library contains many functions, including some to handle 1/Os. The I/O-related run time functions
include printf (), fopen (), fclose (), and many others. It is common practice to redirect the I/O from these
functions to the actual embedded platform. For instance, the printf () output can be redirected to an LCD
display or serial cable while file operations like fopen () and fclose () can be redirected to a flash memory file
system middleware.
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2.6.1 printf() redirection

There are several ways to perform printf () redirection, such as using UART or SWV/ITM. Another solution is
the Real-Time Transfer technology (RTT) provided by SEGGER.

The three techniques compare as follows:

. The UART output is maybe the most commonly used method, where the output from the embedded system
is sent for instance to a terminal using RS-232. It requires some CPU overhead and medium bandwidth.

. The Instrumentation Trace Macrocell (ITM) output is efficient but requires that the Arm® CoreSight™
debugger technology with Serial Wire Viewer (SWV) is supported by the device. This is normally the case for
Cortex®-M3, Cortex®-M4, Cortex®-M7, and Cortex®-M33 based devices. However, the SWV signals must be
available and connected to the board also. It requires low CPU overhead but limited bandwidth. ITM output
is explained in Section 4 Debug with Serial Wire Viewer tracing (SWV).

. The RTT solution is described by SEGGER on their website. RTT is a fast solution but requires SEGGER J-
LINK debug probe.

To enable /O redirection with UART or ITM output, the file syscalls.c must be included and built into the
project. When printf () is used, it calls the write () function, which is implemented in syscalls.c.

The syscalls.c file is normally created and included in the project when creating a new STM32CubelDE
project. The write () function in this file must be modified to enable printf () redirection by modifying the call
to io putchar (). The way to modify write () depends on the hardware and library implementation.

The example below shows how to update syscalls.c so that printf ouput is redirected to ITM with an
STMB32F4 Series device. This is done by adding some header files to access ITM_SendChar () and make a call
to ITM SendChar ().

Original write() function

__attribute ((weak)) int write(int file, char *ptr, int len)
{
int Dataldx;

for (DatalIdx = 0; DatalIdx < len; Dataldx++)
{

1o putchar (*ptr++) ;
}

return len;

}
Modified with added header files calling ITM SendChar (*ptr++);

#include "stm32f4dxx.h"
#include "core cm4.h"

__attribute ((weak)) int write(int file, char *ptr, int len)
{
int Dataldx;

for (DatalIdx = 0; DatalIdx < len; Dataldx++)
{

//__io_putchar (*ptr++);

ITM SendChar (*ptr++) ;
}

return len;

It can be noticed that the write functionin syscalls.c contains a weak attribute. This means that the
_write function can be implemented in any C file used by the project.
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For instance, the new write () function can be added directly into main.c. Omit the weak attribute in that
case, as shown in the example below.

int write(int file, char *ptr, int len)
{
int Dataldx;

for (DatalIdx = 0; Dataldx < len; DatalIdx++)
{

//__io putchar (*ptr++) ;

ITM SendChar (*ptr++) ;
}

return len;

2.7 Thread-safe wizard for empty projects and CDT™ projects
STM32CubelDE includes a thread-safe wizard to generate files to support the use of resources that can be
updated by application code and interrupts or when using a real-time operating system.

Note: The thread-safe wizard may only be used for STM32CubelDE empty projects. For projects managed by
STM32CubeMX, the thread-safe implementation configuration must be made using STM32CubeMX dialogs.
The thread-safe wizard creates three files and adds the STM32 THREAD SAFE STRATEGY define to the project.

The files are:
. newlib lock glue.c
. stm32 lock user.h

. stm32 lock.h

First, in the example below, a myThreadSafe folder is created in the empty project. This folder is selected in the
Thread-Safe Solution wizard so that files are generated in this folder.
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Open the menu [File]>[New]>[Other...] to obtain the wizard selection window shown in Figure 95.

Figure 95. Select a wizard

m Select a wizard U X

Select a wizard FQ

Generate a set of files that provide the ST thread-safe solution.

Wizards:
type filter text

» (= General

& C/CHt

» (= Launch Targets

» = Remote System Explorer

v =ST
[ STM32 Project
[ STM32 Project from an Existing STM32CubeMX Configuration File (.ioc)
[l Thread-Safe Solution

@ < Back Next > Finish Cancel
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In the [ST] node select [Thread-Safe Solution] and press [Next >] to open the Thread-Safe Solution wizard.

Figure 96. Thread-Safe Solution wizard

m Generate Thread-Safe Solution U X

Thread-Safe Solution m

@ Folder 'STM32F401 RE_empty' is not in a source folder.

Source folder; | STM32F401RE_empty ‘ Browse... |
Strategy: o ‘
@ < Back Next > Finish Cancel

UM2609 - Rev 6 page 94/245



m UM2609

Thread-safe wizard for empty projects and CDT™ projects

Press [Browse] to open the Generate Into Source Folder dialog.

Figure 97. Thread-safe source folder location

m Generate Into Source Folder ] X

Select the folder to generate into.

By o
» [ NUCLEO-F401RE
v [ STM32F401RE_empty
= .settings
= Inc
= myThreadSafe
= Src
= Startup
@ oK Cancel

Select the source folder to generate the files into and press [OK].

The wizard proposes to select among five different thread-safe strategies:
1. User-defined thread-safe implementation.

Allow lock usage from interrupts.

Deny lock usage from interrupts.

Allow lock usage from interrupts. Implemented using FreeRTOS™ locks.

o bk N

Deny lock usage from interrupts. Implemented using FreeRTOS™ locks.
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The different strategies are explained in file stm32 lock.h.

1. User defined thread-safe implementation.
User defined solution for handling thread-safety.
NOTE: The stubs in stm32 lock user.h needs to be implemented to gain
thread-safety.

2. Allow lock usage from interrupts.
This implementation will ensure thread-safety by disabling all interrupts
during e.g. calls to malloc.
NOTE: Disabling all interrupts creates interrupt latency which
might not be desired for this application!

3. Deny lock usage from interrupts.
This implementation assumes single thread of execution.
Thread-safety dependent functions will enter an infinity loop
if used in interrupt context.

4. Allow lock usage from interrupts. Implemented using FreeRTOS locks.
This implementation will ensure thread-safety by entering RTOS ISR capable
critical sections during e.g. calls to malloc.
By default this implementation supports 2 levels of recursive locking.
Adding additional levels requires 4 bytes per lock per level of RAM.
NOTE: Interrupts with high priority are not disabled. This implies
that the lock is not thread-safe from high priority interrupts!

5. Deny lock usage from interrupts. Implemented using FreeRTOS locks.
This implementation will ensure thread-safety by suspending all tasks
during e.g. calls to malloc.

NOTE: Thread-safety dependent functions will enter an infinity loop
if used in interrupt context.

LR S A R N N N . N N S S N N . S N N N N .

Select a strategy as shown in Figure 98.

Figure 98. Thread-safe strategy selection

m Generate Thread-Safe Solution U X

Thread-Safe Solution

Generate a set of files that provide the ST thread-safe solution.

Source folder: | STM32F401 RE_emptyfmyThreadSafe ‘ Browse... |

Strategy: Generic Strategy #3 - Deny lock usage from interrupts ™
gy gy

Generic Strategy #1 - Custom implementation
Generic Strategy #2 - Allow lock usage from interrupts

Generic Strategy #3 - Deny lock usage from interrupts
FreeRTOS Strategy #4 - Allow lock usage from interrupts
FreeRTOS Strategy #5 - Deny lock usage from interrupts

@ < Back Next > Finish | ‘ Cancel
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Select a strategy and press [Finish] to generate the files into the selected source folder.

Note: The files generated are the same and contain the same information independently of the selected strategy.

A new define, STM32 THREAD SAFE STRATEGY=3, is added by the wizard to the project for use by the
preprocessor when building the project. The define value is set according to the strategy selected in the wizard.
The define can be observed by opening the project properties and looking into the Tool Settings tab.

Figure 99. Thread-safe properties

m Properties for STM32F401RE_empty [l X
type filter text Settings Hw v 3
> Resource ~
Builders . ) Deb i H ; .
E ~
~ C/C++ Build Configuration: |Debug [ Active ] Manage Configurations...

Build Variables

Environment % Tool Settings # Build Steps ** Build Artifact & Binary Parsers € Error Parsers

Logging
Settings # MCU Toolchain Define symbols (-D) a8 8§ L
> C/C++ General 2 MCU Settings DEBUG
CMSIS-SVD Settit 2 MCU Post build outputs STM32
Project Reference: v B MCU GCC Assembler STM32F401RETx

# General STM32F4
STM32_THREAD_SAFE_STRATEGY=3

Run/Debug Settir

# Debugging

(2 Preprocessor

2 Indlude paths

# Miscellaneous

~ & MCU GCC Compiler

# General

2 Debugging

% Preprocessor

# Include paths

< > # Ontimization

Undefine symbols (-U) a0 8 gl 9\|
I 1

Apply and Close | | Cancel ‘
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The generated files are shown in the Project Explorer.

Note: The generated files require that some CMSIS header files are included in the project. The files must be copied

and added manually into the project if they are missing.

Figure 100. Thread-safe files

File Edit Source Refactor Navigate Search Pro
OvEdRQ ®~vyR @ E@8~va~Eye-
% Project Explorer 2 %Y & -0
» [ NUCLEO-F401RE
v [ STM32F401RE_empty
> @ Includes
> #EInc
> #BSrc
> & Startup
v 2 myThreadSafe
> 8 newlib_lock_glue.c
> [0 stm32_lock user.h
> [0 stm32_lock.h
STM32F401RETX_FLASH.IM
STM32F401RETX_RAM.Id
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If the wizard is started while the project is managed by STM32CubeMX, an error is displayed stating that
STM32CubeMX must be used to manage the thread-safe strategy.

Figure 101. Thread-safe error dialog

m Generate Thread-Safe Solution U
Thread-Safe Solution
o Project is managed by STM32CubeMX. Use STM32CubeMX to manage the strategy.
Source folder: | NUCLEO-F401RE Browse...
Strategy: o
@ | < Back | Next > Finish Cancel
2.8 Position-independent code

This section is of interest to users working on applications where the final address location is not defined in the
system. This occurs for instance when using a bootloader: the system designer must be able to define the final
location of the application. In such case, position-independent code (PIC) can be used. The -£PIE compiler
option enables the compiler/linker to generate position-independent executable.

Compiling with option —£PIE generates position-independent executable so that if the application is linked for
address 0x800 0000 but placed at 0x800 1000, it still runs.

However, the information in this section is not complete. The solution it describes works when using global data
initialized to zero (. bss) but it does not work when using initialized data and has several other limitations. One
such limitation is that run time libraries included in the STM32 toolchain cannot be used as these libraries are
built without the —-fPTE option for optimization. Instead of using position-independent code in a system, it is worth
considering other solutions.

Alternate solution example:

If a system is designed to have a bootloader and multiple versions of an application in flash memory at different
slots, it may be easier to setup multiple build configurations for the application. Each build configuration is based
on its own linker script file. In this case, there is no need to use position-independent code since run time libraries
can be used. Each build configuration links the application to a unique slot in flash memory, generating one single
el f file per slot. When downloading a new version of the application into a slot, the correct e1 £ file must be

used. The bootloader can be designed to validate the addresses in the e1f file and generate an error if it contains
addresses that are out of the slot. The application can copy the interrupt vector table to RAM and update vector
copies depending on the slot where the application is stored.

UM2609 - Rev 6 page 99/245



m UM2609

Position-independent code

2.81 Adding the -£PIE option

To add the -£PIE option into the tool settings:

1. Right-click the project in the Project Explorer view and select [Properties]

In the dialog, select [C/C++ Build]>[Settings]
Select the Tool Settings tab in the panel

Select [MCU GCC Compiler]>[Miscellaneous]
Add -fPIE to the [Other flags] field.

o~ nN

Figure 102. Position independent code, —-£PIE

m Properties for NUCLEO-F401RE

O X
‘type filter text Settings e
> Resource
v C/C++ Build

Build Variables Configuration: ‘Debug [ Active ] V‘ ‘Manage Configurations...‘
Discovery Options

Environment

Logging B3 Tool Settings & Build Steps Build Artifact Binary Parsers €3 Error Parsers EIZ‘
Settings
> C/C++ General @MCU Settings Other flags & =3 'G| ,@|
CMSIS-SVD Settings (#2MCU Post build outputs
Project Natures v i MCU GCC Assembler -
Project References 2 General
Refactoring History (% Debugging
Run/Debug Settings @ Preprocessor

@ Include paths

(3 Miscellaneous
v B MCU GCC Compiler

(22 General

(2 Debugging

@ Preprocessor

2 Include paths

@ Optimization

@Warnings

(# Miscellaneous
v B3 MCU GCC Linker

(2 General

(2 Libraries

@ Miscellaneous

[JVerbose (-v)
[JPosition Independent Code (-fPIC)

Enable stack usage analysis (-fstack-usage)

‘ Restore Defaults ‘ | Apply |

@

| Apply and Close ‘ | Cancel ‘

2.8.2 Run time library

The C run time library is compiled without using the —-£PIE option. So any call to the library must

be avoided when generating position-independent executable. The startup code normally has a call to
__libc_init_array. This call must be removed as in the example below:

/* Call static constructors */
7 bl libc _init array */
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2.8.3 Stack pointer configuration
Make sure that the stack pointer is set up correctly. The stack pointer must be set in the Reset Handler in the
startup file as shown in the example below. It must not be assumed that the stack pointer is set by a reset reading
it from the vector table.

Reset Handler:
1dr sp, = estack /* set stack pointer */

284 Interrupt vector table
The vectors in the vector table must be updated if the program is loaded to an offset address. If a program needs
to add the offset to each vector in the table, it can copy the interrupt vector table to the RAM and add the offset to
this vector table.
The vector base register must also be changed so that it points to the new located vector table as shown in the
example below:

/* Set Vector Base Address */
SCB->VTOR=RAM VectorTable;

2.8.5 Global offset table
The global offset table (GOT) is a table of addresses normally stored in the data section when building and using
the —fPIE option. It is used by the executed program to find, during run time, addresses of global variables,
unknown at compile time. If no global variable location change is needed, the variables can be located at same
place as located when linking the program. Then the GOT table can be placed in the . text section in the flash
memory area instead.

The example below shows how to update the linker script with the . got * section. In this case the GOT START
and GOT_END symbols are added also so that the tools are able to know the GOT location and size.

/* The program code and other data into "ROM" Rom type memory */

.text

{
. = ALIGN(4);
*(.text) /* .text sections (code) */
*(.text*) /* .text* sections (code) */
GOT_START = .;
*(.got*)
GOT END = .;
*(.glue 7) /* glue arm to thumb code */
*(.glue 7t) /* glue thumb to arm code */

*(.eh_frame)

KEEP (*(.init))
KEEP (*(.fini))

. = ALIGN (4);

_@text = ¢ /* define a global symbols at end of code */
} >ROM
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2.8.6 Interrupt vector table and symbols

When debugging the code with an offset, both the load offset and the new symbol address must be
specified. The symbol address to provide is the . text section address. The linker script can be updated by
defining .isr vector to be located into . text. This avoids the issue of finding the location of . text.

Remove the following

.isr vector :

{

. = ALIGN (4);
KEEP (* (.isr_vector)) /* Startup code */
. = ALIGN (4);
} >FLASH
Add KEEP (* (.isr vector)) instead to first location of .text
/* The program code and other data into "FLASH" Rom type memory */
o EEKE 8
{
. = ALIGN (4);
KEEP (* (.isr_vector)) /* Startup code */
* (.text) /* .text sections (code) */
* (.text*) /* .text* sections (code) */
GOT_START = .;
*(.got*)
GOT_END = .;
*(.glue 7) /* glue arm to thumb code */
*(.glue 7t) /* glue thumb to arm code */

*(.eh frame)

KEEP (*(.init))
KEEP (*(.fini))

. = ALIGN(4);
_etext = .; /* define a global symbols at end of code */
} >FLASH
2.8.7 Debugging position-independent code
When debugging position-independent code located at an offset, the download offset and new symbol address
must be set.
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Figure 103. Debugging position independent code

B8 pebug Configurations [m} X
Create, manage, and run configurations ﬁv
S % (o 2 3L,
RERY R =KD Name: | NUCLEO-F401RE.elf |
type filter text [ Main %% Debugger | B+ Startup 5 Source | [Z] Common |
[E]¢/C++ Application Initialization Commands
[E1C/C++ Attach to Application
[€]C/C++ Postmortem Debugger
[E1C/C++ Remote Application
[£]GDB Hardware Debugging
& Launch Group
> Launch Group (Deprecated) Load Image and Symbols
~ [ STM32 MCU Debugging File Build Download Load symbols Add...
L= NUCLEO-F401RE elf 5 Debug/NUCLEO-FA01RE.elf [NUCLEO-FA01RE] @ 0x1000 symbols @ 0x8001000  See Maintab o true o true —
[T STM32F401_empty.elf Edit...
[ STM32 MPU - Cortex-M Debugging r—
Move up
L5 Add/Edit item [m} X
Move down
Some properties of this item can only
Runtime Options be changed in the “Main" tab.
[ Set program counter at (hex): Project: NUCLEO-F401RE v
[ Set breakpoint at:
[ Exception on divide by zero Program path: Debug/NUCLEO-F401RE.elf
[ Exception on unaligned access
[ Halt on exception
[ Resume
Download
R EmmEES | Use download offset (hex) | 0x1000 L
set $pc=Reset_Handler Load symbols
Use symbol address (hex) | 0x8001000
ok Cancel
Filter matched 11 of 11 items Bevert Gplly

® Close

Figure 103 illustrates an example where the download offset is 0x1000 and the symbol address is 0x800 1000.
It is possible to set the symbol address to 0x800 1000 in this case because the .isr vector is added into
the . text section as described in Section 2.8.6 Interrupt vector table and symbols.

Ifinstead the . isr vector is located in another section outside . text, the start address of the . text
section must be used with the offset added. For instance, if the map file states that . text starts at
0x0000 0000 0800 0194, the symbol address in this case must be setto 0x800 1194.

Figure 103 shows that the breakpoint is set at main and that the program counter (Spc) is set to

the Reset Handler symbol into [Run Commands]. This symbol contains the correct address to the

Reset Handler because gdb uses the base symbol address 0x800 1000. If $pc is not setup during this
debug configuration, the [Resume] checkbox must be disabled to make the program stop after load. In this case,
the program counter must be set manually in the Registers view before starting the program.
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2.9 Exporting projects

A project can be exported in many different ways. This section shows how to export a project as a compressed
zip file.
Right-click the project in the Project Explorer view and select [Export...].

Figure 104. Export project

v EENuceo-F - .
B i ew
b ﬁ.Blnarles ol
> [l Includes o 1nte
v 2 core Open in New Window
? [=Inc Copy Ctrl+C
? [=Src Paste Ctrl+V
v [=Startt 3¢ Delete Delete
> 8 st Source >
EE] st Move...
=l st Rename... F2
> 2 Drivers | ],
> (= Debug 2y Import...

> [=Debug2 L Export..

> [=Release Build Project
NUCLEC Clean Project

=/ NUCLEC & | Refresh F5
EZINUCLEC  Close Project
=l readme. Close Unrelated Projects
STM32F Build Configurations >
STM32 Build Targets >
STM32F
= Index >
STM32F
STM32F Show in Remote Systems view
> [T sTm32ra0 O Run As ’
> (I sTM32Mp- %% Debug As 2
> LI swasTm3:  Profile As >
Team >
Compare With >

Restore from Local History...
Generate Code

[y
3

Convert to C++
Run C/C++ Code Analysis

Configure >

e

Properties Alt+Enter
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The Export dialog opens. Select [General]>[Archive File] and press [Next >].

Figure 105. Export dialog

[T Export O X
Select ﬁ
Export resources to an archive file on the local file system. H

Select an export wizard:
‘type filter text ‘

v [ General
[ Archive File
£ File System
lj Preferences

> [ C/CH+

> [ Install

> [£ Remote Systems

> [ Run/Debug

> [~ Team

@
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2.10

2101

The Export dialog is updated. Select the project to be exported. It is possible to exclude some project files from
the export. In the example in Figure 106, all project and library files are included. A file name must be entered
into the [To archive file] field, possibly browsing to a folder location for the file with the [Browse...] button. In the
example, the default options values are kept unchanged. Press [Finish] to export the project and create the zip

file.

Figure 106. Export archive

E Export
Archive file

Export resources to an archive file on the local file system.

> CIEE F401
> ML NUCLEO-F401RE
[J= RemoteSystemsTempFiles
> [ STM32F401_empty
> =5 STM32F4xx-Nucleo
> [ STM32MP151C_MPU_CM4

| NUCLEO-F401RE.elf.cfg
|2/ NUCLEO-F401RE.elf.launch
M [INUCLEO-F401RE.ioc

> EALEmytie 54 STM32F401RETX_FLASH.Id
[24 STM32F401RETX_FLASH_IPCodelnFlash.Id
54 STM32F401RETX_FLASH_ORG.Id y
Filter Types.. | SelectAll  DeselectAll |

To archive file: ‘ ive - STMicroelectronics\dev\CubelDE\Manuals\STM32CubelDE_UG\nucleo-f401.zip v ‘ ‘

Browse...

Options
@® Save in zip format
O Save in tar format
Compress the contents of the file

D Resolve and export linked resources

@ Create directory structure for files
QO Create only selected directories

@

Next > Finish | ‘ Cancel

Importing existing projects

This section describes different ways to import existing projects into an STM32CubelDE workspace. The
standard Eclipse® importer is capable of importing Eclipse® projects. This is used to import projects created
with STM32CubelDE. The project importer is also extended to support the import of ac6 System Workbench for
STM32 projects and Atollic® projects. Such projects are converted during the import phase to STM32CubelDE

projects.

It is possible to import and debug an existing e1f£ file developed by another IDE or toolchain. More information on

how this is done is available in Section 3.8 .

Importing an STM32CubelDE project

A project can be imported in many different ways. This section shows how to import a project that was exported

as a compressed zip file.

. One way to open the Import dialog is to use the menu [File]>[Import...]
. Another way is to right-click the Project Explorer view and select [Import...]
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Figure 107. Import project

% Project Explorer &% Q:D ¥ =08

New >

2 Import...
3 Export..

&' Refresh F5

{ % Generate Code

Figure 108. Import dialog

[ Import U x

Select

Create new projects from an archive file or directory. @

Select an import wizard:

type filter text

L Archive File L
1= Existing Projects into Workspace
[} File System
0 Import ack Systern Workbench for 5STM32 Project
m Import an Existing 5TM32CubeMX Configuration File (ioc)
E Import Atellic TrueSTUDIO Project
E Import 5STM32Cube Example
[} Preferences
([} Projects from Folder or Archive
» = C/C++
5 [= Install
» [= Remote Systems
» [ Run/Debug
5 = Team y

@ < Back Next > Finish Cancel
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Figure 109. Import projects

[ import O X
Import Projects
Select a directory to search for existing Eclipse projects. /4
O select root directory: A Browse...
@ Select archive file: DE\Manuals\STM32CubelDE_UG\Projects\nucleo-f401.zip kg ‘ Browse... ‘
Projects:
myLib (myLib/) . SelectAll |
NUCLEO-F401RE (NUCLEO-F401RE/)
‘ Deselect All ‘
‘ Refresh ‘
Options
Search for nested projects
Copy projects into workspace
[ I Close newly imported projects upon completion
[_|Hide projects that already exist in the workspace
Working sets
] Add project to working sets New...
Working sets: &7 Select...
@ < Back Next > Finish | ‘ Cancel

2.10.2 Importing System Workbench and projects

To import an ac6 System Workbench for STM32 project or an Atollic® project into STM32CubelDE, it is advised
to work on a project copy:

1. Create a copy of the project, either as a copy of the project folder or an export of the project in a zip file
2.  Use the copied project for the import into STM32CubelDE

The way to import the copied project is to open the Import dialog by means of the menu [File]>[Import...] or by
right-clicking the Project Explorer view.
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Select [Import acé System Workbench for STM32 project] or [Import Atollic TrueSTUDIO project] depending
on the original tool used to create the project and press [Next >].

Figure 110. Import System Workbench projects (1 of 3)

[ Import U X

Select

Import System Workbench for STM32 projects @

Select an import wizard:

type filter text

1@- Archive File A
=% Existing Projects into Workspace
[} File System
G Import ack Systern Workbench for STM32 Project
m Import an Existing 5TM32CubeMX Configuration File (1oc)
E Import Atellic TrueSTUDIO Project
E Import STM32Cube Example
[} Preferences
() Projects from Folder or Archive
» = C/C++
5 [= Install
» [= Remote Systemns
» [= Run/Debug

5 = Team
W

@ < Back Next > Finish Cancel
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In this example, the ac6 project is copied into the STM32CubelDE workspace, hence the [Directory...] button
is used and project STM32F401_Ac6 is selected. The import wizard detects that this is a System Workbench
project.

Figure 111. Import System Workbench projects (2 of 3)

[ import Projects from File System or Archive O X
Import Projects from File System or Archive
This wizard analyzes the content of your folder or archive file to find projects and import them in the IDE. @

Import source: | C:\Users\johansse\STM32CubelDE\workspace_um1\STM32F401_Ac6 V‘ | Directory... | ‘ Archive...

‘ type filter text ‘ Select All

Folder Import as Deselect All
STM32F401_Ac6 Convert ‘System Workben...

1 of 1 selected
[JHide already open projects
[ close newly imported projects upon completion

Use installed project configurators to:
Search for nested projects
Detect and configure project natures

Working sets

[JAdd project to working sets New...

Working sets: e Select...

Show other specialized import wizards

@ < Back Next > Finish Cancel

Press [Finish] to open the Project converter dialog.

Figure 112. Import System Workbench projects (3 of 3)

[ project converter X

.@ This project requires a conversion in order to be used with STM32CubelDE.
Project-files are automatically backed-up (.project_org/.cproject_org) in project root folder before
conversion.

Convert project STM32F401 to an STM32CubelDE project?

| OK | ‘ Cancel

Press [OK] to convert the project to an STM32CubelDE project.
There are two migration guides explaining how to migrate from ac6 System Workbench for STM32 ([ST-06]) and

Atollic® to STM32CubelDE ([ST-05]). These guides can be opened from the Technical Documentation page in
the Information Center.
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210.3 Importing using project files association
When STM32CubelDE is started, a pop-up window asks if . cproject and .project files must be associated
to the program.

Figure 113. Import using project files association

[ override... X

@ The .project file extension is currently associated to another STM32CubelDE installation
‘ (C\ST\STM32CubelDE_1.1.0.19w38_targetplatform_2019-09\STM32CubelDE\stm32cubeide.exe).
Would you like to associate the .project files to the STM32CubelDE instance in use?

[JrRemember my decision

Yes | ‘ No

If the association is selected, double-clicking on a .project file in the personal computer file browser
triggers the project import by STM32CubelDE into the current workspace. The project converter investigates
the project, which is imported directly if made for STM32CubelDE. If the project comes from another tool, the
project converter tries to identify if it is a known project format and, in such case, converts the project to an
STM32CubelDE project as described in Section 2.10.2 Importing System Workbench and projects.

2104 Prevent “GCC not found in path” error

When importing old projects, an error in the Problems view can state “Program “gcc” not found in PATH”. The
error is caused by the project use of a deprecated discovery method setting. The error can be removed by
updating the Window Preferences and Project Properties settings.

1. Open [Window]>[Preferences]. In the Preferences dialog, select [C/C++]>[Property Pages Settings] and
enable checkbox [Display “Discovery Options” page].

2. Open [Project Properties]>[C/C++ Build]>[Discovery Options] and disable checkbox [Automate
discovery of paths and symbols].

21 Toolchain Manager

The Toolchain Manager is used to install toolchains, uninstall toolchains and select the default workspace
toolchain when building a project.
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To open the Toolchain Manager from the Tool Settings tab in project properties:
1. Select the [MCU Toolchain] node

Figure 114. Open Toolchain Manager

m Properties for NUCLEO-F401RE O X
. type filter text Settings LA
> Resource ' ' | A'
Builders - -
v C/C++ Build Configuration: Debug [ Active ] ~ Manage Configurations...

Build Variables

Environment . Sy

Logai % Tool Settings . Build Steps Build Artifact s Binary Parsers @ Error Parsers
0gging

Settings # MCU Toolchain Select what toolchain to use

> EI/\;:;I; g\‘:gegal . #MCU Settings @) Use workspace setting (GNU Tools for STM32 (9-2020-g2-update
- tt .
etings &MCU Post build outputs | O Fixed [GNU Tools for STM32 (9-2020-q2-update)

Project References + ®MCU GCC Assembler
Run/Debug Settings & General Toolchain Manager
= Debugging

Configure the workspace toolchain, and manage installed toolchain:
% Preprocessor

&lInclude paths
=Miscellaneous
v ®MCU GCC Compiler

v
N |

@ Apply and Close Cancel

2. Click on [Open Toolchain Manager...]

Open Toolchain Manager...

The Toolchain Manager can also be opened from the [Window]>[Preferences] menu:
1. Select [STM32Cube]>[Toolchain Manager]

Figure 115. Toolchain Manager

m Preferences

] X
Coom
type filter text Toolchain Manager AR
> Help . The Toolchain Manager allows users to configure the workspace toolchain, and man‘age installed toolchains.
> Install/Update
> Remote Development Default Name State Add Local...
> Remote Systems GNU ARM Embedded (7-2018-g2-update) Not installed Edit Local..
> Run/Debug GNU ARM Embedded (9-2020-g2-update) Not installed
v STM32Cube GNU Tools for STM32 (7-2018-g2-update) Not installed Uninstall...
Build & GNU Tools for STM32 (9-2020-g2-update) Installed with STM32CubelDE 1.6....
Device Configuration Tool FEEEE
End User Agreements Set Default
File Association
Firmware Updater
MPU Serial

Serial Wire Viewer
Target Status

B By default let STM32CubelDE select the toolchain to use.
Toolchain Manager

3 Team Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.
Terminal v Restore Defaults
@ ueh Apply and Close Cancel
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The columns in the Toolchain Manager are described in Table 4.

Table 4. Toolchain Manager column details

s T e ]

A green/grey arrow symbol indicates the default workspace toolchain.

The arrow color is:

Default

. green when the toolchain is manually set as default by the user

. grey when the toolchain is selected as default by STM32CubelDE logic
Name The name of the toolchain.

The state of the toolchain. Toolchains available for download from STMicroelectronics online
State repository are listed as ‘“installed” or “not installed”. Local toolchains added by the user are listed

as ‘“local”.
The buttons in the Toolchain Manager are described in Table 5.

Table 5. Toolchain Manager button information

R

Add Local... Add reference to local toolchain.

Edit Local... Edit reference to local toolchain.

Install.... The button text depends on the type of the selected toolchain. It is used to:
Uninstall... . Install / Uninstall the selected toolchain provided by the repository
Remove... . Remove the selected local toolchain

Reload Reload the toolchain list from the repository.

Set Default Set selected toolchain to be used by default.

Restore Defaults Restore and use the default toolchain.

Apply and Close Apply selection and close dialog.

Cancel Cancel dialog.
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2111 Install new toolchain
Open the Toolchain Manager to install a new toolchain.

Figure 116. Install toolchain

m Preferences O X
| type filter text | Toolchain Manager erovi
? Help ” The Toolchain Manager allows users to configure the workspace toolchain, and manage installed toolchains.
> Install/Update
> Remote Development Default Name State Add Local...
> Remote Systems GNU ARM Embedded (7-2018-q2-update) Not installed Edit Local
> Run/Debug GNU ARM Embedded (9-2020-g2-update) Not installed
v STM32Cube GNU Tools for STM32 (7-2018-g2-update) Not installed Install...
Build B GNU Tools for STM32 (9-2020-q2-update) Installed with ST...
Device Configuration Tool Reload
End User Agreements Set Default
File Association
Firmware Updater
MPU Serial
Serial Wire Viewer
Target Status i
. By default let STM32CubelDE select the toolchain to use.
Toolchain Manager
5 Team Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.
Terminal - Restore Defaults
@ e Apply and Close Cancel
Select the toolchain to install and click on [Install...]. The Install dialog opens and displays the items to be
installed.
Figure 117. Check items to install
m Install O X
Install I |
%
Check the items that you wish to install. |
Name

Version Id

M4-STM32CubelDE MCU External Tools GNU Tools for STM32 - Binaries (7-2018-q2-update) ~ 1.5.0.202011040924 com.st.stm32cube.ide feature. mcu.externaltools....

Select All Deselect All

Details

STMicroelectronics STM32CubelDE MCU External Tools GNU Tools for STM32 - Binaries (7-2018-g2-update) &

@ < Back Finish Cancel

Check the items to install and click on [Next].
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Figure 118. Review items to install

m Install

Install Details

Review the items to be installed.

Name Version
v 4-STM32CubelDE MCU External Tools GNU Too 1.5.0.202011040924
§STM32CubelDE MCU External Tools GNU “1.5.0.202011040924

Details

Review the items and click on [Next].

STMicroelectronics STM32CubelDE MCU External Tools GNU Tools for STM32 - Binaries (7-2018-q2-update) 5

Id
com.st.stm32cube.ide feature.mcu.externaltools.gnu_tools_for_stm32.7_2018_qg2_upda...
com.st.stm32cube.ide.feature.mcu.externaltools.gnu_tools_for_stm32.7_2018_g2_upda...

< Back Finish Cancel

Figure 119. Review and accept licenses

m Inagall

Review Licenses

Liserosis:
» STMicroelectronics Software License Agreemsent

v,

Licenses mist be reviewed and sccepted befoee the software can be installed.

o

Liggrse text;
STMicreslectronics Softwane License Agreement -

SLAMKE Revd/March 2018

BY INSTALLING COPYING, DOWNLOADING, ACCESSING OR OTHERWISE LISING THIS SOFTWARE
PACKAGE OR ANY PART THEREQF (AMD THE RELATED DOCUMENTATION, FROM
STMICRCELECTRONICS INTERMATIONAL MY SWISS BRANCH AND/OR ITS AFFILLATED
COMPANIES (STMICROELECTROMICS), THE RECIPIENT, O BEHALF OF HIMSELF Oft HERSELF, OR
O BEHALF OF ANY ENTITY BY WHICH SUCH RECIMENT IS EMPLOYED AMDVOR ENGAGED AGREES
0 BE BOUMD BY THIS SO0F TWARE PACKAGE LICENSE AGREEMENT,

Urder STMErcidectronics’ intellectual praperty ights and subject to applicable licensing berms. for

anvy third-party softwasre inconporated in this software packsge and applicable Open Source Teems

[ chefirnsd boeres beebo], thee reditribution, reproduction and use in sowce and binesy fonma of the
softveare package or ary pan thereof, with or without modification, are pemitted provided that the
@ | accept the terms of the license agreemant

1211 do ot sccept the terms. of the license agresment

ST

Review the licenses, select [| accept the terms of the license agreements] and click on [Finish].

At this point, the software installation starts. Th
window shows the installation completion rate.

e progress bar displayed at the bottom of the STM32CubelDE
Wait until the installation is completed.
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The following warning may appear before the installation is finished.

Figure 120. Security warning

B Security Warning O X

3. Warning: Installing unsigned software for which the authenticity or validity cannot be
: established. Continue with the installation?

Install anyway Details >

In this case, to finalize the installation, click on [Install anyway]. After some time, the following dialog is
displayed.

Figure 121. Restart to apply software update

E Software Updates *

.@ Restart STM32CubelDE to apply the software update?

w

Click on [Restart Now] to be able to use the installed toolchain in STM32CubelDE. STM32CubelDE is restarted
and the new toolchain can be used.

Open the Toolchain Manager to verify the installation.

Figure 122. Toolchain installed

[ preferences O X
r a rm
| type filter text | Toolchain Manager o=l
: g;cnfrfl The Toolchain Manager allows users to configure the workspace toolchain, and manage installed toolchains.
> Help Default  MName State Add Local...
> Install/Update GNU ARM Embedded (7-2018-q2-update) Not installed Edit Local
> Remote Development GNU ARM Embedded (9-2020-q2-update) ~Not installed
> Remote Systems GNU Tools for STM32 (7-2018-q2-update)  Installed Uninstall...
> Run/Debug B GNU Tools for STM32 (9-2020-g2-update)  Installed with STM32CubelDE 1.6....
v STM32Cube EE
Build Set Default

Device Configuration Tool
End User Agreements
File Association

Firmware Updater

MPU Serial

Serial Wire Viewer

Target Status

By default let STM32CubelDE select the toolchain to use.
Toolchain Manager

Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.

> Team !
Terminal Restore Defaults
Q%) Apply and Close Cancel

In this case, Figure 122 shows that two versions of GNU Tools for STM32 are installed.
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2.11.2 Manage default toolchain
The Toolchain Manager highlights the default workspace toolchain with an arrow in the Default column.

Figure 123. Default toolchain

m Preferences | pad
r a m
| type filter text | Toolchain Manager cToTd
z S;Cnf:al The Toolchain Manager allows users to configure the workspace toolchain, and manage installed toolchains.
> Help Default Name State Add Local...
> Install/Update GNU ARM Embedded (7-2018-q2-update) Not installed Edit Local
> Remote Development GNU ARM Embedded (9-2020-g2-update) ~ Not installed
> Remote Systems GNU Tools for STM32 (7-2018-q2-update)  Installed Uninstall...
> Run/Debug B GNU Tools for STM32 (9-2020-g2-update)  Installed with STM32CubelDE 1.6
v STM32Cube Relaad
Build Set Default

Device Configuration Tool
End User Agreements
File Association

Firmware Updater

MPU Serial

Serial Wire Viewer

Target Status

By default let STM32CubelDE select the toolchain to use.
Toolchain Manager

Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.

> Team !
Terminal Restore Defaults
Q%) Apply and Close Cancel

Figure 123 shows that GNU Tools for STM32 version 9-2020-q2-update is the default workspace toolchain.
The GNU Tools for STM32 version 7-2018-q2-update line is marked in blue, which indicates that this toolchain
selected. Any line in the table can be selected with the mouse.

Click on [Set default]: the selected toolchain to be used as the default workspace toolchain is highlighted with an
arrow symbol in the Default colum of the Toolchain Manager.

Figure 124. Default toolchain updated

[T preferences O X
r a m
| type filter text | Toolchain Manager DY@
; S;Cnf:al The Toolchain Manager allows users to configure the workspace toolchain, and manage installed toolchains.
> Help Default  Name State Add Local...
> Install/Update GNU ARM Embedded (7-2018-q2-update) Not installed Edit Local
> Remote Development GNU ARM Embedded (9-2020-g2-update)  Not installed
> Remote Systems Ld GNU Tools for STM32 (7-2018-q2-update)  Installed Uninstall...
> Run/Debug GNU Tools for STM32 (9-2020-g2-update)  Installed with STM32CubelDE 1.6
v STM32Cube iz
Build Set Default

Device Configuration Tool
End User Agreements
File Association
Firmware Updater
MPU Serial
Serial Wire Viewer
Target Status
Toolchain Manager
> Team |
Terminal Restore Defaults

By default let STM32CubelDE select the toolchain to use.
Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.

Q%) Apply and Close Cancel

Click on [Apply and Close] to apply the setting and update which toolchain is set to be the default workspace
toolchain.
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211.3 Uninstall toolchain

It is not possible to uninstall the GNU Tools for STM32 toolchain, which is installed by default with
STM32CubelDE. Any other installed toolchain can be uninstalled.

Figure 125. Uninstall toolchain

E Preferences U X
| type filter text | Toolchain Manager R
> Help A

The Toolchain Manager allows users to configure the workspace toolchain, and

> Install/Update manage installed toolchains.

> Remote Development

> Remote Systems Def.. Name State Add Local...
> Run/Debug GNU ARM Embedded (7-2018-q2-... Not installed Edit Local..
v STM32Cube GNU ARM Embedded (9-2020-q2-... Not installed
Build GNU Toals for STM32 (7-2018-g2-u... Installed Uninstall...
Device Configuration Tool ®  GNU Tools for STM32 (9-2020-g2-u... Installed with ST...
End User Agreements Reload
File Association Set Default
Firmware Updater
MPU Serial
Serial Wire Viewer By default let STM32CubelDE select the toolchain to use.

Target Status
Toolchain Manager
» Team

Terminal v Restore Defaults

@ e Apply and Close Cancel

Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.

To uninstall a toolchain, select it in the Toolchain Manager and click on [Uninstall...].
This opens the Uninstall dialog.

Figure 126. Uninstall details

m Uninstall O X

Uninstall Details @{
-}
=

Review and confirm the items to be uninstalled.

Name Version Id
> §-STM32CubelDE MCU External Tools GNU Tools for STM32 - Binaries (7-2018-g2-update) 1.5.0.202011040924 com.st.stm32cube.ide feature....

Details

@ < Back Next > Cancel
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Click on [Finish] to start the software uninstallation. The Software Updates dialog is displayed.

Figure 127. Software updates

E Software Updates *

.@ Restart STM32CubelDE to apply the software update?

o

Click on [Restart Now] to apply the software update.
The product is restarted.
Open the Toolchain Manager to verify the installation.

Figure 128. Toolchain uninstalled

m Preferences OJ X
type filter text | Toolchain Manager erovd
> C/C++ ~ . . . .
> Help The Toqlchaln Manager allows users to configure the workspace toolchain, and manage installed
toolchains.
> Install/Update
> Remote Development Default  Name State Add Local...
> Remote Systems GNU ARM Embedded (7-2018-g2-update) Not installed Edit Local..
> Run/Debug GNU ARM Embedded (9-2020-g2-update) Not installed
v STM32Cube GNU Tools for STM32 (7-2018-q2-update)  Not installed Uninstall...
Build [ 4 GNU Tools for STM32 (9-2020-q2-update)  Installed with ST...
Device Configuration Tool Reload
End User Agreements SetDaratit
File Association
Firmware Updater
MPU Serial
Serial Wire Viewer
Target Status .
Toolchain Manager By default let STM32CubelDE select the toolchain to use.
> Team Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.
Terminal > Restore Defaults
@i

In this case, Figure 128 shows that only one version of GNU Tools for STM32 is installed.
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2114 Using local toolchain

It is possible to add and use an already installed local GNU ARM toolchain. To add a local toolchain, follow the
steps below:

1. Open Toolchain Manager and press the [Add Local...] button.

Figure 129. Add local toolchain

1DE} O X

Add local toolchain

9 Give the toolchain a name

Name: |

Prefix.  arm-none-eabi- |

Location: | | Browse...
@ Finish Cancel
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2. Add a name and specify location.

Figure 130. Specify local toolchain location
10} O X

Add local toolchain

O The following toolchain applications are missing: arm-none-eabi-addr2line.exe, arm-
none-eabi-gcc.exe, arm-none-eabi-nm.exe, arm-none-eabi-objcopy.exe, arm-none-

Name:  TrueSTUDIO

Prefix: arm-none-eabi- |
Location: C:\Program Files (x86)\Atollic\TrueSTUDIO for STM32 9.3.0\ARMTools\bin |
@ Finish Cancel

As seen in Figure 130, some naming problems can occur. In this case, the problem results from a wrong
prefix that prevents the toolchain application validation.

Update the toolchain prefix. The prefix must end with a dash (-).

Figure 131. Specify local toolchain prefix
1DE} 0 X

Add local toolchain

Name:  TrueSTUDIO

Prefix:  arm-atollic-eabi-

Location: C:\Program Files (x86)\Atollic\TrueSTUDIO for STM32 9.3.0\ARMTools\bin | Browse...

@ Cancel
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3.  Press [Finish].

Figure 132. Local toolchain added

m Preferences O X
|WP9 filter text | Toolchain Manager ey
> Install/Update ~

The Toolchain Manager allows users to configure the workspace toolchain, and

» Remote Development manage installed toolchains.

> Remote Systems

Firmware Updater
MPU Serial

Serial Wire Viewer

Set Default

> Run/Debug De.. Name State Add Local...
v STM32Cube GNU ARM Embedded (7-2018-g2... Not installed
Build GNU ARM Embedded (9-2020-g2... Not installed
Device Configuration Tool GNU Tools for STM32 (7-2018-q2-... Installed
End User Agreements B GNU Tools for STM32 (9-2020-qg2-... Installed with ST...
File Assodiation TrueSTUDIO Local

Target Status

Toolchain Manager By default let STM32CubelDE select the toolchain to use.
> Team Note: installing and uninstalling toolchains requires a restart of STM32CubelDE.
Terminal
ermina > Restore Defaults
@ | Apply and Close | ‘ Cancel

4. Use the [Edit Local...] button to edit local toolchain. The Edit local toolchain dialog opens, and it is possible
to update Prefix and Location.

Figure 133. Edit local toolchain

10E} O X

Edit local toolchain

Name:  TrueSTUDIO
Prefix: _|arm-ato||ic-eabi-

Location: C:\Program Files (x86)\Atollic\TrueSTUDIO for STM32 9.3.0\ARMTools\bin Browse...

@ Cancel

5.  Update Prefix or Location and press [Finish] to update local toolchain settings.
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211.5 Network error
In case of problem to access the update site, the Network error... dialog is displayed.

Figure 134. Toolchain network error

[CE Network error... s

,@ Failed to fetch the toochain list, please check your network settings.

Check the network settings. Information on how to configure network proxy settings are described in
Section 1.5.3 Preferences - Network proxy settings.

UM2609 - Rev 6 page 123/245



m UM2609

Debugging

3 Debugging

3.1 Introduction to debugging
STM32CubelDE includes a powerful graphical debugger based on the GDB command-line debugger. It also
bundles GDB servers for the ST-LINK and SEGGER J-Link JTAG probes.
The GDB server is a program that connects GDB on the PC to a target system. The STM32CubelDE debug
session can autostart a local GDB server or connect to a remote GDB server.

The remote GDB server can be running on the same PC, or on a PC that is accessible via the network and
specified with Host name or IP address and a Port number. When connecting to a remote GDB server, this GDB
server must be started first before a debug session is started in STM32CubelDE.

When autostart local debugging is selected, STM32CubelDE automatically starts and stops the GDB server as
required during debugging, thus integrating the GDB server seamlessly.

Note: It is recommended to use compiler optimization level —00 when building a project that must be debugged.
Debugging with optimization level —0g may work but higher optimization level is hard to debug because of
compiler code optimization.

It is also possible to use the GDB server only to download the application into the target system and run it without
starting a debug session. This is performed by creating run configurations, which is described later in this chapter
(refer to Section 3.7 Run configurations).

STM32CubelDE can be used to debug an existing e1f£ file developed with another IDE or toolchain by importing
the e1£ file using the import of STM32 Cortex®-M executable. This is described in Section 3.8 Import STM32
Cortex-M executable.
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General debug and run launch flow

Debug configurations are used to debug an STM32 program. Run configurations are used to flash a new

program into the STM32 and start it. The flowchart in Figure 135 presents the order of starting the GDB server,
reset the device, load the program, set run time options, exceptions, program counter, breakpoints, Standby/Stop/
Sleep, watchdog, and external loader initialization when starting a debug session. It also displays the differences
between debug and run sessions.

Figure 135. General debug and run launch flowchart

Debug using debug configuration Run using run configuration

<&
<

A

Start GDB server or connect to running GDB server

No

Reset board?

A 4

Reset board | | Attach to board

A

No

Any files in loadlist?

Download program?

Load / Program memory

No

Set run-time options for debug
Exception on divide by zero
Exception on unaligned access

Halt on exception Set run-time options for run

Set PC to entry or specific address =
Set breakpoints Set PC to entry or specific address

Set Standby/Stop/Sleep
Set watchdog
(External loader initialize)

Debug Run
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A debug configuration for the project is needed before a debug session can be started. To create the first debug
configuration for the project, right click on the project name in the Project Explorer view and select [Debug
As]>[STM32 Cortex-M C/C++ Application].

Figure 136. Debug as STM32 MCU

E workspace_umd - MUCLEQ-F401RE/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Mavigate Search  Project Run Window Help

el ®~- | @ @[~ @i~ O-Qvinidi® g~ 46

[ Project Explorer 53 E ¥ = 8 [§manc 2
> [T myLib
3 m NUC! EN-FANRE
MNew ¥
/* MCU Configurati
Go Into

. i /* Reset of all pe
Open in New Window

Show In Alt+Shift+W > £f HAL_Init();
Copy CtrleC /* USER CODE BEGIN
Paste Crl+V /* USER CODE END I
3 Delete Delete
S " /* Configure the s
ource SystemClock Config
Move...
*
Rename... 2 /* USER CODE BEGIN
*
fa Import.. /* USER CODE END S
&5 Export... /* Initialize all
_ _ MX_GPTO_TInit();
Build Project MX_USART2_UART_Ini

Clean Project /* USER CODE BEGIN

2 Refresh F5 mem=malloc(12);

Close Project mem2=malloc(12);
. #ifdef OLD
Close Unrelated Projects mem3=malloc(12);
Build Configurations » mmS::iigE E::ﬁ:
Build Targets » mem6=malloc(12);
Index > mem7=malloc(12);
#endif

/* USER CODE END 2

Show in Remote Systemns view

) PRunis ? :
45 Debug As > [ 1STM32 Cortex-M C/C++ Application
Profile As ’ Debug Configurations...
Teamn H
/* USER CODE END
Cornpare With 3 c = mem[i¥12];

mem[i%¥12] = 1i;

Rectrrs from | neal Hicknre

Another way to create a new debug configuration is to select the project name in the Project Explorer view and
use the menu [Run]>[Debug As]>[STM32 Cortex-M C/C++ Application].
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Figure 137. Debug as STM32 MCU menu

E workspace_umd - NUCLEQ-F401RE/Core/Src/main.c - 5STM32CubelDE

File Edit Source Refactor Mavigate Search Project | Run Window Help

érj'hgu'q_g%ﬁ‘.un E'O'Q’\Q&agqv
3%, Debug F11
5 Project Expl: Run History »
D RunAs » [DE BEGIN Header */
> E myLib Run Configurations... kR ERERE R R R R R R R R R R
~ [} NUCLED
Debug History H
» @] Incluc
v @ Core %5 Debugés > [ 15TM32 C/C++ Application |

» = Inc Debug Configurations... |

v e Cem

A third way to create a new debug configuration is to select project name in the Project Explorer view and press
[F11].
All three different ways open the Debug Configuration dialog.

3.21 Debug configuration
The Debug Configuration dialog contains the following tabs:
. Main
. Debugger
. Startup
. Source

. Common

The Debugger and Startup tabs must be updated when creating a new debug configuration while the others do
not require update.

3.2.2 Main tab

The Main tab contains the configuration of the C/C++ application to debug. Usually, when creating a debug
configuration using the sequence described earlier in this chapter, there is no need to make any change in the
Main tab. Make sure the correct e1 £ file and project are selected.
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Figure 138. Debug configuration main tab

m Edit Configuration

Edit launch configuration properties

Name: ‘ NUCLEO-F401RE

-7 Source| = Common

Mainl*ﬁ* Debugger| ® Startup

Project:
| NUCLEO-F401RE |

C/C++ Application:

| Debug/NUCLEO-FA01RE elf | SearchProject.. | Browse.. |

Build (if required) before launching

Build Configuration: |Select Automatically ™ ‘

(O Enable auto build (O Disable auto build
Configure Workspace Settings...

® Use workspace settings

Revert Apply

(0]4 | ‘ Cancel

@

Note: It is possible in the Main tab to define if a build must be made before the debug session is started.

3.23 Debugger tab
The Debugger tab configures how to start the GDB server and connect to it. It also defines which GDB server

must be used if [Autostart local GDB server] is selected.
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Figure 139. Debug configuration debugger tab

m Edit Configuration J X

Edit launch configuration properties

Name: ‘ NUCLEO-F401RE

Main | % Debugger| & Startup| B Source‘ i=] Comm0n|
GDB Connection Settings

@ Autostart local GDB server Host name or IP address |ocalhost

O Connect to remote GDB server Port number 61234

Debug probe |ST—LINK (ST-LINK GDB server)

GDB Server Command Line Options

Show Command Line

Interface

(® swp O1aG

[IST-LINK S/N ~ | |Sean
Frequency (kHz): | Auto ~ |
Access port: | 0 - Cortex-M4 v |

Reset behaviour

Type: |C0nnect under reset v |

Device settings

Debug in low power modes: |Enab|e v |
Suspend watchdog counters while halted: |N0 configuration ~ |
Serial Wire Viewer (SWV) RTOS Kernel Awareness
[ 1Enable [ ] Enable RTOS Proxy
Core Clock (MHz): 16.0 Driver settings

Limit SWO clock Driver:  ThreadX ~
Maximum SWO cock (kHz): | auto detect Port: | cortex_mO ~
Port number, 61235

Port number: | 60000

Misc
Verify flash download
Enable live expressions

[Log to file: C\Users\johansse\STM32CubelDE\workspace_um8\NUCLEO-F401RE\D| |Browse...
[ External Loader: ~ | ISean Initialize

[ Shared ST-LINK
[ Max halt timeout(s): 2

| Revert ‘ | Apply |

@ | oK | ‘ Cancel |

The [Port number] edit field contains the default value used by the GDB server selected in field [Debug probe].
Field [Host name or IP address] must be set when [Connect to remote GDB server] is selected.
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Field [Debug probe] selects the probe and GDB server to be used for debugging. When using an ST-LINK
debug probe, ST-LINK GDB server or OpenOCD can be used. When using a SEGGER J-LINK probe, use the
SEGGER J-LINK GDB server.

Pressing the [Show Command Line] button opens the GDB Server command line dialog. The dialog displays
how the GDB server is started according to the current [GDB Server Command Line options] settings.

Figure 140. GDB server command line dialog

[I1 GDB Server command line [l X

t:\ST\STM32CubeIDE_1.7.0.21w21\STM32Cube|DE\pIugins
\com.st.stm32cube.ide.mcu.externaltools.stlink-gdb-
server.win32_2.0.0.202105051205\tools\bin\ST-LINK_gdbserver.exe -p 61234 -| 1
-d -s -cp C\ST\STM32CubelDE_1.7.0.21w2 1\STM32CubelDE\plugins
\com.st.stm32cube.ide.mcu.externaltools.cubeprogrammer.win32_2.0.0.20210506
1353\tools\bin -m 0 -k

Copy & Close ‘ | Close

Use the [Copy & Close] button to copy the current command line settings to the clipboard, for instance to start
the GDB server manually in a command line window by pasting the command.

The [GDB Server Command Line options] selections are updated as a function of the [Debug probe] selected.
Detailed information about these settings are available in Section 3.4 Debug using different GDB servers and
sub-sections.

3.24 Startup tab
The Startup tab configures how to start a debug session.
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Figure 141. Debug configuration startup tab

[I Edit Configuration O x

Edit launch configuration properties

Name: | NUCLEO-F4D1RE
Main H}- Debugger [ =3 Starlupl E_f Source| [C] Common

Initializatien Commands

Load Image and Symbols

File Build Download Load symbaols dd.
= Debug\NUCLED-F401RE.elf [NUCLEO-F401RE] See Main tab Qj? true J true

Remowve

L

Move down

Runtime Options
Start Address
(®) Default start address

() Set program counter (hex):
() Specify vector table (hex):

Exception on divide by zero
[[] Exception on unaligned access
Halt on exception

Resume

Run Commands

| Revert | | Apply |

@ [ ok || cance

The [Initialization Commands] edit field can be updated with any kind of GDB or GDB server monitor commands
if there is any special need to send some commands to the GDB server before load commands are sent. For
instance, when using ST-LINK GDB server amonitor flash mass_erase command can be entered here if a
flash memory erase is needed before load.
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The [Load Image and Symbols] list box must contain the file(s) to debug. This list is associated with the
following command buttons:

. [Add...]: Add new lines for files for download and/or load symbols

. [Edit...]: Edit the selected line

. [Remove]: Remove the selected line from the list

. [Move up]: Move the selected line upwards

. [Move down]: Move selected line downwards

The [Runtime Options] section contains checkboxes to set the start address and breakpoint, and enable

exception handling and resume.

The start address can be selected as:

. [Default start address]: spc is set to the start address found in the last loaded e1£ file

. [Set program counter (hex)]: Spc is set to the hex value specified in the edit field

. [Specify vector table (hex)]: Spc is updated with the value found in memory using specified address +
offset of 4. This is similar to how $pc is set by a reset using vector table in a Cortex®-M device

The [Set breakpoint at:] checkbox is enabled by default and the edit field displays main. It means that, by

default, a breakpoint is set at main when the program is debugged.

Three exception checkboxes, [Exception on divide by zero], [Exception on unaligned access] and [Halt on
exception], are used to make it easier to find problems when debugging an application.

. [Exception on divide by zero] is enabled by default to make it easier to trap a divide-by-zero error when
debugging

. [Exception on unaligned access] can be enabled to get exceptions if there are any unaligned accesses

. [Halt on exception] is enabled by default so that program execution halts when an exception error occurs
during debugging. If an exception occurs, the Fault Analyzer view can be used to find the location of the
problem

Note: The application software needs to enable Exception on divide by zero and Exception on unaligned access
if they must be issued also when running the application and not only during debugging. The CMSIS Cortex®-M
header files contain defines to update the SCB Configuration Control Register. For instance, core cm4.h
contains the SCB->CCR register, and SCB_CCR DIV 0 TRPand SCB_CCR UNALIGN TRP defines.

When the [Resume] selection is enabled, a continue command is issued to GDB after load to start the
program. Usually, in this case, the program breaks at main if a breakpoint at main is set. Otherwise, when the
[Resume] selection is disabled, the program stays at the ENTRY location specified in the linker script, normally
the Reset Handler function. A step may be needed in this case to display the Reset Handler function in the
editor.

When a line in the listbox is selected and [Edit...] is pressed, the following dialog appears for selecting if the file
must be downloaded and if symbols must be loaded.

Figure 142. Add/Edit item

[ Add/Edit item O X

Some properties of this item can only
be changed in the “Main" tab.

Project: NUCLEO-F401RE
Program path: Debug\NUCLEO-F401RE.elf
Download

Use download offset (hex)

Load symbols

Use symbol address (hex)

Cancel
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3.3 Manage debug configurations
Each project can have several debug configurations. It is easy to create a copy of an existing debug configuration
and update it with some changes. For instance, one configuration may contain flash memory loading of new
programs while another does not load any program.
When opening debug configurations from the menu [Run]>[Debug Configurations...], the Debug Configurations
dialog opens. This dialog contains a navigation window on the left side with a toolbar, and the debug configuration
on the right side with the tabs and fields described in Section 3.2 Debug configurations.

Figure 143. Manage debug configurations

[T Debug Configurations O >

Create, manage, and run configurations

CEeEX BY- Name: | NUCLEO-FA401RE
| type filter text | Main] £ Debugger| = Startup| Bp Source| [C] Common
[E] C/C++ Application o Project:
[E] C/C++ Attach to Application
[E] C/C++ Postmortem Debugger | NUCLEQ-F401RE | | Browse.., |
[E] C/C++ Remote Application C/C++ Application:
[£] GDB Hardware Debugging -
& Launch Group | Debug/NUCLEO-FAD1RE.eff | SearchProject..| | Browse.. |
w [ 5TM32 C/C++ Application Build (if required) before launching
[[ NUCLEO-F401RE
Build Cenfiguration: |Select Automatically V|
(_) Enable aute build (") Disable auto build
(®) Use workspace settings Configure Workspace Settings...

Revert Appl
Filter matched & of 8 items — EEY

® | Debug | | Cloze

The [Name] field on top of the right pane can be edited using a name for the debug configuration which
reflects the configuration. This name then appears in the navigation window under the [STM32 Cortex-M C/C++
Application] node to the left when pressing [Apply].

The toolbar left of the navigation window contains icons to manage configurations, for instance to duplicate or
delete a selected configuration.

Figure 144. Manage debug configurations toolbar

G e B Y~
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These icons are used for the following purpose, from left to right:
. Create new launch configuration

. New launch of configuration prototype

. Export launch configuration

. Duplicate currently selected launch configuration

. Delete selected launch configuration(s)

. Collapse all expanded launch configurations

. Filter launch configurations

34 Debug using different GDB servers
STM32CubelDE includes the following GDB servers:
. ST-LINK GDB server
. OpenOCD GDB server
. SEGGER J-Link GDB server
All three GDB servers support normal debug, live expressions and SWV.
All GDB servers also support RTOS Kernel Awareness debugging for Microsoft® Azure® RTOS ThreadX and
FreeRTOS™ operating systems using an RTOS proxy. The RTOS proxy is included in STM32CubelDE.

Different command-line options are used when starting these GDB servers. Therefore the Debugger tab in the
Debug Configurations dialog displays different settings depending on the GDB server selected. This section
describes the individual settings for each server.

3.41 Debug using the ST-LINK GDB server

Usually, when the ST-LINK GDB server is used for debugging, there is no need to update the [GDB Server
Command Line Options] in the Debugger tab. In some cases, the default configuration must be updated, for
instance if SWV is intended to be used or if several STM32 boards are connected to the PC.

UM2609 - Rev 6 page 134/245


https://www.st.com/en/product/stm32cubeide?ecmp=tt9470_gl_link_feb2019&rt=um&id=UM2609

UM2609

Debug using different GDB servers

Figure 145. ST-LINK GDB server debugger tab
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E Debug Configurations

Create, manage, and run configurations

CEeEX B~

| type filter text

[E] C/C++ Application
[E] C/C++ Attach to Application
[£] C/C++ Postmortem Debugger
[€] C/C++ Remote Application
[t ] GDB Hardware Debugging
2 Launch Group
v E 5TM32 C/C++ Application
[[] NUCLEO-F401RE
[[] NUCLEO-FA401RE (OpenOCD)
m MNUCLEQ-F401RE (SEGGER]

Mame: | NUCLEO-F401RE

Main | 35 Debugger] "3 Startup| Ep Source| i=| Common|

GDB Connection Settings
(® Autostart local GDB server Host name or IP address | localhost

(O Connect to remote GDB server  Port number

Debug probe |ST—I_INK (ST-LINK GDB server)

GDE Server Command Line Options

Show Command Line

Interface
® swp CITAG

[]ST-LINK S/M ~

Frequency (kHz): | Auto

Access port: | 0 - Cortex-M4

Reset behaviour

Type: |Conned under reset V|

Device settings

61234

Debug in low power modes: | Enable ~ |
Suspend watchdog counters while halted: | Ma configuration ~ |
Serial Wire Viewer (SWV) RTOS Kernel Awareness
[JEnable [[] Enable RTOS Proxy
Care Clock (MHz): 16.0 Driver settings
Limit SWO clock Driver: | ThreadX ~
faximurn WO clock (kHz) | auto detect Port: | cortex_mi ~
Port number: 61235
Port number: | 0000
Misc
Verify flash download
Enable live expressions
CiUsers\bil st STM32Cubel DE\workspace_ur| | Browse...
[ External Leader: | | Scan Initialize
] Shared ST-LINK
[ Max halt timeout(s): 2
Revert Appl
Filter matched 10 of 10 items - -
@ | Debug I | Clese |

Select [SWD] or [JTAG] in [Interface] to define how the ST-LINK probe must connect with the microcontroller. The
SWD interface is usually the preferred choice. It must be selected if SWV is to be used.
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When [ST-LINK S/N] is enabled, the serial number of the ST-LINK probe to be used must be entered in the
edit/list field. The [Scan] button can be used to scan and list all detected ST-LINK devices connected to the PC.
After a scan, the S/N of these ST-LINK devices are listed in the list box from which the desired ST-LINK can be
selected. When [Use specific ST-LINK S/N] is enabled, the ST-LINK GDB server is started and connects only to
the ST-LINK with the selected S/N.

The [Frequency (kHz)] selection defines the communication speed between the ST-LINK and STM32 device.
When [Auto] is selected, the maximum speed provided by ST-LINK is used. Reduce the frequency in case of
hardware limitations.

The [Access port] selection is used only when debugging a multi-core STM32 device. In such case, the ST-LINK

is connected to the device and the ST-LINK GDB server must be informed of the core to debug.

The [Reset behaviour] contains selections for [Type] and [Halt all cores]. The [Halt all cores] selection is only

visible for multi-core devices.

The [Type] can be set as follows:

. [Connect under reset] (default): ST-LINK reset line is activated and ST-LINK connects in the SWD or JTAG
mode while reset is active. Then the reset line is deactivated.

. [Software system reset]: System reset is activated by software writing in a register. This resets the core
and peripherals, and can reset the whole system as the reset pin of the target is asserted by itself.

. [Hardware reset]: ST-LINK reset line is activated and deactivated (pulse on reset line), then ST-LINK
connects in the SWD or JTAG mode.

. [Core reset]: Core reset is activated by software writing in a register (not possible on Cortex®-M0,
Cortex®-M0+ and Cortex®-M33 cores). This only resets the core, not the peripherals nor the reset pin.

. [None]: For attachment to a running target where the program is downloaded into the device already. There
must not be any file program command in the Startup tab.

Note: The selected reset behaviour is overridden if the debug configuration includes flash memory programming,
in which case the ST-LINK GDB server uses the STM32CubeProgrammer (STM32CubeProg) command-line
program STM32 Programmer CLI to program the flash memory. This program is always started by the ST-
LINK GDB server with mode=UR reset=hwRst SO that a device reset is done when loading a new program,
disregarding the selection of the [None] option. This ensures that device programming is made correctly.
[Halt all cores] can be used only when debugging multi-core devices. The [Halt all cores] selection is not visible
for single core devices.
[Device settings] contains selections for [Debug in low power modes] and [Suspend watchdog counters
while halted]. These can be defined as:
. [No configuration]
. [Enable]
. [Disable]
The [Serial Wire Viewer (SWV)] selections can be used only when the [SWD] interface is selected. When [SWV]
is enabled, it is required to configure the [Clock Settings]. The [Core Clock] must be set to the device speed.
More information about SWV configuration is available in Section 4.2.1 SWV debug configuration.
The [RTOS Kernel Awareness] selections are used to to enable RTOS-kernel-aware debugging with the

ThreadX and FreeRTOS™ operating systems. When RTOS-kernel-aware debugging is enabled and a debug
session is started, all threads are listed in the Debug view. By selecting a thread in the Debug view the current
line executed by the thread is displayed in the editor. More information about RTOS-kernel-aware debugging is
available in Section 6.3 .
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The [Misc] selections contains:

. [Verify flash download]

. [Enable live expressions] (To be able to use the Live Expressions view during debugging, the live
expression mechanism must be enabled during startup. It is enabled by default.)

. [Log to file] (Enable in case of debugging problems. It starts the ST-LINK GDB server with a higher log level
and saves the log into a file.)

. [External Loader] (Enable if loading must be made to non-internal STM32 flash memory). A [Scan] button is
available to access STM32CubeProgrammer external flash loader files.
When [External Loader] is enabled, there is also an [Initialize] selection. When it is enabled, the Init ()
funtion in STM32CubeProgrammer is called after reset. It can be used to configure the device for external
memory access. Usually, initialization must be done by the debugged application.

. [Shared ST-LINK] (Shared ST-LINK must be enabled if other programs must be able to connect to the same
ST-LINK during a debug session.). Refer to Section 3.6.2 Shared ST-LINK for details.

A detailed description of the ST-LINK GDB server is available in the ST-LINK GDB server manual ([ST-07]),
which is available from the Information Center.

Note: STM32 Programmer CLI is used by the ST-LINK GDB server to program the STM32 or external flash
memory. In this case, such external flash memory programming is automatically done using the external loader.
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3.4.2 Debug using OpenOCD and ST-LINK

When OpenOCD is used, the [GDB Server Command Line Options] in the Debugger tab contains a generator
options toggle field, which alternates between [Show generator options...] and [Hide generator options...].

When the field is set to [Hide generator options...], the dialog displays additional [GDB Server Command Line
Options] as shown in Figure 146.

Figure 146. OpenOCD debugger tab

E Debug Configurations

Create, manage, and run configurations

CEReEX BY- Mame: [ NUCLEQ-F401RE (OpenOCD)
| type filter text | Main | 5 Debuggerl " Startup| 173 Source| =) Common|
[€] C/C++ Application GDE Connection Settings
E C/C++ Attach to Application (®) Autostart local GDB server Host name or IP address  localhost
[£] C/C++ Postmortem Debugger
[E] C/C++ Remote Application () Connect to remote GDB server Port number 3333
[£] GDE Hardware Debugging ; :
& Launch Group Debug probe |?'5T—LINK (Open0CD) i
v m 5TM32 C/C++ Application GDE Server Command Line Options

[[] NUCLEO-F401RE

[T} NUCLEQ-FAD1RE (OpenOCD) drrw fammen L

E MNUCLEOQ-FA01RE (SEGGER) OpenOCD Setup

OpenOCD Command:

| "8§{stm32cubeide_openocd_path}\openocd.exe” | | Browse...

OpenOCD Options : | |

Configuration Script

(®) Automated Generation () User Defined | Show generator options... |

Script File: | ${ProjDirPath ANUCLED-F401RE (OpenOCD).cfg | Browse... Reload

Serial Wire Viewer (SWV) RTOS Kernel Awareness

[JEnable [ Enable RTOS Proxy
Care Clack {MHz): 16.0 Driver settings

Limit SWO clock Drriver: [ ThreadX ~
Maximurm S0 clock (kHz): | auto detect Port: | cortex_m0 o
Fort number: 3344

Paort nurnber: | 60000
Misc
Enable live expressions

ST-LINK Client Setup
[ Shared ST-LINK

Filter matched 10 of 10 items | Revet || Appl

©) I

Debug | | Close |

The [OpenOCD Command] edit field contains the openocd. exe file to be used when debugging. The [Browse]
button can be used to select another version of OpenOCD.

The [OpenOCD Options] edit field can be used to add additional command-line parameters to be used when
starting OpenOCD.
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The [Configuration Script] selections can be [Automated Generation] or [User Defined]. When [Automated
Generation] is selected, an openocd. cfg file is created automatically based on the selections made in the
Debugger tab. When [User Defined] is selected, the file must be specified in the [Script File] edit field.

The [Interface]selection [Swd] or [Jtag] selects how the ST-LINK probe must connect with the microcontroller.

[Swd] is usually the preferred choice.

The Frequency selection configures the communication speed between the ST-LINK and STM32 device.

The [Reset Mode] selection contains:

. [Connect under reset] (default): ST-LINK reset line is activated and ST-LINK connects in the SWD or JTAG
mode while reset is active. Then the reset line is deactivated.

. [Hardware reset]: ST-LINK reset line is activated and deactivated (pulse on reset line), then ST-LINK
connects in the SWD or JTAG mode.

. [Software system reset]: System reset is activated by software writing in a register. This is resetting the
core and peripherals, and can reset the whole system as the reset pin of the target is asserted by itself.

. [Core reset]: Core reset is activated by software writing in a register (not possible on Cortex®-M0,
Cortex®-M0+ and Cortex®-M33 cores). This is only resetting the core, not the peripherals nor the reset
pin.

. [None]: For attachment to a running target where the program is downloaded into the device already. There
must not be any file program command in the Startup tab.

[Enable debug in low power modes] enables debug also with the STM32 device in low-power mode.

[Stop watchdog counters when halt] stops the watchdog when the debug session halts the STM32 device.

Otherwise, a watchdog interrupt may be triggered.

The [Serial Wire Viewer (SWV)] selections can be used only when the [SWD] interface is selected. When [SWV]
is enabled, it is required to configure the [Clock Settings]. The [Core Clock] must be set to the device speed.
More information about SWV configuration is available in Section 4.2.1 SWV debug configuration.

The [RTOS Kernel Awareness] selections are used to to enable RTOS-kernel-aware debugging with the

ThreadX and FreeRTOS™ operating systems. When RTOS-kernel-aware debugging is enabled and a debug
session is started, all threads are listed in the Debug view. By selecting a thread in the Debug view the current
line executed by the thread is displayed in the editor. More information about RTOS-kernel-aware debugging is
available in Section 6.3 .

[Enable live expressions] must be enabled if the Live Expressions view is meant to be used during debugging.

[Shared ST-LINK] must be enabled if other programs have to connect to the same ST-LINK during a debug
session. Refer to Section 3.6.2 Shared ST-LINK for details.

3.4.3 Debug using SEGGER J-Link

When [SEGGER J-LINK] is selected in the Debugger tab, the [GDB Server Command Line Options]
corresponds to SEGGER J-Link GDB server.
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Figure 147. SEGGER debugger tab

m Debug Configurations O X

Create, manage, and run configurations
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| type filter text | Main | % Debugger] = Startup| 73 Source| i=| Common|
[E] C/C++ Application GDB Connection Settings
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[€] C/C++ Remate Application () Connect to remote GDB server Port number 233

[£] GDB Hardware Debugging
& Launch Group Debug probe |§’SEGGERJ-I_INK i

W m 5TM32 C/C++ Application GDE Server Command Line Options
[I] NUCLEO-FA0RE

[} NUCLEQ-FAD1RE (Open0CD) Show Command Line

m MNUCLEQ-F40MRE (SEGGER) Interface

@SWD O JTAG  Initial Speed kHz [] Use specific J-Link 5/N

Device | STM32F401RE

Reset strategy | Type O: Nermal

JTAG Scan Chain

Auto Manual Paosition IRPre | O

Serial Wire Viewer (SWV) RTOS Kernel Awareness
[JEnable [JEnable RTOS Proxy J-Link
Core Clock (MHz): 8.0 Driver seftings

Limit SWO clock Driver: | Threadi -
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Misc
[JUse J-Link script file Search Project... | | Browse...

Enable live expressions
[ Verify flash download

Filter matched 10 of 10 items | Revet || Apply |

® | Debug | | Close |

The [Interface] selection [SWD] or [JTAG] selects how the SEGGER J-Link probe must connect with the
microcontroller. The [SWD] interface is usually the preferred choice; it is required if SWV is used.

The [Initial Speed] selection configures the communication speed used between SEGGER J-Link and the STM32
device.

When [Use specific J-Link S/N] is enabled, enter the S/N of the J-Link to be used when debugging in the edit/list
field. When [Use specific J-Link S/N] is enabled, the SEGGER J-Link GDB server is started and connects only
to the J-Link with the selected S/N.

The Device edit field is used if it contains an entry. This field can be used if there is a problem to start the
SEGGER J-Link GDB server with the default device name used in STM32CubelDE. In such case, enter the
device name used by the SEGGER GDB server in the edit field.
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The [Reset strategy] selection contains:
. [Type 0: Normal] - Default.

. [None] - Intended to be used for attaching to the running target. In this case, the program must already be
downloaded into the device. There must not be any file program command in the Startup tab.

The [JTAG Scan Chain] selections can be used only when the [JTAG] interface is selected.

The [Serial Wire Viewer (SWV)] selections can be used only when the [SWD] interface is selected. When [SWV]
is enabled, it is required to configure the [Clock Settings]. The [Core Clock] must be set to the device speed.
More information about SWV configuration is available in Section 4.2.1 SWV debug configuration.

The [RTOS Kernel Awareness] selections are used to to enable RTOS-kernel-aware debugging with the

ThreadX and FreeRTOS™ operating systems. When RTOS-kernel-aware debugging is enabled and a debug
session is started, all threads are listed in the Debug view. By selecting a thread in the Debug view the current
line executed by the thread is displayed in the editor. More information about RTOS-kernel-aware debugging is
available in Section 6.3 .

The [Misc] selections contains:
. [Use J-Link script file]
. [Enable live expressions]

To be able to use the Live Expressions view during debug, the live expression mechanism must be enabled
during startup.

. [Verify flash download]
. [Select RTOS variant] list box can be used if [Thread-aware RTOS support] is used with [FreeRTOS] and
[embOS].

When [Thread-aware RTOS support] is used, update the Startup tab: disable [Resume] and [in Run
Commands], add thread 2 and continue. This forces a thread context switch before the continue
command is sent.

Note: A detailed description of SEGGER J-Link GDB server is available in the SEGGER J-Link manual, which can be
accessed from the “Information Center”.

3.5 Start and stop debugging

When a debug configuration is created for the project with the preferred JTAG probe, it is ready for debugging. In
the following sections, the ST-LINK GDB server is used. However, the way to debug the STM32 project is quite
independent of the choice among ST-LINK GDB server, OpenOCD or SEGGER J-Link.

Perform the following steps to prepare for debug:

1.  Determine whether the board supports the JTAG debug, SWD debug, or both.
SWD-mode debug is usually the preferred choice.

2. Connect the JTAG cable between the JTAG probe and the target board.

When using STMicroelectronics STM32 Nucleo and Discovery boards, the ST-LINK is usually integrated on
the board. Also, most STMicroelectronics STM32 Evaluation boards contain an embedded ST-LINK.

3. Connect the USB cable between the PC and the JTAG probe.
4. Make sure that the target board has a proper power supply attached.
Once the steps above are performed, a debug session can be started.

3.51 Start debugging

Open the Debug Configurations dialog with a right click on the project name in the Project Explorer view and
select [Debug As]>[Debug Configurations...].

It is also possible to open the dialog using the menu [Run]>[Debug Configurations...].
This opens the Debug Configurations dialog.

Note: It is possible to select the project in the “Project Explorer” view and press [F11] to restart a debug session after it
has been closed.
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Figure 148. Debug configurations

[ Debug Configurations [m| X
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[€] GDB Hardware Debugging
5 Launch Group Debug probe |ST—LINK (ST-LIMK GDB server)
v m 5TM32 C/C++ Application GDEB Server Command Line Options
[[3 NUCLEO-F4D1RE -
[[7] NUCLEQ-F401RE (Open0CD) iz CrmE L
[} NUCLEO-F4D1RE (SEGGER) Interface
@ SWD O JTAG
ST-LINK 5/M | 066FFF305252717267065926 - \
Frequency (kHz): | Auto w ‘
Access port: | 0 - Cortex-M4 w ‘
Reset behaviour
Device settings
Debug in low power modes: | Enable ~ |
Suspend watchdog counters while halted: | No configuration ~ |
Serial Wire Viewer (SWV) RTOS Kernel Awareness
[ Enable [] Enable RTOS Proxy
Care Clack (MHz): 16.0 Driver settings
Limit SWO clock Driver: | ThreadX i
Faxirmum SWO clock (kHz): | auto detect Port: | cortex_mi ~
Port nurmber: 61235
Part nurnber: | 60000
Misc
Verify flash download
Enable live expressions
[ Log to file: C\Users\ bamgamsa\5TM32Cubel DE\workspace_umd\NUCLEO-FAD1RE\ | | Browse...
[ External Loader: ~ | | Scan Initialize
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v
Revert A
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Select in the left pane the debug configuration to use. Press the [Debug] button to start a debug session if all
debug configurations have been made. The project is built if file updates are made, but the building depends on
the debug configuration.

STM32CubelDE launches the debugger and the following dialog is opened.
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Figure 149. Confirm perspective switch

mConfirm Perspective Switch X

@ This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It incorporates views
for displaying the debug stack, variables and breakpoint management.

Do you want to switch to this perspective now?

[] Remember my decision

| Switch | ‘ No

It is recommended to enable [Remember my decision] and press [Switch]. It opens the Debug perspective,
which provides a number of views and windows suitable for debugging.

Debug perspective and views
The Debug perspective contains menus, toolbars and views frequently used during debugging.

Figure 150. Debug perspective
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The most important views opened by default in the Debug perspective are:

. The Debug view, which displays the program under debug. It also lists threads and offers the possibility to
navigate in the thread by selecting a line in threads.

. The Editor view, which displays the program file. It is possible to set break points and follow program
execution in the file. It is also possible to hoover the cursor over a variable to display its current value. The
features available during file edition are available also during debug, such as opening the declaration of a
function and others.

. The Variables view, which displays local variables automatically with their current value when the program is
not running.
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. The Breakpoints view, which displays current breakpoints. It is possible to disable and enable breakpoints in
the list. The Breakpoints view also contains a toolbar, which, for instance, enables to remove breakpoints,
and skip breakpoints with one click on the [Skip All Breakpoints] icon.

. The Expressions view, which is used to add and view expressions. An expression may be a single global
variable, structure, or an expression calculating some variables. The values are only updated when the

program is stopped. It is possible to select a global variable in the Editor and drag it over to the Expressions
view instead of entering the variable name.

. The Registers view, which displays the debugged device current values. The values are only updated when
the program is stopped.

. The Live Expressions view, which displays expression values sampled and updated regularly during
program execution. The view allows the creation of mathematical expressions that are evaluated
automatically, such as (Index*4+0ffset). The Live Expressions view update requires that live
expressions are enabled in the debug configuration. Refer to Section 3.6.1 Live Expressions view for
details.

. The SFRs view, which displays the Special Function Registers in the debugged device. Refer to
Section 5 Special Function Registers (SFRs) for details.

. The Console view, which displays different console outputs. By default, the console output from the GDB
server log is displayed. It is possible to change the console log by pressing the [Display Selected Console]
icon to the right of the Console view.

Other views are also useful during debug, among which:

. The Debugger Console view, which can be used if there is a need to manually enter GDB commands. The
easiest way to open the Debugger Console view is to use the [Quick Access] field and enter Debugger
in this field. It lists choices containing the Debugger Console view. Select it to open the view. GDB can be
entered in the Debugger Console view.

For instance, to display 16 words of memory from address 0x800 0000, enter the GDB command x /16

0x8000000.

x /16 0x8000000

0x8000000: 0x20018000 0x080008b1l 0x080007e9 0x080007£7
0x8000010: 0x080007£d 0x08000803 0x08000809 0x00000000
0x8000020: 0x00000000 0x00000000 0x00000000 0x0800080f
0x8000030: 0x0800081d 0x00000000 0x0800082b 0x08000839

. The Memory and Memory Browser views, which can be used to display and update memory data.
. The Disassembly view, which is used to view and step in the assembly code.

. The SWV views. Refer to Section 4 Debug with Serial Wire Viewer tracing (SWV) for details.

. The Fault Analyzer view. Refer to Section 7 Fault Analyzer for details.
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3.5.3 Main controls for debugging
The [Run] menu in the Debug perspective contains a number of execution control functions.

Figure 151. [Run] menu

E workspace_um1 - NUCLEO-F401RE/Core/Src/main.c

File Edit Source Refactor Navigate Search Project Run '
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i¥ |nstruction Stepping Mode
% Del *. Move to Line (C/C++)
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¥ [k Resume F8
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® Terminate Ctrl+F2
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& Reset
2. Step Into F5
% Step Over F6
.2 Step Return F7
Run to Line Ctrl+R
Use Step Filters
Step Into Selection Ctrl+F5
* Debug F11
Debug History >
# Debug As >
Debug Configurations...
Breakpoint Types >
Toggle Breakpoint Ctrl+Shift+B

° Toggle Line Breakpoint
. Toggle Watchpoint
Toggle Method Breakpoint
® Skip All Breakpoints Ctrl+Alt+B
% Remove All Breakpoints

Alternatively, the Debug perspective toolbar has the following main debug control icons.

Figure 152. Debug toolbar
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These icons are used for the following purpose, from left to right:
. Reset the device and restart the debug session
. Skip all breakpoints (Ctri+Alt+B)

. Terminate and relaunch

. Resume (F8)

. Suspend

. Terminate (Ctrl+F2)

. Disconnect

. Step into (F5)

. Step over (F6)

. Step return (F7)

. Instruction stepping mode (assembler stepping)

Press [Terminate and relaunch] to terminate the current debug session, build a new program if the source code
is modified, and relaunch the debug session.

When pressing [Instruction stepping mode], the Disassembly view is opened and further stepping uses
assembiler instruction stepping level. Press [Instruction stepping mode] again to toggle back to C/C++ level
stepping.

3.54 Run, start and stop a program
Use the toolbar icons as follows to run, step, or stop the program:
. Run the program with the [Resume] toolbar icon ([F8])
. Step into a function with the [Step into] toolbar icon ([F5])
. Step over a function with the [Step over] toolbar icon ([F6])
. Step until return from a function with the [Step return] toolbar icon ([F7])
. Abort running program with the [Suspend] toolbar icon

3.5.5 Set breakpoints
It is common during a debug session to set breakpoints and let the code execute until it reaches a breakpoint.

3.5.5.1 Standard breakpoint

A standard code breakpoint at a source code line can easily be inserted by double-clicking in the left editor
margin, or by right-clicking in the left margin of the C/C++ source code editor. A context menu is proposed in the
latter case.

Figure 153. Debug breakpoint

1CA ; /¥ 1ICCD ~AMNC CAMR LILUTIE %/
Toggle Breakpoint Ctrl+Shift+B
Add Breakpoint... Ctrl+Double Click
Add Dynamic Printf...
Disable Breakpoint Shift+Double Click
Breakpoint Properties... Ctrl+Double Click
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Go to Annotation Ctrl+1
Add Bookmark...
Add Task...

v Show Quick Diff Ctrl+Shift+Q

~ Show Line Numbers
Folding >
Preferences...
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Select the [Toggle Breakpoint] menu command to set or remove a breakpoint at the corresponding source code
line.

3.5.5.2 Conditional breakpoint

When setting a standard breakpoint at a source code line, the program breaks each time it reaches this line. If
that is not the desired behaviour, a condition can be set on the breakpoint that regulates if the program should
actually break or not on that breakpoint.

Update breakpoint properties with a right-click on the breakpoint icon visible left of the editor on a line with
breakpoint set. The [Breakpoint Properties] can also be opened from the Breakpoints view.

Figure 154. Breakpoint properties
1 r - TN

Toggle Breakpoint Ctrl+Shift+B
Add Breakpoint... Ctrl+Double Click
Add Dynamic Printf...
Disable Breakpoint Shift+Double Click
Breakpoint Properties... Ctrl+Double Click
Breakpoint Types >
Go to Annotation Ctrl+1
Add Bookmark...
Add Task...
~ Show Quick Diff Ctrl+Shift+Q
v Show Line Numbers
Folding >
Preferences...

Select [Breakpoint Properties...]. The following window opens. In the example illustrated below, i>20 is entered
as a condition.

Figure 155. Conditional breakpoint

[I Properties for C/C++ Line Breakpoint O X
‘ Common R
Cor_nmon Class: C/C++ Line Breakpoint
Actions
Filter Type: Regular v
File: C\Users\johansse\STM32CubelDE\workspace_umT\NUCLEO-F401RE\Core\Src\main.c
Line number: 156
Enabled
Condition: i>20

Ignore count: 0

®@ Apply and Close Cancel

With the condition above set, the program breaks each time the line is executed, then GDB tests the condition
and restarts execution if the variable i is not greater than 20. It takes some time for GDB to evaluate the
condition.

The conditions are written in C-style. It is therefore possible to write expressions such as 1%2==0" to set more
complex conditions.
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3.5.6 Attach to running target

It is possible to connect STM32CubelDE and a debugger via JTAG/SWD to the embedded target without
performing a reset. This approach is useful when trying to resolve problems that occur at rare occasions. Finding
the root cause of the problem in case of a CPU crash is further simplified by learning how to use the Fault
Analyzer view (refer to Section 7 Fault Analyzer).

Before trying this approach, consider whether halting the application in the wrong state could potentially harm the
hardware (for instance in the case of a motor controller application). This is because when GDB connects to the
target, the CPU is halted. This behaviour cannot be modified.

The following three or four steps are needed to update the debug configuration and to attach to running target:
1. Modify the debug configuration to attach to the running target

2. Connect the debug probe to the embedded target

3.  Start a debug session using the modified debug configuration

4.  Optionally, analyze the CPU fault condition with the Fault Analyzer tool (refer to Fault Analyzer)

Step 1: Modify the debug configuration

The default generated debug configurations in STM32CubelDE contains settings to reset the device and
download new program, and sets a breakpoint at main. This is not of any use when connecting to a running
system which may, or may not, have crashed.

In order to create a modified debug configuration, perform these steps:
1. Open the Debug Configurations dialog.

2. In the left frame of the Debug Configurations dialog, select the debug configuration associated to the project
to debug and make a copy of this by right-clicking it and selecting [Duplicate].

3.  Give the duplicate debug configuration a name.

4. Update the Debugger tab in Debug Configurations:
—  When using ST-LINK GDB server and OpenOCD, select [None] as [Reset behaviour].
—  When using SEGGER J-Link GDB server, select [None] as [Reset strategy].

5. Change needed/recommended in the Startup tab of Debug Configurations for both ST-LINK GDB server and
SEGGER J-Link GDB server:

—  Disable file [Download] in [Load Image and Symbols].

—  Disable [Set program counter at (hex)].

—  Disable [Set breakpoint at].

—  [Exception on divide by zero]and [Exception on unaligned access] can be disabled or enabled.
—  Disable [Resume].

If the [Resume] is enabled, the debugger stops the target during connection and, after a short period of
time, sends a continue command.
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Figure 156. Startup tab attach
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w [ 5TM32 C/C++ Application 08 Image and symbols
m NUCLEQ-F401RE Debug (OpenOCD) File Build Download Load symbols Add...
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(O Specify vector table (hex):
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Exception on divide by zero
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@ | Debug | ‘ Close ‘

Step 2: Connect ST-LINK or SEGGER J-Link to the embedded target

Connect first ST-LINK or the SEGGER J-link to the computer. Then connect it to the embedded target. No reset is
issued.

Step 3: Start a debug session using the modified debug configuration

Do not launch the debug session using the wrong debug configuration, which may reprogram and reset the
target. Use [Run]>[Debug Configurations...], select the modified debug configuration in the left frame, and click
[Debug]. This is the safest way to launch a debug session with full control of the debug configuration applied
and prevents from a potential reset.

The debugger is now connected to the embedded target, which is automatically halted. At this point, different
status registers and variables can be investigated in the application. If the CPU has crashed, the Fault Analyzer
can be used to get a better understanding of the root causes.

Restart or terminate debugging
This section presents various ways to restart and stop a debug session.
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3.5.7.1 Restart

During debugging, it is sometimes needed to restart the program to examine more carefully problems observed
during debug. In such case, restart the program using the [Reset the chip and restart debug session] toolbar
button or [Run]>[Restart] menu command. This resets the device, and starts the program if [Resume] is enabled
in the debug configuration.

Note: To make restart work, the interrupt vector must be configured and used with the hardware reset. This is usually
the case for STM32 programs located in the flash memory. However, if the program is located elsewhere
such as in RAM, some manual handling may be needed to make the program start from the expected
Reset Handler.

3.5.7.2 Restart configurations

It is possible to create restart configurations defining how the reset and restart of a debug session must be
performed. Click on the arrow to the right of the [Reset the chip and restart debug session] toolbar icon.

Figure 157. Reset the chip toolbar

AR I S T

n::lject| Reset the chip and restart debug session

This expands the menu with the [Restart Configurations...] selection.

Figure 158. Restart configurations selection

S i | B E N D o
Reset 5%
Restart Configurations...

ITRF AT Trarec 1Tl
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When [Restart Configurations...] is selected, the restart configurations dialog opens.

Figure 159. Restart configurations dialog

[ Restart configurations O >

Reset and restart configurations

|:| = 4 Marme | Reset |

Reset Type: | Reset " |

Additional commands:

Apply

@ oK || Cancel

The dialog contains a left and right pane:

. The left pane is used to select and create new restart configuration, duplicate an existing restart
configuration, and delete the selected restart configuration. The default restart configurations cannot be
deleted.

. The right pane is used to set [Name] and select the [Type] of reset to be used for the selected configuration.
It is also possible to add additional commands to be used with the reset.

Press [Apply] to save a setting.
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Figure 160 shows a setting where a new restart configuration is created, which contains an additional command
to set pc to 0x8000ca0.

Figure 160. Restart configurations dialog with additional command

[ Restart configurations O >

Reset and restart configurations @

Mame | Reset_and_set_pc |

Type: | Reset w |

Additional commands:

et Spo=0nB000cal

Apply

@ ok || cancel

When several reset configurations are defined, they appear in the toolbar dropdown menu in order of use. Select
the desired one to perform a reset.

Figure 161. Select restart configuration

‘E|'i-|]i-uui£‘-?.‘=:‘.'!=.ﬁf

Fezet
Reset_and_set pc

EEEE

R

Restart Configurations...

I'E 1 I B s | |

3.5.7.3 Terminate
The most common way to stop a debug session is by clicking the [Terminate] toolbar button. It is also possible to
stop the debug session with the [Run]>[Terminate] menu. When the debug session is stopped, STM32CubelDE
switches automatically to the C/C++ perspective.
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3.5.7.4 Terminate and relaunch

Use the [Terminate And Relaunch] toolbar button if changes in the source code have been made during the
debug session. Menu command [Run]>[Terminate And Relaunch] can also be used for this purpose. This stops
the debug session, rebuild the program, and relaunches a debug session with the new program loaded.

3.6 Debug features

3.6.1 Live Expressions view

The Live Expressions view in STM32CubelDE works very much like the Expression view with the exceptions that
all the expressions are sampled live during debug execution. The sampling speed is determined by the number of
expressions being sampled. An increased number of expressions being sampled results in a slower sample rate.

The view displays many different types of global variables. The view also allows users to create mathematical
expressions that are evaluated automatically, suchas (i * 4 + offset).

Figure 162. Live Expressions

(x)= Variables 9g Breakpoints & Expressions 1il! Registers & Live Expressions i1 8 SFRs X% 2 =B

Expression Type Value

)= i uint32_t 2
(=)= offset uint32_t 8
()= "4+ offset unsigned int 16

57 Add new expression

The view can parse complicated data types and display complex data types like C-language structures. Only one
format of numbers is used at the same time. To change this format, use the dropdown menu.

Figure 163. Live expressions number format

(x)= Variables @ Breakpoints &7 Expressions !fli Registers &7 Live Expressions [ 8 SFRs X% =0

Expression Type Default Number Format »
= i uint32_t Hex
b= affset uint32_t ® Decimal
{=)= *d=offset unsigned int Octal
o Add new expression Binary

The variable values can be changed on the fly in the Live Expressions view while the program is running. Select
the variable and change its value. It requires that only single variable name is used in the expression, and that no
calculation involved.

Note: To be able to use the Live Expressions view during debug, the live expression mechanism must be enabled
during startup.
3.6.2 Shared ST-LINK

In the Debugger tab in Debug Configurations for ST-LINK GDB server and OpenOCD, a selection enables shared
ST-LINK. When shared ST-LINK is enabled, the communication to ST-LINK goes via the ST-LINK server. The
ST-LINK server makes it possible for several programs to access the same ST-LINK when shared ST-LINK is
enabled.

STM32CubeProgrammer (STM32CubeProg) also contains a configuration for shared ST-LINK. This means that
when shared ST-LINK is enabled in the debug configuration in STM32CubelDE, it is possible to debug a program
and let STM32CubeProgrammer access and read the device flash memory and RAM at the same time.

Enabling the shared mode causes STM32CubelDE to launch the ST-LINK server, if it is not already running, with
the default port 7184 for listening to the TCP connection. This default port is not editable from STM32CubelDE.
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3.6.3 Debug multiple boards

Debugging with multiple boards is possible using two ST-LINK or SEGGER J-Link probes at the same time.
Connected to two different microcontrollers, both probes are connected to one PC on different USB ports. In this
section, let us suppose that two different boards/microcontrollers are used: HW_A and HW_B.

It is possible to run one instance of STM32CubelDE containing one project for HW_A and one project for HW_B.
The default port to be used is:

. 61234 for ST-LINK GDB server

. 3333 for OpenOCD

. 2331 SEGGER J-Link

This is presented in the Debugger tab in the Debug Configurations dialog. The port number must be changed for
one of the projects to use another port, such as port 61244.

The debug configuration can use GDB connection selection [Autostart local GDB server]. Note that when
debugging multiple boards, two or more debug probes are connected to the PC; the correct serial number must
be selected for each debug configuration.

When the debug configurations has been configured for both projects so that each board is associated to a
specific probe, it is time to test and debug each board individually first. When it is confirmed that this is working,
the debug of both targets at the same time can be started as follow:

1.  Start to debug HW_A.

2. The perspective switches automatically to the Debug perspective in STM32CubelDE when a debug session
for HW_A is started.

3. Switch to the C/C++ perspective.
Select the project for HW_B and start debugging it. The Debug perspective opens again.
5.  There are two application stacks/nodes in the Debug view, one for each project. When changing the

selected node in the Debug view, the related editor, variable view and others are updated to present
information associated to the selected project.
It is also possible to start the GDB servers manually: select [Connect to remote GDB server] in the debug
configuration. In such case, make sure that the GDB servers are started with parameters defining the individual
ports and serial numbers to be used, and that the corresponding port numbers are used in the Debug
Configurations dialog for each project.
Below is an example using SEGGER J-Link GDB server connecting to SEGGER J-Link, with port=2341 and
S/N=123456789:

>JLinkGDBServerCL.exe -port 2341 -if SWD -select usb=123456789

&

Information on command-line parameters to be used when starting the GDB servers manually are provided in the
GDB server manuals available from the Information Center.

3.6.4 STM32H7 multicore debugging
Information about how to use STM32H7 multicore devices in STM32CubelDE is available in [ST-09].

3.6.5 STM32MP1 debugging
Information about how to use STM32MP1 devices in STM32CubelDE is available in [ST-08].

Users are advised to keep updated with the documentation evolution of the STM32MP1 Series at www.st.com/en/
microcontrollers-microprocessors/stm32mp1-series.

3.6.6 STM32L5 debugging

Information about how to use STM32L5 devices with TrustZone® in STM32CubelDE is available in [ST-10].
Note: TrustZone is a registered trademark of Arm Limited (or its subsidiaries) in the US and/or elsewhere.
3.7 Run configurations

It is possible to create run configurations to download applications and reset the target without launching a full
debug session. The Run Configurations dialog is similar to the Debug Configurations dialog, however disabled
widgets in the lower part of the Startup tab are not performed. When running a run configuration, the specified
program is flashed but, after program counter is set, the program execution is started in target and the "run"
session in STM32CubelDE is closed.
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To create a run configuration for the project, right-click on the project name in the Project Explorer view and select
[Run As]>[STM32 Cortex-M C/C++ Application].

Another way to create a run configuration is to select the project name in the Project Explorer view and use the
menu [Run]>[Run As]>[STM32 Cortex-M C/C++ Application].

Figure 164. Run configurations startup tab

[[ Debug Configurations O X

Create, manage, and run configurations

CEeER| BT~ Mame: | NUCLEO-F401RE
‘ type filter text | Main | %5 Debugger | = Startupl Ep Source| [C] Common
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C/C++ Postmortem Debugger
C/C++ Remote Application
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2 Launch Group

v [ STM32 C/C++ Application

[[] MUCLED-FAD1RE File Build Download Load symbols Add...

[[5 NUCLEQ-F401RE (OpenOCD) [ Debug/NUCLEQ-FAD1RE.lf [NUCLEO-F401RE] See Maintab o true o true
[[] NUCLEO-F401RE (SEGGER)

Load Image and Symbols

Remove
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Runtime Options
Start Address
(®) Default start address
() Set program counter (hex):

(@) Specify vector table (hex):

Set breakpoint at:
Exception on divide by zero

[[] Exception on unaligned access
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Resume
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@ Debug__|

Close
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3.8 Import STM32 Cortex®-M executable

Use menu [File]>[Import...] to open the Import dialog.

Figure 165. Cortex®-M executable import dialog

m Import O et

Select Iﬁ

Imports an externally built STM32 Cortex-M executable into a new project and configures the debugger.

Select an import wizard:

type filter text

* = General
v =C/C++
] C/C++ Executable
& C/C++ Project Settings
Existing Code as Makefile Project
[ STM32 Cortex-M Executable
> = Install
» = Remote Systems
> = Run/Debug
> = Team

@ < Back Next > Finish Cancel
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Select [STM32 Cortex-M Executable] and press [Next >].

Figure 166. STM32 Cortex®-M executable dialog

m STM32 Cortex-M Executable O X

Select executable to debug and configure a matching STM32 device.

Executable: ‘ C\dev\STM32F401_Nucleo_ExtBuilt.elf ‘ ‘ Browse... ‘

STM32 device

MCU: || | select..|
CPU: \ " ‘
Core: ‘ ™ ‘
@ < Back Next > Finish Cancel

Use the [Browse...] button and select the e1 £ file to import. When the e1f file is selected, the STM32 device
must be selected manually so that STM32CubelDE can be used for debugging.

Press [Select...] to open the MCU/MPU Selector dialog.

Figure 167. STM32 Cortex®-M executable MCU/MPU selection

[l MCU/MPU Selector O X

Please select your STM32 target device

401

MCU/MPU A
5TM32F401RDTx
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STM32F401VBTx
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@ OK | ‘ Cancel
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Select the microcontroller or microprocessor to be used. The search field can be used to find the device. Press
[OK] once the device is selected.

As a result, the CPU and core are presented in the dialog.

Figure 168. STM32 Cortex®-M CPU and core

m STM32 Cortex-M Executable

Select executable to debug and configure a matching STM32 device.

Executable: ‘ C\dev\STM32F401_Nucleo_ExtBuilt.elf
STM32 device
MCU: ‘ STM32F401RETx

‘ ‘ Browse... ‘

‘ ‘ Select... |

CPU: Cortex-M4 (0)

v ‘

Core: ‘0
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Press [Finish] and the debug configuration dialog automatically opens.

Figure 169. Cortex®-M debug configuration for imported project

m Edit Configuration

Edit configuration and launch.

Name: | STM32F401_Nudleo_ExtBuilt.elf |

Main‘ g Debugger‘ & Startup“‘i./ Source‘ E Common

Project:
‘ STM32F401_Nucleo_ExtBuilt.elf
C/C++ Application:

Browse... ‘

‘STM32F401_Nuc|e0_E)rtBuiIt.elf ‘ ‘ Search Project... ‘ ‘ Browse... ‘

Build (if required) before launching

Build Configuration: |Use Active

(O Enable auto build (®) Disable auto build

(O Use workspace settings Configure Workspace Settings...

‘ Revert ‘ ‘ Apply ‘

@ | Debug | | Close ‘

The debug configuration can then be set up in similar way as with any other STM32CubelDE project. Once the
configuration is completed, press [Debug] to start a debug session.
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The imported project is displayed in the Project Explorer view.

Figure 170. Project explorer view with imported project
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4 Debug with Serial Wire Viewer tracing (SWV)

4.1 Introduction to SWV and ITM

This section provides information on how to use Serial Wire Viewer tracing (SWV) in STM32CubelDE.

System analysis and real-time tracing in STM32 requires a number of interaction technologies: Serial Wire Viewer
(SWV), Serial Wire Debug (SWD), Instrumentation Trace Macrocell (ITM) and Serial Wire Output (SWO). These

technologies are part of the Arm® CoreSight™ debugger technology. They are explained below.

Serial Wire Debug (SWD) is a debug port similar to JTAG. It provides the same debug capabilities (run, stop on
breakpoints, single-step) but with fewer pins. It replaces the JTAG connector with a 2-pin interface (one clock pin
and one bi-directional data pin). The SWD port alone does not allow real-time tracing.

The Serial Wire Output (SWO) pin can be used in combination with SWD. It is used by the processor to emit
real-time trace data, thus extending the two SWD pins with a third pin. The combination of the two SWD pins and

SWO pin enables Serial Wire Viewer (SWV) real-time tracing in compatible Arm® processors.

Beware that, SWO being just one pin, it is easy to set a configuration that produces more data than the SWO is
able to send.

The Serial Wire Viewer (SWV) is a real-time trace technology that uses the Serial Wire Debug (SWD) port and the
Serial Wire Output (SWO) pin. The Serial Wire Viewer provides advanced system analysis and real-time tracing
without the need to halt the processor to extract the debug information.

Serial Wire Viewer (SWD) provides the following types of target information:

. Event notification on data reading and writing

. Event notification on exception entry and exit

. Event counters

. Timestamp and CPU cycle information, which can be used for program statistical profiling

The Instrumentation Trace Macrocell (ITM) enables applications to write arbitrary data to the SWO pin, which can
be interpreted and visualized in the debugger. For example, ITM can be used to redirect printf () outputto a
SWV console view in the debugger. The standard is to use port 0 for this purpose.

The ITM port has 32 channels. Writing different types of data to different ITM channels allows the debugger to
interpret or visualize the data on various channels differently.

Writing a byte to the ITM port takes only one write cycle, thus taking almost no execution time from the application
logic.

Based on SWV, and ITM trace data, STM32CubelDE can provide advanced debugger capabilities with special
SWV views.

Note: Arm® does not include SWV/ITM in Cortex®-MO or Cortex®-MO+ cores. Therefore, STM32 devices based on
these cores, such as STM32L053 microcontrollers, do not support SWV/ITM.

4.2 SWV debugging

To debug and use the Serial Wire Viewer (SWV) in STM32CubelDE, the JTAG probe and the GDB server must
support SWV. The board must also support SWD, and the SWO pin needs to be available and connected to the
JTAG probe.

The following sections describe the process to create a debug configuration, SWV settings configuration, and how
to use SWV tracing in a debug session.

421 SWV debug configuration

Step 1: Open the Debug Configurations dialog

Use for instance menu [Run]>[Debug Configurations...] and select the STM32 Cortex®-M debug configuration
to update.

Step 2: Select the SWD interface
Select the [SWD] interface in the Debug Configurations dialog.
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Step 3: Enable SWV
Enable [SWV] in the Debug Configurations dialog.

Step 4: Enter the core clock frequency

Enter the [Core Clock] frequency in the Debug Configurations dialog. This must correspond to the value set by
the application program to be executed.

Usually, the core clock setting is stored in the SystemCoreClock variable when using projects imported from
STM32 firmware examples or created with STM32CubeMX. One method to inspect the core clock value is to start
a debug session and add the SystemCoreClock variable to the Expressions view. Make sure that the system
core clock is configured by the application before reading the value.

If the SystemCoreClock is not updated, change the program and add a call to the function
SystemCoreClockUpdate (). Rebuild the program, restart debugging and inspect the SystemCoreClock
value again.

Figure 171. SWV core clock

10¢] o x
& Expressions B3 &=t E|||.{,': N%|rﬁ=l_lﬁ-’" i = O
Expression Type Value

()= SystemCoreClock uint32_t 24000000

o5 Add new expression

Step 5: Enter the SWO clock frequency

The [Serial Wire Viewer (SWV)] selections in the Debug Configurations dialog can be used only when the [SWD]
interface is selected. When [SWV] is enabled, it is required to configure the [Clock Settings]. The [Core Clock]
must be set to the device speed. The SWO clock is automatically set to the highest possible speed depending on
debug probe used and core clock. However, if the debugged hardware does not allow too-high SWO clock speed,
it is possible to enable [Limit SWO clock] and enter the maximum SWO clock speed in kHz. The SWV [Port
number] must be set to the port to be used for SWV data communication. The SWV port cannot be set equal to
the GDB connection [Port number].

Figure 172. SWV debug configuration

Serial Wire Viewer (SWV)
Enable

Core Clock (MHz): 84.0
[ Limit SWO clock
Maximum SWO clock (kHz): | auto detect

Port number: 61235

Step 6: Save the configuration

Press [Apply]in the Debug Configurations dialog to save the configuration.

Step 7: Start a debug session

Press [Debug] to start a debug session. Make sure that the probe and board are connected.
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Step 8: Possibly suspend the target
[Suspend] the target if it has not stopped at a breakpoint.

Step 9: Open a SWV view

Open one of the SWV views. For first-time users, it is recommended to open the SWV Trace log view because it
gives a good overview of incoming SWV packets and how well the tracing is working.

Select the [Window]>[Show View]>[SWV]>[SWV Trace log ] menu command to open the SWV Trace log view.

Figure 173. SWV show view
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Step 10: View the trace log

The SWV Trace log view is now visible.
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Figure 174. SWV Trace log view
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422 SWV settings configuration

Step 1: Open the Serial Wire Viewer settings

Click on the [Configure Trace] toolbar button in the SWV Trace Log view to open the Serial Wire Viewer settings

dialog.
Figure 175. SWV [Configure Trace] toolbar button
il
Note: The [Configure Trace] toolbar button is available in all SWV views.

Step 2: Configure the trace data

Configure the data to be traced in the Serial Wire Viewer settings dialog.
For this example [PC Sampling] and [Timestamps] are enabled.

Figure 176. SWV settings dialog
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The SWV settings dialog has the following configurations:
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. [Clock Settings]: These fields are disabled and only present the values used and configured in the Debug
Configurations for the debug session. If these values need to be changed, close the debug session and
open the Debug Configurations to modify them.

. [Trace Events]: The following events can be traced.

—  [CPI: Cycles per instruction. For each cycle beyond the first one that an instruction uses, an internal
counter is increased with one. The counter (DWT CPI count) can count up to 256 and is then set
to 0. Each time that happens, one of these packets are sent. This is one aspect of the processors
performance and used to calculate instructions per seconds. The lower the value, the better the
performance.

—  [SLEEP]: Sleep cycles. The number of cycles the CPU is in sleep mode. Counted in DWT Sleep
count register. Each time the CPU has been in sleep mode for 256 cycles, one of these packets is
sent. This is used when debugging for power consumption or waiting for external devices.

—  [FOLD]: Folded instructions. A counter for how many instructions are folded (removed). Every 256
instruction folded (taken zero cycles) will receive one of these events. Counted in DWT Fold count
register.

Branch folding is a technique where, on the prediction of most branches, the branch instruction is
completely removed from the instruction stream presented to the execution pipeline. Branch folding
can significantly improve the performance of branches, taking the CPI for branches below 1.

—  [EXC]: Exception overhead. The DWT Exception count register keeps track of the number of
CPU cycles spent in exception overhead. This includes stack operations and returns but not the time
spent processing the exception code. When the timer overflows, one of these events is sent. Used to
calculate the actuel exception handling cost to the program.

—  [LSU]: Load Store Unit Cycles. The DWT LSU count register counts the total number of cycles the
processor is processing an LSU operation beyond the first cycle. When the timer overflows, one of
these events is sent.

With this measurement, it is possible to track the amount of time spent in memory operations.

—  [EXETRC]: Trace Exceptions. Whenever an exception occurs, exception entry, exception exit and
exception return events are sent. These events can be monitored in the SWV Exception Trace Log
view. From this view, it is possible to jump to the exception handler code for that exception.

. [PC Sampling]: Enabling this starts sampling the Program Counter at some cycle interval. Since the SWO
pin has a limited bandwidth, it is not advised to sample to fast. Experiment with the [Resolution] (cycles/
sample setting) to be able to sample often enough. The results from the sampling are used, among other
things, for the SWV Statistical Profiling view.

. [Timestamps]: Must be enabled to know when an event occurred. The [Prescaler] should only be changed
as a last effort to reduce overflow packets.

. [Data Trace]: It is possible to trace up to four different C variable symbols, or fixed numeric areas of the
memory. To do that, enable one comparator and enter the name of the variable or the memory-address to
trace. The value of the traced variables can be displayed both in the Data Trace and Data Trace Timeline
Graph views.

. [ITM Stimulus Ports]: There are 32 ITM ports available, which can be used by the application. For instance,
the CMSIS function ITM SendChar can be used to send characters to port 0 refer to Section 4.3.5 SWV
ITM Data Console and printf redirection). The packets from the ITM ports are displayed in the SWV ITM
Data Console view.

Note: It is recommended to limit the amount of data traced. Most STM32 microcontrollers read and write data faster
than the maximum SWO pin throughput. Too many trace data result in data overflow, lost packets and possibly
corrupt data. For optimum performance, trace only data necessary to the task at hand.

Overflow while running SWV is an indication that SWV is configured to trace more data than the SWO pin is able
to process. In such a case, decrease the amount of data traced.

Enable [Timestamps] to use any of the timeline views in STM32CubelDE. The default [Prescaler] is 1. Keep this
value, unless problems occur related to SWV packet overflow.
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Three examples are provided below for illustrating SWV trace configuration:

. Example 1: To trace the value of a global variable, enable [Comparator] and enter the name of the variable
or the memory address to be traced.

The value of the traced variable is displayed both in the Data Trace and Data Trace Timeline Graph views.

. Example 2: To profile program execution, enable [PC sampling]. In the beginning, a high value for the
[Cycles/sample] is recommended.

The result from the PC sampling is then displayed in the SWV Statistical Profilingview.

. Example 3: To trace the exceptions occurring during program execution, enable [Trace Event EXETRC:
Trace Exceptions].

Information about the exceptions is then displayed in the SWV Exception Trace Log view.

Step 3: Save the SWV configuration

Click on the [OK] button to save the SWV configuration. The configuration is saved together with other debug
configurations and remains effective until changed.

4.2.3 SWV tracing

Step 1: Start SWV trace recoding

Press the [Start/Stop Trace] toolbar button in one of the SWV views to send the SWV settings to the target board
and start the SWV trace recoding. This toolbar button is available in all SWV views. The board does not send any
SWV packet until it is properly configured. The SWV configuration must be resent if the configuration registers on
the target board are reset. Actual tracing does not start until the target starts to execute.

Figure 177. SWV [Start/Stop Trace] toolbar button

Note: The tracing cannot be configured while the target is running. Pause the debugging before attempting to send a
new configuration to the board. Each new or updated configuration must be sent to the board to take effect. The
configuration is sent to the board when the [Start/Stop Trace] button is pressed.

Step 2: Start the target

Press the [Resume] toolbar button on top of the Debug perspective to start the target.

Step 3: SWV Trace Log view
SWV packets are displayed in the SWV Trace Log view.

Figure 178. SWV Trace Log PC sampling

10€] I
E SWV Trace Log HeX[pio O
Index Type Data Cycles Time(s) Extra info ~

10362 PC Sample  0x8000508 169777034 2.021155s
10363 PC Sample 0x8000516 169793417 2021350 s
10364 PCSample 0x8000528 169809800 2.021545 s
10365 PC Sample 0x8000500 169826183 2.021740 s
10366 PC Sample 0x8000510 169842566 2.021935s
10367 PCSample 0x80004f2 169858949 2.022130s
10368 PC Sample  0x8000504 169875332 2.022325s
10369 PC Sample 0x8000516 169891715 2.022520 s
10370 PC Sample 0x8000528 169908098 2.022715s

Overflow packets: 0
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Step 4: Clear collected SWV data

When the target is not running, the collected SWV data can be cleared by pressing the [Remove all collected
SWV data] toolbar button. This toolbar button is available in all SWV views.

Figure 179. [Remove all collected SWV data] toolbar button

A

4.3 SWV views
The SWV views that display SWV traces data are:

. SWV Trace Log: Lists all incoming SWV packets in a spreadsheet. Useful as a first diagnostic for the trace
quality.

. SWV Exception Trace Log: The view has two tabs, one is similar to the SWV Trace Log view and the other
tab displays statistical information about exception events.

. SWV Data Trace: Tracks up to four different symbols or areas in the memory.

. SWV Data Trace Timeline Graph: A graphical display that shows the distribution of variable values over
time.

. SWV ITM Data Console: Prints readable text output from the target application. Typically this is done via
printf () with output redirected to ITM channel 0.

. SWV Statistical Profiling: Displays statistics based on the Program Counter (PC) sampling. Shows the
amount of execution time spent within various functions.

Figure 180. SWV views selectable from the menu

SWV Trace log

SWV Exception Trace log

SWV Data Trace

SWV Data Trace Timeline Graph
SWV ITM Data Console

SWV Statistical Profiling

]

HmEE »

Note: More than one SWV view may be open at the same time for the simultaneous tracking of various events.
The SWV views toolbars contain these usual control icons.

Figure 181. SVW views common toolbar

KOX|EE= O

These icons are used for the following purpose, from left to right:
. Configure trace

. Start/Stop trace

. Remove all collected SWV data

. Scroll lock

. Minimize

. Maximize
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The SWV graph views toolbars contain these extra control icons.

Figure 182. SVW graph views extra toolbar

@i O il = =

These icons are used for the following purpose, from left to right:
. Save graph as image

. Switch between seconds and cycle scale

. Adjust the Y-axis to best fit

. Zoom in

. Zoom out

4.31 SWYV Trace Log

The SWV Trace Log view lists all incoming SWV packets in a spreadsheet. The data in this view can be copied to
other applications in CSV format by selecting the rows to copy and type Ctrl+C. The copied data can be pasted
into another application with the Ctrl+V command.

Figure 183. SWV Trace Log PC sampling and exceptions

10 O X
= SWV Trace Log Ki®x|an - o
Index Type Data Cycles Time(s) Extra info ~
25012 PC Sample 0x80004f6 258481871 3.077165s
25013 PC Sample 0x8000508 258498254 3.077360 s
25014 PC Sample 0x8000518 258514637 3.077555s

25015 Exception entry SYSTICK (EXC 15) 258522309 3.077647 s
25016 Exception exit SYSTICK (EXC 15) 258522367 3.077647 s

25017 Exception return N/A (EXC0) 258522374 3.077647 s
25018 PC Sample 0xB80004fc 258531017 3.077750 s
25019 PC Sample 0x800050e 258547400 3.077945s
25020 PC Sample 0x800051e 258563783 3.078140 s v
2EN21 D Camnla NuaNnNNAfA AEQCANTAAR 2 NT7RAIE

Overflow packets: 0

The column information in the SWV Trace Log view is described in Table 6.

Table 6. SWV Trace Log columns details

I

Index The packet ID. Shared with the other SWV packets.

Type The type of packet (example PC sample, data PC value (comp 1), exceptions, overflow).
Data The packet data information.

Cycles The timestamp of the packet in cycles.

Time(s) The timestamp of the packet in seconds.

Extra info Optional extra packet information.

4.3.2 SWYV Exception Trace Log
The SWV Exception Trace Log view is composed of two tabs.
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UM2609 - Rev 6

Data tab

The first tab is similar to the SWV Trace Log view, but is restricted to exception events. It also provides additional
information about the type of event. The data can be copied and pasted into other applications. Each row is
linked to the code for the corresponding exception handler. Double-click on the event to open the corresponding
interrupt hander source code in the Editor view.

Enable [Trace Event EXETRC: Trace Exceptions] in the Serial Wire Viewer settings dialog to trace exceptions
during program execution. Enable [Timestamps] to log cycle and time for each interrupt packet.

Figure 184. SWV Exception Trace Log — Data tab

@ o x
E SWV Exception Trace Log H@X[eE"
Data  Statistics

Index Type Name Peripheral  Function Cycles Time(s) Extra info 2
17629  Exception exit SYSTICK (EXC 15) SysTick_Handler() 58204401 692.909536 ms

17630  Exception return N/A (EXC 0) 58205926 692927690 ms Timestamp delayed. Packet delayed.

17636 Exception entry SYSTICK (EXC 15) SysTick_Handler() 58288335 693.908750 ms

17637  Exception exit SYSTICK (EXC 15) SysTick_Handler() 58288393  693.909440 ms

17638 Exception return N/A (EXC 0) 58288400 693.909524 ms

17644  Exception entry SYSTICK (EXC 15) SysTick_Handler() 58372327 694908655 ms

17645  Exception exit SYSTICK (EXC 15) SysTick_Handler() 58372385 694909345 ms

17646 Exception return N/A (EXC 0) 58372392 694909429 ms

Overflow packets: 0

The column information in the SWV Exception Trace Log — Data tab is described in Table 7.

Table 7. SWV Exception Trace Log — Data columns details

Come | i

Index The exception packet ID. Shared with the other SWV packets.
Type Each exception generates three packets: Exception entry, Exception exit and then an Exception return packet.
Name The name of the exception. Also the exception or interrupt number.

Peripheral The peripheral for the exception.

The name of the interrupt handler function for this interrupt. Updated when debug is paused. Is cached during the

Function whole debug session. By double clicking the function, the editor will open that function in the source code.

Cycles The timestamp for the exception in cycles.
Time(s) The timestamp for the exception in seconds.

Extra info = Optional extra information about that packet.

Statistics tab

The second tab displays statistical information about exception events. This information may be of great value
when optimizing the code. Hypertext links to exception handler source code in the editor is included.

Figure 185. SWV Exception Trace Log — Statistics tab

¢ [mN
= SWV Exception Trace Log KO
Data Statistics

Exception Handler % of Number of % of excepti.. % of debug time Total runtime  Avg runtime  Fastest Slowest  First First (s) Latest Latest (s)

SYSTICK (EXC 15) SysTick_Handler() ~ 100.0000% 2172 100.0000% 0.0690% 40309 57 57 58 71567 851.988095 us 58372327 694.908655 ms

Total for all 2172 0.0690% 40309 18

Qverflow packets: 0
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The column information in the SWV Exception Trace Log — Statistics tab is described in Table 8.

Table 8. SWV Exception Trace Log — Statistics columns details

e [ EmEw ]

Exception The name of the exception provided by the manufacturer. Also the exception or interrupt number.

The name of the interrupt handler for this interrupt. Updated when debug is paused. Is cached during the
Handler whole debug session.

By double clicking the handler, the editor will open that function in the source code.
% of This exception type’s share, in percentage, of all exceptions.
Number of The total number of entry packets received by SWV of this exception type.
% of exception time = How big part of the execution time for all exceptions that this exception type have.

How big part of the total execution time for this debug session that this exception type have. All the

o )
% of debug time timers are restarted when the Empty SWV-Data button is pressed.

Total runtime The total execution time in cycles for this exception type.

Avg runtime The average execution time in cycles for this exception type.

Fastest The execution time in cycles for the fastest exception of this exception type.

Slowest The execution time in cycles for the slowest exception of this exception type.

First The first encounter of an entry event for this exception type in cycles.

First(s) The first encounter of an entry event for this exception type in seconds.

Latest The latest encounter of an entry event for this exception type in cycles.

Latest(s) The latest encounter of an entry event for this exception type in seconds.
4.3.3 SWYV Data Trace

The SWV Data Trace view tracks up to four different symbols or areas in the memory. For example, global
variables can be referenced by name. The data can be traced on Read, Write and Read/Write.

Enable [Data Trace] in Serial Wire Viewer settings. In Figure 186, two global variables pos1 and pos2 in the
program are traced on [Write] access.
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Figure 186. SWV Data Trace configuration
ESeriaI Wire Viewer settings for NUCLEO-F401RE Debug (ST-LINK) X

Trace Events
MHz [ CPI: Cycles per instruction [_] EXC: Exception overhead
[C1SLEEP: Sleep cycles ] LSU: Load store unit cycles
[]FOLD: Folded instructions [_] EXETRC: Trace Exceptions

Clock Settings

Core Clock: 84
Clock Prescaler: 42
SWO Clock: 2000.0 kHz

PC Sampling
nable Resolution: - ycles/sample
[“]Enable Resolution: 16384  Cycles/: I

Timestamps
[V Enable Prescaler: 1 v

Data Trace

Comparator 0 Comparator 1 Comparator 2 Comparator 3

Enable M Enable [JEnable [Enable
Var/Addr: ﬁ Var/Addr: pos2 Var/Addr: 0x0 Var/Addr: 0x0
Access: Write v Access: Read N Access: Read/Write Access: Read/Write
Size: Word v Size: Word Size: Word Size: Word

Generate: Data Value + PC Generate: Data Value + PC Generate: Data Value Generate: Data Value

ITM Stimulus Ports

Enable port: 3110000000000 24 2300000000000 16 1sO0O00O00O00O0CC0s 7000000000 o

Privileged only ports: [ ] Port 31.24 [ ] Port 23.16 [_]Port 15.8 [ ]Port 7.0

Cancel

When running the program in debugger with SWV trace enabled the SWV Data Trace view displays this
information when [Comparator 0] with pos1 data is selected in the [Watch] list.

Figure 187. SWV Data Trace

1D O X
“L SWV Data Trace e
Watch

Comp Name Value A
0 pos1 10

1 pos2 0 Vi
History (pos1) _
Access Value PC Cycles Time N
WRITE 8 0x8000578 642414276 7.647789 s

WRITE 1 0x8000578 645655051 7.686370 s

WRITE 2 0x8000578 649164268 7.728146 s

WRITE 3 0x8000578 652673485 7.769922 s

WRITE 4 0x8000578 656182631 7.811698 s

WRITE 5 0x8000578 659691850 7.853474 s

WRITE 6 0x8000578 663004479 7.892910 s

WRITE 7 0x8000578 666513696 7.934687 s

WRITE 9 0x8000578 673532061 8.018239 s

WRITE 10 0x8000578 677041280 8.060015 s v
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The column information in the SWV Data Trace described in Table 9.

Table 9. SWV Data Trace columns details

e e ]

Access Read or Write access type.

Value The value of data read or written.

PC The PC location where read or write access occurs.
Cycles The timestamp for the packet in cycles.

Time(s) The timestamp for the packet in seconds.

434 SWYV Data Trace Timeline Graph
The SWV Data Trace Timeline Graph view contains a graphical display that shows the distribution of variable
values over time. It applies to the variables or memory areas in the SWV Data Trace. The following is displayed
when using the timeline graph displaying global variables pos1 and pos2 counting up and down.
Figure 188. SWV Data Trace Timeline Graph
10E O X
- SWV Data Trace Timeline Graph WO AL @K™ O
— posl — pos2
™ | | |
N | M|
| |
N | |
1 14 A
| Al 1 |
) o ] | ]
H i
Iﬂl 0 _l T T T T ‘ T | T T T T T T T T T T T
0 05 1 15 2 2.5 3 35 4 45 5 5.5 6 65 7 75 8
The SWV Data Trace Timeline Graph has the following features:
. The graph can be saved as a JPEG image file by clicking on the camera toolbar button.
. The graph shows the time in seconds by default but can be changed to cycles by clicking on the clock
toolbar button.
. Y-axis can be adjusted to best fit by clicking on the y-axis toolbar button.
. Zoom in and out by clicking on the [+] and [-] toolbar buttons.
. The zoom range is limited while debug is running. Zoom details are available when debug is paused.
4.3.5 SWV ITM Data Console and printf redirection

The SWV ITM Data Console prints readable text output from the target application. Typically, this is done via
printf () with output redirected to ITM channel 0. Other ITM channels can get their own console views.

To use the SWV ITM Data Console view, first enable one or more of the 32 ITM ports in the Serial Wire Viewer
settings dialog.

UM2609 - Rev 6 page 172/245



‘_ UM2609
,l SWV views

Figure 189. SWV settings

mSeriaI Wire Viewer settings for NUCLEO-F401RE Debug (ST-LINK) X
Clock Settings Trace Events PC Sampling
Core Clock: 84 MHz [_]CPI: Cycles per instruction [_] EXC: Exception overhead []Enable Resolution: 16384 Cycles/sample
Clock Prescaler: 42 [C1SLEEP: Sleep cycles ] LSU: Load store unit cycles T
q q 3 tamps
. []FOLD: Folded instructions [_] EXETRC: Trace Exceptions fmes
SWO Clock: 2000.0 kHz FEnabielpresczier B o
Data Trace
Comparator 0 Comparator 1 Comparator 2 Comparator 3
[JEnable [JEnable [JEnable [Enable
Var/Addr: pos1 Var/Addr: pos2 Var/Addr: 0x0 Var/Addr: 0x0
Access: Write Access: Write Access: Read/Write Access: Read/Write
Size: Word Size: Word Size: Word Size: Word
Generate: Data Value + PC Generate: Data Value + PC Generate: Data Value Generate: Data Value
ITM Stimulus Ports
Enable port: 31 LI 24 23O e s s 7O o

Privileged only ports: [ ] Port 31.24 [ ] Port 23.16 [_]Port 15.8 [ ]Port 7.0

Cancel

The packets from the ITM ports are displayed in the SWV ITM Data Console view. The CMSIS function
ITM SendChar () can be used by the application to send characters to the port 0, and the print £() function

can be redirected to use the ITM SendChar () function.

The following describes how to setup printf redirection over ITM:

1. Configure first file syscalls.c. Usually, the syscalls.c file is located in the same source folder as main
.C.
If no syscalls.c file is available in the project, it can be copied from another STM32CubelDE project. One
way to get the file is to create a new STM32 empty project for the device. In the src folder, this project
contains a syscall.c file. Copy this file to a source folder in the project where it is needed.

2. Inside the syscalls.c file, replace the write () function with code calling ITM SendChar () instead of
1o putchar()

int _write(int file, char *ptr, int len)

{
int DatalIdx;

for (DatalIdx = 0; Dataldx < len; Dataldx++)

{
//__io putchar (*ptr++);
ITM_SendChar (*ptr++) ;

}

return len;

}

3. Locate the core cmX.h file, which contains the function ITM SendChar (). The core cmX.h file is
included by the Device Peripheral Access Layer header file (for instance stm32f4xx.h, which in turn must
be included in the syscalls.c file).

#include "stm32fdxx.h"

Use the Include Browser view to find the Device Peripheral Access Layer header file. Drop the core file in
the Include Browser view, and check which files are including the core cmX.h file.
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4. Test by adding include stdio.h and call to printf () into the application. Make sure that printf () is not
called too often.

#include <stdio.h>
printf ("Hello World %d\n", posl);

5.  Start a debug session and enable [ITM port 0] in the SWV ITM Data Console view.

6. Openthe SWV ITM Data Console view and start tracing using the red [Start/Stop Trace] button on the
toolbar in this view.

7.  Start the program. Print commands are logged to the Port 0 tab in the view.

Figure 190. SWV ITM Data Console

10E | X

© SWV ITM Data Console * K @X|Luih+ O

Port 0

Hello World
Hello World
Hello World
Hello World
Hello World
Hello World
Hello World
Hello World
Hello World
Hello World

W oo~ O bW

=
®

8. ltis possible to open new port x tabs (x from 1 to 31) by pressing the green [+] button on the toolbar. This
opens the Add Port dialog. In the dialog select the [ITM Port number] to be opened to display it as a tab in
the SWV ITM Data Consoleview.

Figure 191. SWV ITM port configuration

[CH Add Port

ITM Port number (0}:

OK ‘ Cancel
Note: Study the ITM SendChar () function to learn how to write a function that transmits characters to another ITM
port channel.
4.3.6 SWVYV Statistical Profiling

TheSWV Statistical Profiling view displays statistics based on Program Counter (PC) sampling. It shows the
amount of execution time spent within various functions. This is useful when optimizing code. The data can be
copied and pasted into other applications. The view is updated when debugging is suspended.
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1. Configure SWV to send Program Counter samples, as shown in Figure 192. Enable [PC Sampling] and
[Timestamps].
With the given [Core Clock] cycle intervals, SWV reports the Program Counter values to STM32CubelDE.
Set the [PC Sampling] to a high [Cycle/sample] value to avoid interface overflow.

Figure 192. SWV PC sampling enable

mSeriaI Wire Viewer settings for NUCLEO-F401RE Debug (ST-LINK) X
Clock Settings Trace Events PC Sampling
Core Clock: 84 MHz [ CPI: Cycles per instruction [_] EXC: Exception overhead Enable Resolution: 16384 ~ Cycles/sample
Clock Prescaler: 42 [C1SLEEP: Sleep cycles ] LSU: Load store unit cycles =
c q . tamps
. [CJFOLD: Folded instructions [_] EXETRC: Trace Exceptions 'mes
SNl 2010l [ Enable Prescaler: 1 v
Data Trace
Comparator 0 Comparator 1 Comparator 2 Comparator 3
[Enable [JEnable [JEenable [JEenable
Var/Addr: pos1 Var/Addr: pos2 Var/Addr: 0x0 Var/Addr: 0x0
Access: Write Access: Write Access: Read/Write Access: Read/Write
Size: Word Size: Word Size: Word Size: Word
Generate: Data Value + PC Generate: Data Value + PC Generate: Data Value Generate: Data Value
ITM Stimulus Ports
Enable port: 31O ]24 23 ]I e 1s IO s 7O o
Privileged only ports: [_] Port 31..24 [ ] Port 23..16 [_]Port 15..8 [ ]Port 7.0
Cancel

2. Open the SWV Statistical Profiling view by selecting [Window]>[Show View]>[SWV Statistical Profiling].
The view is empty since no data is collected yet.

3. Press the red [Start/Stop Trace] button to send the configuration to the board.

4. Resume program debugging. STM32CubelDE starts collecting statistics about function usage via SWV
when the code is executing in the target system.

5. Suspend (Pause) the debugging. The view displays the collected data. The longer the debugging session,
the more statistics are collected.
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Figure 193. SWV Statistical Profiling

1DE O X
F9 SWV Statistical Profiling KX~ O
Function % in use Samples Start addr... Size

main() 59.06% 48575 0x80005bd 0x100

readSpeed() 24.82% 20413 0x80004d5 Ox46

readTemp() 16.04% 13191 0x800051b Ox2e

HAL_IncTick() 0.07% 56 0x8000b1d 0x34

SysTick_Handler() 0.01% 8 0x80009e5 0Oxc

writeSpeed() 0.00% 1 0x8000549 0Ox46

Overflow packets: 0 PC Samples: 82244

Note: A double-click on a function line in the SWV Statistical Profiling view opens the file containing the function in the

editor.
The column information in the SWV Statistical Profiling is described in Table 10.

Table 10. SWV Statistical Profiling columns details

I T

The name of the function which is calculated by comparing address information in SWV packets with the

Function program e1 £ file symbol information.
% in use The calculated percentage of time the function is used.
Samples The number of samples received from the function.

Start address ' The start address for the function.

Size The size of the function.

4.4 Change the SWV trace buffer size

The incoming SWV packets are saved in the Serial Wire Viewer trace buffer, which has a default maximum size of
2 000 000 packets. To trace more packets, this figure must be increased.
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Select the [Windows]>[Preferences] menu. In the Preferences dialog, select [STM32Cube]>[Serial Wire
Viewer]. Update [Trace buffer size] if needed.

Figure 194. SWV Preferences

[l Preferences O X

type filter text Serial Wire Viewer Sy
> General
C/C++
Help
Install/Update
Remote Development
Remote Systems
Run/Debug
v STM32Cube
Build
Device Configuration Tool
File Association
Firmware Updater
Serial Wire Viewer

Serial Wire Viewer
Trace buffer size: 2000000

v VvV VvV VvV VvV VvV

Target Status
> Team
Terminal
Restore Defaults Apply
@ e | Apply and Close | Cancel

The buffer is stored in the heap. The allocated heap is displayed by first selecting the [Windows]>[Preferences]
menu. In the Preferences dialog, select [General]. Enable [Show heap status] to display the current heap and
allocated memory in the bottom right corner of STM32CubelDE. There is an upper limit to the amount of memory
STM32CubelDE can allocate. This limit can be increased to store more information during a debug session.

To update the memory limit, proceed as follows:

1. Navigate to the STM32CubelDE installation directory. Open the folder in which the IDE is stored.

2. Editthe stm32cubeide.ini file and change the —xXmx1024m parameter to the desired size in megabytes.
3. Save the file and restart STM32CubelDE.

4.5 Common SWV problems
The following issues can occur when attempting to debut with SWV tracing:
. SWV is not enabled in the debug configuration currently used.

. The SWV Trace is not started, the red Start/Stop Trace button on the toolbar in some SWV view needs
to be pressed to enable SWV and send SWV configuration to the target board. Then start the program to
receive SWV data. For some SWV views the program then needs to be stopped again to visualize received
SWV information.

. The SWO receives an excess of data. Reduce the amount of data enabled for tracing.
. The JTAG probe, the GDB server, the target board, or possibly some other part, does not support SWV.
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. The target [Core Clock] is incorrectly set. It is very important to select the right [Core Clock].

If the frequency of the target [Core Clock] is unknown, it can sometimes be found by setting a breakpoint in
a program loop and open the Expressions view, when the breakpoint is hit.

Click on [Add new expression], type SystemCoreClock and press [Enter]. This is a global variable that,
according to the CMSIS standard, must be set by the software to the correct speed of the [Core Clock].

In CMSIS standard libraries, a function called SystemCoreClockUpdate () can be included in main () to
set the SystemCoreClock variable. Use the Variable view to track it.
Note: If the software dynamically changes the CPU clock speed during runtime, this might cause SWV to stop as the
clocking suddenly becomes wrong during execution.
To make sure that all data is received, apply the following steps:

1. Open the SWV configuration. Disable all tracing except [PC Sampling] and [Timestamps]. Set the
[Resolution] to the highest possible value.

2. Save, and open the SWV Trace Log view.
Start tracing.
4.  Make sure that incoming packets can all be seen in the SWV Trace Log view.

w
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5 Special Function Registers (SFRs)

5.1 Introduction to SFRs

Special Function Registers (SFRs) can be viewed, accessed and edited via the SFRs view. The view displays the
information for the current project. Its content changes if another project is selected. To open the view from the

menu, select the [Window]>[Show View]>[SFRs] menu command or use the [Quick Access] field, search for
“SFR”, and select it from the views.

Figure 195. Open the SFRs view using the [Quick Access] field

SFR] v
Views & SFRs (Debug)
Commands ® Show In (SFRs)
@ Show View (SFRs) - Shows a particular view
Help < Search 'SFR' in Help
5.2 Using the SFRs view

The SFRs view contains information about peripherals, registers and bit fields for the STM32 device used in
the project. When debugging the project, the registers and bit fields are populated with the values read from
the target. The view contains two main nodes, the Cortex®-M node and the STM32 node. The Cortex®-M

node includes common Cortex®-M core information and the STM32 node includes the STM32 device specific
peripherals.
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Figure 196. SFRs view
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The top of the SFRs view contains a search field to filter visible nodes, such as peripherals, registers, bit fields.
Upon text entry in the search field, only the nodes containing this text are displayed.

The information at the bottom of the SFRs view displays detailed information about the selected line. For registers
and bit fields, this includes [Access permission] and [Read action] information.

The [Access permission] contains the following details:

[RO](read-only)
[WO](write-only)
[RW](read-write)
[W1](writeOnce)
[RW1](read-writeOnce)

The Read action contains information only if there is a read action when reading the register or bit field:

[clear]

[set]

[modify]
[modifyExternal]
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The toolbar buttons are located at the top-right corner of the SFRs view.

Figure 197. SFRs view toolbar buttons

RD‘“m“m Hz‘%‘_ﬂ'v” =

The [RD] button in the toolbar is used to force a read of the selected register. It causes a read of the register even
if the register, or some of the bit fields in the register, contains a ReadAction attribute set in the svD file.

When the register is read by pressing the [RD] button, all the other registers visible in the view are read again also
to reflect all register updates.

The program must be stopped to read registers.
The base format buttons ([X16], [X10], [X2]) are used to change the registers display base.
The [Configure SVD settings] button opens the CMSIS-SVD Settings Properties Panel for the current project.

The [Pin] button ("don’t follow" selection) can be used to keep focus on the current displayed svD file even if the
Project Explorer view is switched to another project.

5.3 Updating CMSIS-SVD settings
The SFRs view for a project can display two CMSIS-SVD (System View Description) files for this project:
. The default file selected by STM32CubelDE is the SVD file for the selected device in the project
. The other file can be a custom SVD file made to visualize specific user hardware configuration

To update the settings, use the [Configure SVD settings] toolbar button in the SFRs view to open the CMSIS-
SVD Settings properties.

Figure 198. SFRs CMSIS-SVD Settings

E Properties for NUCLEO-F401RE O X

\ CMSIS-SVD Settings M
> Resource

X CMSIS SVD (System View Description) Data Files
> C/C++ Build

> C/C++ General Device file ' platform:/plugin/com.st.stm32cube.ide.mcu.productdb.debug/resources/cmsis/STMicroelectronics_CMSIS_SVD/STM32F401.svd Browse...
CMSIS-SVD Settings G il
Project References ustom file Browse...
Run/Debug Settings
Restore Defaults Apply
@ Apply and Close Cancel

All SVD files must comply with the syntax outlined in the CMSIS-SVD specification available on Arm® website. If
these requirements are not met, the SFRs view is likely not to show any register information.

The [Device file] field is used for the System View Description (SVD) file. This file must describe the whole
device. Other views may fetch information from the SVD file pointed out by this field, therefore it is recommended
to use this field only for SVD files containing full STM32 device description. Updated SVD files can be obtained
from STMicroelectronics (refer to the HW Model, CAD Libraries and SVD columns in the device description
section on the STMicroelectronics website at www.st.com.

The [Custom file] field can be used to define special function registers related to custom hardware, in order to
simplify the viewing of different register states. Another possible use case is to create an SFR favourites’ file,
containing a subset of the content in the [Device file]. This subset may be for instance composed of frequently
checked registers. If a [Custom file] is pointed out, a new top-node in the SFRs view is created, which contains
the [Custom file] related register information.

Both fields may be changed by the user and both fields may be used at the same time.
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Note: . It is possible to write new values in the value columns of registers and bit fields when these have write
access permission.

. It is possible to use the SFRs view while the target is running when using the ST-LINK GDB server.
However the [Live expression] option in the debug configuration must be enabled in this case.

. It is not possible to use SFRs view while the target is running when using OpenOCD or SEGGER J-Link.

. The SFRs view can also be useful in the C/C++ Editing perspective, however then only the names and
addresses of the registers are displayed.
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6 RTOS-aware debugging

Real-time operating systems (RTOS) add different kinds of objects to the design such as threads, semaphores,
and timers. STM32CubelDE includes dedicated set of views to handle Microsoft® Azure® RTOS ThreadX and
FreeRTOS™ kernel objects.

These views visualize the status of the RTOS objects when stepping through the code or when the program hits a
breakpoint during a debug session.

Note: FreeRTOS is a trademark of Amazon in the United States and/or other countries.
All other trademarks are the property of their respective owners.

6.1 Azure® RTOS ThreadX

The following views are available for ThreadX:
. ThreadX Thread List

. ThreadX Semaphores

. ThreadX Mutexes

. ThreadX Message Queues

. ThreadX Event Flags

. ThreadX Timers

. ThreadX Memory Block Pools

. ThreadX Memory Byte Pools

6.1.1 Finding the views

In the Debugger perspective, the ThreadX-related views are opened from the menu. Select the menu command
[Window]>[Show View]>[ThreadX]>[...] or use [Quick Access] and search for “ThreadX” and select it from the

views.
Figure 199. ThreadX views selectable from the menu
Window Help
Mew Window 0'%'@9' R TR =R R = '|H|ﬂ
Editor > Q | B
Appearance ’  time_gete 51 = O =V i ®%B fE R = 0
Show View > g2 ThreadX > &8 ThreadX Thread List
Perspective > & FreeRTOS > &2 ThreadX Semaphores
Navigation , B swv &2 ThreadX Mutexes
B Breakpoints Alt+Shift+0, B &%  ThreadX Message Queues
| Preferences miy  Build Analyzer &2  ThreadX Event Flags
E Console Alt+Shift+C, C .ﬁ ThreadX Timers
: %3 Debug &2  ThreadX Memory Block Pools
_timer_system_clock Gl Debugger Console &%  ThreadX Memory Byte Pools
6.1.2 ThreadX Thread List view

The ThreadX Thread List view displays detailed information regarding all available threads in the target system.
The thread list is updated automatically each time the target execution is suspended.
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There is one column for each type of thread parameter, and one row for each thread. If the value of any
parameter for a thread has changed since the last time the debugger was suspended, the corresponding row is
highlighted in yellow.

Figure 200. ThreadX Thread List view (default)

= o =
32 Theead Thesad List 22 ==
e Priceity  State Fuan Coet Stack Start Stack End Stack Size Stack Pir Stack Usage
Bain Thread 3 SUSPEMNDED (MySemaphore 1) 1 24001634 (24001233 iz Ou28001Bec Disabled
Sysbemn Timer Thread o SUSPENDED 0 2400018 2400017 1 (x24000dcc Disabled
Thread One 0 SUSPENDED (MyMutes_1) 1 D2400183¢ [=24001a3b 512 2400184 Disabled
=+  Thread Two '] RUNNING 1 Oi4007044 (24001243 g (n2a00ble Disabled
e

Due to performance reasons, the Stack Usage column is disabled by default. To enable the stack analysis, use
the [Toggle Stack Checking] toolbar button (circled in pink in Figure 201) in the ThreadX Thread List view
toolbar.

Figure 201. ThreadX Thread List view (Stack Usage enabled)

i0g| X
(1 ThreadX Thread List 2 8

MName Priority  State Run Count Stack Start Stack End Stack Size Stack Ptr Stack Usage

Main Thread 5 SUSPENDED (Event Flag) 2 024001524 0x240017a3 512 (24001614 512

System Timer Thread 0 SUSPENDED 505 (224000984 0x24000d83 1024 (x24000cdc 1024

Thread One 10 READY 381 x240017ac 0x240019ab. 512 024001824 512
=+ Thread Two 8 RUNNING 126 (240019b4 0x24001bb3 512 0x24001b0c 512

Idle
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The column information in the ThreadX Thread List view is described in Table 11.

Table 11. ThreadX Thread List details

I

N/A A green arrow symbol indicates the currently running thread.
Name The name assigned to the thread.

Priority The thread priority.

State The current state of the thread.

Run Count The threads run counter.

Stack Start The start address of the stack area.

Stack End The end address of the stack area.

Stack Size The size of the stack area (bytes).

Stack Ptr The address of the stack pointer.

The maximum thread stack (bytes).

Stack Usage By default, ThreadX fills every byte of thread stacks with a OxEF data pattern during thread
creation. See the note below for more information.

Note: If the Stack Usage column contains the same values as the Stack Size column for all threads, the reason could
be that the thread stack has not been filled with the 0xEF data pattern during task creation. This happens
if the ThreadX kernel is built with stack data pattern filling disabled. Normally, a <tx user.h> file is used,
which contains a TX DISABLE STACK FILLING define. Comment this define as shown in the example below
and rebuild the project to solve the problem. It is good to know that the <tx user.h> file also contains a
TX ENABLE STACK CHECKING define, which can be enabled to get run-time stack checking if stack corruption
is detected. Additional information can be found in the ThreadX user guide.

Example of tx user.h file from ThreadX header file with commented TX ENABLE STACK CHECKING define:

/* Determine is stack filling is enabled. By default, ThreadX stack filling is enabled,
which places an OxEF pattern in each byte of each thread's stack. This is used by
debuggers with ThreadX-aw:areness and by the ThreadX run-time stack checking feature. */

/* #define TX DISABLE STACK FILLING */

/* Determine whether or not stack checking is enabled. By default, ThreadX stack checking is
disabled. When the following is defined, ThreadX thread stack checking is enabled. If
stack
checking is enabled (TX ENABLE STACK CHECKING is defined), the TX DISABLE STACK FILLING
define is negated, thereby forcing the stack fill which is necessary for the stack
checking
logic. */

/*#define TX ENABLE STACK CHECKING*/

6.1.3 ThreadX Semaphores view

The ThreadX Semaphores view displays detailed information regarding all available resource semaphores in the
target system. The view is updated automatically each time the target execution is suspended.
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There is one column for each type of semaphore parameter, and one row for each semaphore. If the value of
any parameter for a particular semaphore has changed since the last time the debugger was suspended, the
corresponding row is highlighted in yellow.

Figure 202. ThreadX Semaphores view

10| o X

1f® ThreadX Semaphores 53 = B
Marme Count Suspended

MySemaphore_1 0 Main Thread

MySemaphore_2 5

MySemaphore_3 a

Table 12. ThreadX Semaphores details

I

Name The name assigned to the semaphore.

Count The current semaphore count.

Suspended The threads currently suspended because of the semaphore state.
6.1.4 ThreadX Mutexes view

The ThreadX Mutexes view displays detailed information regarding all available mutexes in the target system.
The view is updated automatically each time the target execution is suspended.

There is one column for each type of mutex parameter, and one row for each mutex. If the value of any parameter
for a particular mutex has changed since the last time the debugger was suspended, the corresponding row is
highlighted in yellow.

Figure 203. ThreadX Mutexes view

10€ | O X
of® ThreadX Mutexes 53 = 0
Mame Owner Owner Count Suspended

MyMute 1 Main Thread 1 Thread One Thread Two

MyMutex_2 0

MyMutex_3 0

Table 13. ThreadX Mutexes details

I

Name The name assigned to the mutex.

Owner The thread that currently owns the mutex.

Owner Count The mutex owner count (number of get operations performed by the owner thread).
Suspended The threads currently suspended because of the mutex state.
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6.1.5 ThreadX Message Queues view

The ThreadX Message Queues view displays detailed information regarding all available message queues in the
target system. The view is updated automatically each time the target execution is suspended.

There is one column for each type of message queue parameter, and one row for each message queue. If
the value of any parameter for a particular message queue has changed since the last time the debugger was
suspended, the corresponding row is highlighted in yellow.

Figure 204. ThreadX Message Queues view

10€} O Pe
0 ThreadX Message Queues 538 = O
Marme Address Capacity Used Free Message size Suspended

Message Queue One (24000208 10 0 10 1

Message Queue Two (re2400003c 10 0 10 1

Table 14. ThreadX Message Queues details

I

Name The name assigned to the message queue.

Address The address of the message queue.

Capacity The maximum number of entries allowed in the queue.

Used The current number of used entries in the queue.

Free The current number of free entries in the queue.

Message size The size (in 32-bit words) of each message entry.

Suspended The threads currently suspended because of the message queue state.
6.1.6 ThreadX Event Flags view

The ThreadX Event Flags view displays detailed information regarding all available event flag groups in the target
system. The view is updated automatically each time the target execution is suspended.
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There is one column for each type of parameter, and one row for each event flag group. If the value of any
parameter for a particular event flag group has changed since the last time the debugger was suspended, the
corresponding row is highlighted in yellow.

Figure 205. ThreadX Event Flags view

10 O X

0f# ThreadX Event Flags &2 = H
Mame Flags Suspended

Event Flagl 0 Main Thread

Event Flagd 0

Table 15. ThreadX Event Flags details

I

Name The name assigned to the event flag group.

Flags The current value of the event flag group.

Suspended The threads currently suspended because of the event flag group.
6.1.7 ThreadX Timers view

The ThreadX Timers view displays detailed information regarding all available software timers in the target
system. The timers view is updated automatically each time the target execution is suspended.

There is one column for each type of timer parameter, and one row for each timer. If the value of any parameter
for a particular timer has changed since the last time the debugger was suspended, the corresponding row is
highlighted in yellow.

Figure 206. ThreadX Timers view

10¢] O *
& ThreadX Timers 53 = B
Mame Remaining Re-init Functicn

{ MyTimer_1 6d 100 CeB0005d1 <My TirmerFunctionl=
MyTimer_2 72 200 OxB0005f3 <MyTimerFunction2=

My Timer_3 276 500 OxB3000615 <MyTimerFunction3>

Table 16. ThreadX Timers details

I

Name The name assigned to the timer.

Remaining The remaining number of ticks before the timer expires.

Re-init The timer re-initialization value (ticks) after expiration. It contains value 0 for one-shot timers.
Function The address and name of the function that is called when the timer expires.
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6.1.8 ThreadX Memory Block Pools view

The ThreadX Memory Block Pools view displays detailed information regarding all available memory block pools
in the target system. The view is updated automatically each time the target execution is suspended.

There is one column for each type of parameter, and one row for each memory block pool. If the value of any
parameter for a particular memory block pool has changed since the last time the debugger was suspended, the
corresponding row is highlighted in yellow.

Figure 207. ThreadX Memory Block Pools view

10| O X
1f® ThreadX Memory Block Pools 53 = 0
Mame Address Used Free Total Block size  Pool size Suspended

WyBlockPool_1 (240005ec <P... 0 3 3 28 100

MyBlockPool_2 0x240004ac <P.. 0 4 4 40 200

MyBlockPool_3 052400034c <P... 0 5 5 52 300

Table 17. ThreadX Memory Block Pools details

s s ]

Name The name assigned to the memory block pool.

Address The starting address of the memory block pool.

Used The current number of allocated blocks.

Free The current number of free blocks.

Total The total number of memory block pools available.

Block size The size (bytes) of each block.

Pool size The total pool size (bytes).

Suspended The threads currently suspended because of the memory block pool state.
6.1.9 ThreadX Memory Byte Pools view

The ThreadX Memory Byte Pools view displays detailed information regarding all available memory byte pools in
the target system. The view is updated automatically each time the target execution is suspended.
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There is one column for each type of parameter, and one row for each memory byte pool. If the value of any
parameter for a particular memory byte pool has changed since the last time the debugger was suspended, the
corresponding row is highlighted in yellow.

Figure 208. ThreadX Memory Byte Pools view

10| O *®
&R ThreadX Memory Byte Pools 532 = im
Mame Address Used Free Size Fragments Suspended

Byte Pool Ow24000f24 "2140021" 1664 6328 8192 7

Table 18. ThreadX Memory Byte Pools details

e B ]

Name The name assigned to the memory byte pool.

Address The starting address of the memory byte pool.

Used The current number of allocated bytes.

Free The current number of free bytes.

Size The number of fragments.

Fragments The size (bytes) of each block.

Suspended The threads currently suspended because of the memory byte pool state.
6.1.10 Azure® RTOS TraceX tool

Important:  The Microsoft® Azure® RTOS TraceX tool (TraceX) only exists for Windows®.

UM2609 - Rev 6 page 190/245



3

UM2609
Azure® RTOS ThreadX

UM2609 - Rev 6

To open TraceX automatically upon data export, select the [Windows]>[Preferences] menu to associate the file
type . trx with TraceX through the Preferences window as shown in Figure 209.

Figure 209. File associations
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The Azure® RTOS ThreadX kernel can generate various system events into the MCU RAM buffer. These events
can later be analyzed “off target” by the TraceX application. This requires an export of the RAM buffer to a
suitable file format. Trace data can be exported using the [Export trace] button available from the menu of any

Azure® RTOS ThreadX view as shown in Figure 210 and Figure 211.

Figure 210. RAM buffer export (1 of 2)

© Console (£ Problems @ Executables @ Debugger Console 0 Memory 2 ThreadX Thread List & bl s
Name Pri.. State Run Count Stack Start Stack End  Stack Size Stack Ptr  Stack Usa...
sine wave 8 SLEEP (1) 124 0x24002... 0x24002.. 1024 0x24002... Disabled
System Timer T.. 0 SUSPENDED 123 0x24013.. 0x24013.. 1024 0x24013... Disabled
thread 0 1 SLEEP (10) 13 0x24000... 0x24000.. 1024 0x24000.. Disabled
thread 1 16 READY 1874 0x24000... 0x24000.. 1024 0x24000.. Disabled

= thread 2 16 RUNNING 1876 0x24000... 0x24000.. 1024 0x24000.. Disabled
thread 3 8 SUSPENDED (semaph... 62 0x24000... 0x24001.. 1024 0x24000f.. Disabled
thread 4 8 SLEEP (2) 62 0x24001,.. 0x24001.. 1024 0x24001... Disabled
thread 5 4 SUSPENDED (event fl.. 13 0x24001... 0x24001.. 1024 0x24001... Disabled
thread 6 8 SUSPENDED (mutex 0) 62 0x24001... 0x24001.. 1024 0x24001... Disabled
thread 7 8 SLEEP (2) 62 0x24001... 0x24002.. 1024 0x24001f.. Disabled
Idle

Figure 211. RAM buffer export (2 of 2)
B Console [ Problems © Executables & Debugger Console 0 Memory i ThreadX Thread list & =§-0
Name Pri.. State Run Count Stack Start Stack @ ThreadX Semaphores Show view... >
[ sine wave 8 SLEEP(1) 124 0x24002...  Ox24 : Wiz a2 Export trace
System TimerT.. 0 SUSPENDED 123 024013, oxzar . 1hreadX Message Queues d
@ ThreadX Event Flags
thread 0 1 SLEEP(10) 13 0x24000.. Ox24l gy 1y = o d
thread 1 16 READY 1874 0x24000... Ox24( @ ThreadX Memory Block Pools d

= thread 2 16 RUNNING 1876 0x24000..  0x24(g9 ThreadX Memory Byte Pools d
thread 3 8 SUSPENDED (semaph... 62 0x24000... O0x240077 1024 0x24000%7.. Disabled
thread 4 8 SLEEP (2) 62 0x24001... 0x24001.. 1024 0x24001... Disabled
thread S 4 SUSPENDED (event fl... 13 0x24001... 0x24001.. 1024 0x24001... Disabled
thread 6 8 SUSPENDED (mutex 0) 62 0x24001... 0x24001.. 1024 0x24001.. Disabled
thread 7 8 SLEEP (2) 62 0x24001... 0x24002.. 1024 0x24001f... Disabled

There are four prerequisites to export traces:
. The Azure® RTOS ThreadX kernel must be built with trace enabled
—  The embedded STM32CubeMX editor provides GUI support to enable the trace events
. The function tx_trace enable () must be called before any data can be exported
. The trace export operation must not be performed inside the kernel API to avoid data file corruption
. The RAM buffer can only be read when the target is halted
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On run

When exporting, the export destination is prepopulated from the active debug context available at: $PATH _TO
_ PROJECT/TraceX/$LAUNCH CONFIGNAME.trx. If previous trace data already exists, the user is prompted
whether to overwrite them as shown in Figure 212.

Figure 212. Existing trace overwrite
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On export

When exporting the data to TraceX, STM32CubelDE reads the RAM buffer from the target. The corresponding
data is then used to create a * . trx file, which can later be opened with the TraceX tool. By default, a Tracex
directory is created in the project, containing the . trx file.

Figure 213. TraceX analysis
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Remember: - The export function only works once TraceX is initialized (tx _trace enable ()). The tool exports the last
N trace events.

. There is a risk of exported trace data corruption if the export is performed inside the kernel API. To avoid
such a corruption, make sure that the export is performed when the target is at a suitable location. For
instance, set a breakpoint outside the kernel API or configure the trace full callback.

6.2 FreeRTOS™

The following views are available for FreeRTOS™:
. FreeRTOS Task List

. FreeRTOS Timers

. FreeRTOS Semaphores

. FreeRTOS Queues

6.2.1 Requirements

To be able to populate the FreeRTOS ™-related views with detailed information about the RTOS status, some files

in the FreeRTOS™ kernel must be configured. The following sections describes some required configurations.
Consult the FreeRTOS reference manual for detailed information.

6.2.1.1 Enable trace information

The define configUSE TRACE FACILITY in freeRTOSConfig.h must be enabled (set to 1). It results in
additional structure members and functions to be included in the build and enables for instance stack checking in
the FreeRTOS Task List view and lists the semaphore types in the FreeRTOS Semaphores view.

Example:

freeRTOSConfig.h
#define configUSE TRACE FACILITY 1

6.2.1.2 Add to registry
The application software must call the vQueueAddToRegistry () function to make the FreeRTOS Queues and

FreeRTOS Semaphores views able to display objects. The function adds an object to the FreeRTOS™ Queue
registry and takes two parameters, the first is the handle of the queue, and the second is a description of the
queue, which is presented in FreeRTOS ™-related views.

Example:

vQueueAddToRegistry (mailId, "osMailQueue");
vQueueAddToRegistry (osQueueHandle, "osQueue");
vQueueAddToRegistry (osSemaphoreHandle, "osSemaphore");
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6.2.1.3
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RTOS profiling information

To get valid RTOS run time statistics, the application must set up a run time statistics time base. The time-base
clock is recommended to run at least 10 times faster than the frequency of the clock used to handle the RTOS tick

interrupt. To enable the FreeRTOS™ collection of run time statistics, file freeRTOSConfig.h must include:
1. Define configGENERATE RUN TIME STATS 1

2. Define portCONFIGURE TIMER FOR RUN TIME STATS () to call the function that configures a timer to
be used for profiling

3. Define portGET RUN TIME COUNTER VALUE () to call the function that reads the current value from the
profiling timer

Example:

freeRTOSConfig.h

#define configGENERATE RUN TIME STATS 1

#define portCONFIGURE TIMER FOR RUN TIME STATS() configureRunTime ()
#define portGET_RUN_ TIME COUNTER VALUE () getRunTimeCounter ()

Or, if a run time variable is available in the system:

freeRTOSConfig.h

#define configGENERATE RUN TIME STATS 1
#define portCONFIGURE TIMER FOR RUN TIME STATS() (RunTime=0UL)
#define portGET_RUN_TIME COUNTER VALUE () RunTime

If the Run Time column in the FreeRTOS Task List view displays N/2 after making these three settings, the
problem can a arise if project is not built with optimization level -00. The reason is quite likely found in the
declaration in tasks.c of ulTutoralRunTime.

Example:

#if ( configGENERATE RUN TIME STATS == 1 )
PRIVILEGED DATA static uint32 t ulTaskSwitchedInTime = OUL;
/*< Holds the value of a timer/counter the last time a task was switched in. */
PRIVILEGED DATA static uint32 t ulTotalRunTime = OUL;
/*< Holds the total amount of execution time as defined by the run time counter clock. */
#endif

Solutions:

. Either declare the variable as volatile:

PRIVILEGED DATA volatile static uint32 t ulTotalRunTime = 0UL;
/*< Holds the total amount of execution time as defined by the run time counter clock.

*/

. Or simply change the optimization level only for tasks.c by
1. Right-clicking it in Project Explorer view and open Properties
2.  Select [Properties]>[C/C++ Build]>[Settings]>[Tool Settings]>[Optimization]
3. Set [Optimization Level] to None (-00)
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6.2.2 Finding the views

In the Debugger perspective, the FreeRTOS ™-related views are opened from the menu. Select the menu
command [Window]>[Show View]>[FreeRTOS]>[...] or use [Quick Access], search for “FreeRTOS” and select
from the views.

Figure 214. FreeRTOS "-related views selectable from the menu

Window Help
New Window SRS ®I- S P-F OO
Editor & [€) emsis_os.c ﬁFreeRTDSConf... [ mainc 2 Py = 0
Appearance > ~
Show View > &2 FreeRTOS > @@ FreeRTOS Queues
Perspective » B oswv > @2 FreeRTOS Task List
Navigation - @y Breakpoints Alt+Shift+Q, B &% FreeRTOS Semaphores
wip  Build Analyzer &2  FreeRTOS Timers
Preferences Console AltShiftsQ, C
6.2.3 FreeRTOS Task List view

The FreeRTOS Task List view displays detailed information regarding all available tasks in the target system. The
task list is updated automatically each time the target execution is suspended.

There is one column for each type of task parameter, and one row for each task. If the value of any parameter
for a task has changed since the last time the debugger was suspended, the corresponding row is highlighted in
yellow, as shown in the example in Figure 215.

Figure 215. FreeRTOS Task List (default)

s o x
I Fremf 704 Taak Lt (21 Eom
Fmrrar Pricety {Bnn/_  Start of Stack Top of Stack Skate Eennt Dibject ey Frew Sasck P Wirren (%3
= & SuBE0Sc BISNCALE urbinup= 1108 Rytaran sabled s
LECThusad 3 0050 Du20000308 @ uckeaps Tl SAFRFERMDED: [mabded o
Trvwt Sl 2 e Fure e e a Dm20000500 < it Heagre 2420 BLOEED T} Deabded %
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Due to performance reasons, stack analysis (the Min Free Stack column) is disabled by default. To enable stack
analysis (refer to Figure 217), use the Toggle Stack Checking toolbar button in the FreeRTOS Task List view
toolbar as shown in Figure 216.

Figure 216. FreeRTOS™ Toggle Stack Checking

O X

— =

ne (%) | Toggle Stack Checking h
L

Figure 217. FreeRTOS Task List (Min Free Stack enabled)

=] o ®
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The FreeRTOS Task List view in Figure 217 contains a Min Free Stack column. The column information is
changed to Stack Usage if the project is built with the following define set:

#define configRECORD STACK HIGH ADDRESS 1

In this case, the full stack usage is presented according to the format Used/Total(%Used) as shown in Figure 218.

Figure 218. FreeRTOS Task List with ConfigRECORD_STACK_HIGH_ADDRESS enabled

10} m] X
7% FreeRTOS Task List == 0
Name Priority (B... Start of S.. Top of St... State Event Object Stack Usage Run Time...
= IDLE 0/0 0%20000... 0x20000.. RUNNING 968 / 2052B (4.7%) N/A
THREAD1 24/24 0%x20001... 0x20001.. DELAYED 1448 / 512B (28.1%) N/A
THREAD2 24/24 0x20001... 0x20001.. DELAYED 1448 / 512B (28.1%) N/A
Tmr Sve 2/2 0x20000... 0x20000.. BLOCKED TmrQ 1688 / 1028B (16.3%) N/A
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The column information in the FreeRTOS Task List view is described in Table 19.

Table 19. FreeRTOS Task List details

I

N/A A green arrow symbol indicates the task currently running.
Name The name assigned to the task.
The task base priority and actual priority. The base priority is the priority assigned to the task.
Priority (Base/Actual) The actual priority is a temporary priority assigned to the task due to the priority inheritance
mechanism.
Start of Stack The address of the stack region assigned to the task.
Top of Stack The address of the saved task stack pointer.
State The current state of the task.
Event Object The name of the resource that has caused the task to be blocked.
The stack “high watermark”. Displays the minimum number of bytes left on the stack for a
Min Free Stack(" task. A value of 0 (most likely) indicates that a stack overflow has occurred.
Note: This feature must be enabled in the “View” toolbar.

The run time statistics provide information on the percentage of time the task has been used.

T 0,
Run Time (%) This can be used for profiling the system during development.

1. When the application is built with configRECORD STACK HIGH ADDRESS = 1, the column name is changed to “Stack
Usage”. It displays the stack usage in detailed format as “Used/Total(%Used)”.

6.2.4 FreeRTOS Timers view

The FreeRTOS Timers view displays detailed information regarding all available software timers in the target
system. The view is updated automatically each time the target execution is suspended. There is one column for
each type of timer parameter, and one row for each timer. If the value of any parameter for a timer has changed
since the last time the debugger was suspended, the corresponding row is highlighted in yellow.

Figure 219. FreeRTOS Timers

19€ [m ¢
1® FreeRTOS Timers

MName Active  Period Type Id Callback

myTimerTEST True 200 Auto-Reload (el OnB000429 <osTimerCallback »
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The column information in the FreeRTOS Timers view is described in Table 20.

Table 20. FreeRTOS Timers details

I

Name The name assigned to the timer.
Active The active status information.
Period The time (in ticks) between timer start and the execution of the callback function.
Type 'I_'he type o_f timer. Auto-reload timers are automatically reactivated after expiration. One-shot
timers expire only once.
Id The timer identifier.
Callback The address and name of the callback function executed when the timer expires.
Note: 1. If no name appears in the Name field, check that the timer is created with a name. The first parameter

when calling xTimerCreate () must contain the timer name string.

2. When using software timers, a Tmr Svc task and a TmrQ queue are created automatically. These objects
are displayed in the FreeRTOS Task List view and FreeRTOS Queues view.

6.2.5 FreeRTOS Semaphores view

The FreeRTOS Semaphores view displays detailed information regarding all available synchronization objects in
the target system, including:

. Mutexes

. Counting semaphores
. Binary semaphores

. Recursive semaphores

The view is updated automatically each time the target execution is suspended. There is one column for each
type of semaphore parameter, and one row for each semaphore. If the value of any parameter for a semaphore
has changed since the last time the debugger was suspended, the corresponding row is highlighted in yellow.

Figure 220. FreeRTOS Semaphores

[ o *
58 FreeRTOS Semaphores 12 -8
Mame Acdress Type Size Free = Blocked tasks
osSemaphore 20000058 BIMARY_SEMAPHORE 1 0 0
L 4
Note: If the Type information displays N/A, make sure that the define configUSE TRACE FACILITY is enabled in

file FreeRTOSconfig.h.
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The column information in the FreeRTOS Semaphores view is described in Table 21.

Table 21. FreeRTOS Semaphores details

I

Name The name assigned to the semaphore.

Address The address of the object.

Type The type of the object.

Size The maximum number of owning tasks.

Free The number of free slots currently available.

#Blocked tasks The number of tasks currently blocked waiting for the object.
6.2.6 FreeRTOS Queues view

The FreeRTOS Queues view displays detailed information regarding all available queues in the target system.
The view is updated automatically each time the target execution is suspended. There is one column for each
type of queue parameter, and one row for each queue. If the value of any parameter for a queue has changed
since the last time the debugger was suspended, the corresponding row is highlighted in yellow.

Figure 221. FreeRTOS Queues

= O *
B FrecfTOS Queues 31 Sl =
MHame Address Max Length tem Size Cument Length & Waating Tx # Waiting Px
osCusue (20000062 1 2 0 0 1

The column information in the FreeRTOS Queues view is described in Table 22.

Table 22. FreeRTOS Queues details

I

Name The name assigned to the queue in the queue registry.

Address The address of the queue.

Max Length The maximum number of items that the queue can hold.

ltem Size The size in bytes of each queue item.

Current Length The number of items currently in the queue.

#Waiting Tx The number of tasks currently blocked waiting to be sent to the queue.

#Waiting Rx The number of tasks currently blocked waiting to be received from the queue.
6.3 RTOS-kernel-aware debug

The RTOS-kernel-aware debug in STM32CubelDE supports the Microsoft® Azure® RTOS ThreadX and
FreeRTOS™ operating systems using an RTOS proxy. The RTOS proxy is included in STM32CubelDE and can
be used with ST-LINK GDB server, OpenOCD, and SEGGER J-Link GDB server.

When RTOS-kernel-aware debugging is enabled and a debug session is started, all threads are listed in the
Debug view. By selecting a thread in the Debug view, the thread current context is visualized in views. For
instance, the Variables, Registers, Editor views reflect the active stack frame.
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Figure 222 shows a debug session. The ThreadX Thread List view displays that the Message Queue
Receiver Thread is RUNNING. This can also be seen in the Debug view. In the Debug view the
MsgSenderThreadTwo Entry function is selected, and the editor area displays that the thread is waiting in
a sleep for 500 ms state.

Figure 222. RTOS-kernel-aware debug

I workspace_ums - T_Thread_MsgQueue/Application/User/app_threadx.c - STM32CubelDE - O X
File Edit Source Refactor Navigate Search Project Run Window Help
B RESEvitvO QR vin(APIBNZRR(PILGSS vivegova v m@ Q s @
4 Debug ‘O Project Explorer B%|# & =0 @app threadxc 3 [ tx thread sy.. x thread s..  [Btx quevere.  [Etxthreads.. [ txe queuer. =0 ervar. @ %Br. %Ex. ®Mo. WRe. L. ®SF. 0
~ [3Tx_Thread_MsgQueue [STM32 Cortex-M C/C++ Application] 195  * @param thread_input: Not used @ oD
v @ Tx_Thread_MsgQueue.lf 123 :/@ 1 None Name Type Value
v H i . - thread_input ULONG 0
# Thread #2 [Message Queue Sender Thread One] 603979944 (Suspended : Container) 195 void MsgSenderThreadTuo_Entry(ULONG thread_input) o thread inpu
= _get ipsr_value() at t_porth:368 0x800386 199 © Msg ULONG 1
thread_system _return_inline() at tx_porth:447 0x8003¢86 200 ULONG Msg = TOGGLE_LED;
thread_system_suspend() at tx_thread_system_suspend.c:549 0x8003e86 201 (void) thread_input;
thread_sleep() at tx_thread._sleep.c:189 0x8003a70 202 /* Infinite loop */
- - - 203 while(1)
MsgSenderThreadOne_Entry() at app_threacx.c:189 0x80007cc 0a  {
thread_shell_entry() at tx_thread_shell_entry.c:114 0x8003938 205 /* Send message to MsgQueueTwo. */
Oxfffffffe 206 if (tx_queue_send(8MsgQueueTwo, &Msg, TX_WAIT_FOREVER) != TX_SUCCESS)
v 4 Thread #3 [Message Queue Receiver Thread] 603980120 (RUNNING) (Suspended : Signal : SIGINT 267 {
. 208 Error_Handler();
tre_queue_receive() at txe_queue_receive.c:102 0x80043de 60 ) -
MsgReceiverThread_Entry() at app_threach.c:229 0x8000826 210 7* Sleep for 5005 */
thread_shell_entry( at tx_thread_shell_entry.c:114 0x8003938 211 tx_thread_sleep(500);
= Oxfffffe 212}
~ # Thread #4 [Message Queue Sender Thread Two] 603980296 (Suspended : Container) ii ¥
__get_ipsr_value() at tx_porth:368 0x8003e86 215 /%%
thread_system_return_inline() at tx_port.h:447 0x8003e86 216  * @rief Function implementing the MsgReceiverThread thread.
tx_thread_system _suspend() at tx_thread_system_suspend.c:549 0x8003e86 217  * @param thread_input: Not used
thread_sleep() at tx_thread_sleep.c:189 0x8003a70 ﬁg :/
MsoSendeqTieadwolEnty(atappttieadecall|06000502 220°void MsgReceiverThread_Entry(ULONG thread_input)
thread_shell_entry() at tx_thread_shell_entry.c:114 0x8003938 221 {
fffffife 222 ULONG RMsg = @;
~ i Thread #5 [System Timer Thread] 603980976 (Suspended : Container) 223 UINT status = @ ;
_get ipsr_value() at tx_porth:368 0x8003¢86 224 (void) thread_input;
hread inli he447 0x8003686 225  /* Infinite loop */
tx_thread_system_return_inline() at tx_port.| x8003e! 22 while (1) 2 N
thread_system_suspend() at tx_thread_system_suspend.c:549 0x8003¢86 227
tx_timer_thread_entry() at tx_timer_thread_entry.c462 0x8004adc 228 /* Determine whether a message MsgQueueOne or MsgQueueTwo is available */
thread_shell_entry() at tx_thread_shell_entry.c:114 0x8003938 229 status = tx_queue_receive(&MsgQueueOne, &RMsg, TX_NO_WAIT);
230 if (status TX_SUCCESS)
itittife as —
» arm-none-eabi-gdb (8.3.1.20191211) 232 /* Check Message value */
4 ST-LINK (ST-LINK GDB server) 233 if (RMsg != TOGGLE_LED)
+4 RTOS Proxy 234
235 Error_Handler();
236 }
237 else
238
239 BSP_LED_Toggle(LED_GREEN);
210 hY v
B Console [ Problems @ Executables &Debugger Console 0 Memory i ThreadX Thread List ==
Name Pri.. State Run Count  Stack Start Stack End Stack Size Stack Ptr Stack Usage
= Message Queue Receiver Thread 10 RUNNING 875 0x2400139¢ 0x2400159 512 0x240014fc Disabled
Message Queue Sender Thread One 5 SLEEP (200) 74 0x24000f8¢ 0x2400118b 512 0x2400105¢ Disabled
Message Queue Sender Thread Two 5 SLEEP (404) 30 0x24001194 0x24001393 512 0x24001264 Disabled
System Timer Thread 0 SUSPENDED 874 0x24000570 0x2400096f 1024 0x2400083¢ Disabled
Idle
< 2| € >
il

To enable RTOS-kernel-aware debugging the Debugger tab in the Debug Configurations dialog contains settings
to enable RTOS proxy, driver (RTOS ThreadX or FreeRTOS™), port (Cortex® core) and configuration of port
number to use with the proxy.

The RTOS tab also contains a Driver settings selection to select the Driver (“ThreadX” or “FreeRTOS”) and the
port used. The “Auto-detect” driver setting is still experimental.
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Figure 223. RTOS-kernel-awareness debug configuration
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Figure 224. ThreadX-kernel-awareness debug configuration

RTOS Kernel Awareness
Enable RTOS Proxy
Driver settings

Driver: |Threa dx

Port: | cortex_m0

Part number: | 60000
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The port selection lists the supported cores. The items listed depend on the selected RTOS driver as displayed in
Figure 225 and Figure 226.

Figure 225. ThreadX port configuration

RTOS Kernel Awareness
Enable RTOS Proxy

Driver settings

Driver: |Threadx v

Port:

Port nujcortex m3

Figure 226. FreeRTOS™ port configuration
RTOS Kernel Awareness
Enable RTOS Proxy

Driver settings

Driver: |FreeRTOS ™
Port: |ARM_CMO

Port nufaARM_CM3
ARM_CM3_MPU
ARM_CMA4F

ARM_CM4_MPU

oace 1.7.00App cM33_NTZ

Known limitations

. Live expressions must be disabled when used with the ST-LINK GDB server

. The Registers view content for swapped out threads is intermixed with active CPU context for some
registers (all registers are not saved by the context switcher)

. The Registers view floating point registers are not updated correctly
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7 Fault Analyzer

71 Introduction to the Fault Analyzer

The STM32CubelDE Fault Analyzer feature interprets information extracted from the Cortex®-M nested vector
interrupt controller (NVIC) in order to identify the reasons that caused a fault. This information is visualized in the
Fault Analyzer view. It helps to identify and resolve hard-to-find system faults that occur when the CPU is driven
into a fault condition by the application software.

Among such conditions are:

. Accessing invalid memory locations

. Accessing memory locations on misaligned boundaries

. Executing undefined instruction

. Division by zero

Upon fault occurrence, the code line where the fault occurred is displayed in the debugger. The view displays the
reasons for the error condition. Faults are coarsely categorized into hard, bus, usage and memory faults.

. Hard and bus faults occur when an invalid access attempt is made across the bus, either of a peripheral
register or a memory location

. Usage faults are the result of illegal instructions or other program errors

. Memory faults include attempts of access to an illegal location or violations of rules maintained by the
memory protection unit (MPU)

To further assist fault analysis, an exception stack frame visualization option provides a snapshot of the MCU
register values at the time of the crash. Isolating the fault to an individual instruction allows to reconstruct the
MCU condition at the time the faulty instruction was executed.

In the Debugger perspective, the Fault Analyzer view is opened from the menu. Select the menu command
[Window]>[Show View]>[Fault Analyzer] or use the [Quick Access] field, search for “Fault Analyzer” and select
it from the views.

Figure 227. Open the Fault Analyzer view

mworkspacefum1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE

File Edit Source Refactor Navigate Search Project Run Window Help

g @i % %o @2 i  New Window viglvilvoaoryo 2O
. : Editor bl o
% Debug & & Project Explorer Appearance s (€ main.c 8 startup_stm3... g,
~ [ENUCLEO-F401RE Debug (ST-LINK) | ik et BLLE 1=0:
Show View > B swv >
v T NUCLEO-F401RE.elf [cores: 0] i - . .
. o Perspective > % Breakpoints Alt+Shift+Q, B
v #Thread #1 [main] 1 [core: 0] ( 5+ Build Anal
= HardFault Handler() atstn ~ Navigation > @ Burd Analyzer ,
. = B Console Alt+Shift+Q, C
= <signal handler called>() Preferences % Debug
fwriFeSpeed().at main.c:147 0x800055c¢ ® Debugger Console
= main() at main.c:232 0x8000684 = Disassembly

= Reset_Handler() at startup_stm32f401retx.s:113 Oxi 9 Error Log Alt+Shift+Q, L
»l C:/ST/STM32CubelDE_1.1.0/STM32CubelDE/plugins/con
»: ST-LINK (ST-LINK GDB server)

© Executables

¢ Expressions

® Fault Analyzer
& Live Expressions
0 Memory
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7.2 Using the Fault Analyzer view

The Fault Analyzer view has five main sections, which can be expanded and collapsed. The sections contain
different kinds of information for better understanding the reason that caused a particular fault to occur. The
sections are:

. Hard Fault Details

. Bus Fault Details

. Usage Fault Details

. Memory Management Fault Details

. Register Content During Fault Exception

When a fault has occurred, it is possible to [Open editor on fault location] and [Open disassembly on fault
location] by pressing the buttons in the view.

Figure 228 shows an example of the Fault Analyzer view when an error is detected. In this example, the error is
caused by a project making a divide by zero with the debugger stopped in the HardFault Handler ().

Opening the Fault Analyzer view when this happens displays the reason of the error. In the example, it displays
[Usage Fault Detected] and [Attempt to perform a division by zero (DIVBYZERO)]. The Register Content
During Fault Exception presents register values when the problem occurred.
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3

Figure 228. Fault Analyzer view

o] o X

@ Fault Analyzer o

! Hard Fault Detected = pc v
Hard Fault Details

@ Bus, memory management or usage fault (FORCED)
@ Failed vector fetch (VECTBL)
@ Debug event (DEBUGEVT)

Bus Fault Details

@ Instruction access violation (IBUSERR)

® Precise data access violation (PRECISERR)

@ Imprecise data access violation (IMPRECISERR)

@ Unstacking error (UNSTKERR)

@ Stacking error (STKERR)

@ Floating point lazy state preservation error (LSPERR)

Bus fault address register (BFAR): 0xe0

Usage Fault Details

@ Attempt to execute an undefined instruction (UNDEFINSTR)

@ Attempt to switch to invalid state (INVSTATE)

@ Attempt to do exception with bad value in EXEC_RETURN number (INVPC)
@ Attempt to execute a coprocessor instruction (NOCP)

@ Attempt to perform an unaligned access (UNALIGNED)

@ Attempt to perform a division by zero (DIVBYZERO)

Memory Management Fault Details

@ Instruction access violation (IACCVIOL)

@ Data access violation (DACCVIOL)

@ Unstacking error (MUNSTKERR)

@ Stacking error (MSTKERR)

@ Floating point lazy state preservation error (MLSPERR)

Mem manage address register (MMFAR): 0xe0
Register Content During Fault Exception

Name  Value
fitsp (M... 0x20017fc0

pc 0x800055¢
fiixpsr  0x21000000

0 0x0
i 0x0
Hitr2 0x0
iir3 0x8000000
12 0x0
iitlr 0x8000685

The value of the stack pointer when the fault occurred. Please verify that this value points to a valid stack memory region.

MSP = Main Stack Pointer
PSP = Process Stack Pointer
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The Fault Analyzer view contains these toolbar buttons:

Figure 229. Fault Analyzer toolbar

9 = PC v

. The first toolbar button (left) opens the Editor on the fault location return address by using the information in
the PC and LR registers in the stack and the symbol information in the debugged e1f file.

. The second toolbar button (middle) opens the Disassembly view on the fault location return address by
using the information in PC and LR registers in the stack and the symbol information in the debugged e1 £
file.

. The third toolbar button (right) selects if the PC or LR register is used when opening the Editor or
Disassembly view on error location.

Figure 230 and Figure 231 show the Editor and Disassembly views opened using the toolbar buttons to find the
fault location in the example.

Figure 230. Fault analyzer open editor on fault

(¢ main.c © 8 startup_stm3..  ld system_stm3... 1w STM32F401RET...
142

43=int writeSpeed(int pos)

46 // update speed
47 speed= pos/tsec;
48 return speed;

50 }

Figure 231. Fault Analyzer open disassembly on fault

#-Variables °e Breakpoints ® Modules = Disassembly * ! Registers ®f SFRs % Live Expressions

Fnter lacation her [|& fy Bl e
0800055c: | sdiv (32, (il (77

08000560 ldr rl, [pc, #28] ; (0x8000580 <writeSpeed+56>)
08000562 : 1dr rl, [r3, rl]
08000564 : str r2, [rl, #0]
148 return speed;
Note: The Fault Analyzer can be used on all STM32 projects. It requires no special code and no special build
configuration. All data are collected for the Cortex®-M registers. The symbol information is read from the
debugged e1r file.
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8 Build Analyzer

8.1 Introduction to the Build Analyzer

The STM32CubelDE Build Analyzer feature interprets program information from the e1 £ file in detail and presents
the information in a view. If a map file, with similar name, is found in the same folder as the e1 £ file the
information from the map file is also used and even more information can be presented.

The Build Analyzer view is useful to optimize or simplify a program. The view contains two tabs, the Memory
Regions and Memory Details tabs:

. The Memory Regions tab is populated with data if the e1f file contains a corresponding map file. When the
map file is available, this tab can be seen as a brief summary of the memory regions with information about
the region name, start address and size. The size information also comprises the total size, free and used
part of the region, and usage percentage.

. The Memory Details tab contains detailed program information based on the e1f file. The different section
names are presented with address and size information. Each section can be expanded and collapsed.
When a section is expanded, functions/data in this section is listed. Each presented function/data contains
address and size information.

8.2 Using the Build Analyzer

The Build Analyzer view is by default open in the C/C++perspective. If the view is closed it can be opened from
the menu. Select the menu command [Window]>[Show View]>[Build Analyzer] or use the [Quick Access] field,
search for “Build Analyzer” and select it from the views.

When the Build Analyzer view is open, select an e1f file in the Project Explorer view. The Build Analyzer view is
then updated with the information from this file. When an e1f file is selected and a map file, with similar name, is
found in the same folder, additional information from the map file is also used by the view.

The Build Analyzer view is also updated if a project node in the Project Explorer view is selected. In this case the
Build Analyzer uses the e1 £ file that corresponds to the current active build configuration of the project.

Figure 232. Build analyzer

1DE| 0 X

v =0

o Build Analyzer

STMI2Fde-Nucleo eff - ISTMI2F4: - 0ct 21,2019 2:44:29 PM

Memory Regions  Memory Details

Region Start address End address Size Free Used Usage (%)

=FLASH 0x08000000 0x08080000 524288 518840 5448 ‘ 1.04%

=RAM 0x20000000 0x20018000 98304 96604 1700 | 1.73%
8.2.1 Memory Regions tab

The Memory Regions tab in the Build Analyzer view displays information based on the corresponding map file.

If no information is displayed, it means that there is no corresponding map file found. When a map file is found,
the region names, start address, end address, total size of region, free size, used size and usage information are
presented.

These regions are usually defined in the linker script file (. 1d) used when building the program. Update the linker
script file if a memory region location or size must be changed.

Note: The Memory Regions tab is empty if the e file has no corresponding map file.
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8.2.2

Figure 233. Memory Regions tab

o Build Analyzer =

Memory Regions

Region

=RAM

=FLASH
=FLASH_ICONS
=ELASH_IMAGES
=FLASH_SOUND
#FLASH D
=FLASH V

NUCLEO-F401RE.elf - INUCLEO-F401RE/Debug - Oct 25, 2019 10:24:05 AM

Memory Details

Start address
0x20000000
0x08000000
0x08040000
0x08050000
0x08070000
0x0807f000
0x0807f800

End address
0x20018000
0x08040000
0x08050000
0x08070000
0x0807f000
0x0807f800
0x08080000

Size
96 KB
256 KB
64 KB
128 KB
60 KB
2 KB

2 KB

Free
16.23 KB
236.17 KB
4447 KB
10.81 KB
7.75 KB
1.99 KB
1.99 KB

Used
79.77 KB
19.83 KB
19.53 KB
117.19 KB
52.25 KB
8B

12B

v e q

Usage (%)
83.09%
[7.75%

180 52%

87.08%
0.39%
| 0.59%

The column information is described in the Table 23.

Region

Table 23. Memory Regions tab information

I T

Name of memory region (if a corresponding map file is found).

Start address ' The start address of the region, defined in the linker script.

End address | End address of the region.

Size The total size of memory region.
Free The free size in the memory region.
Used The used size in the memory region.

Usage %

The percentage of used size relative to the total memory region size. See Table 24 for the bar icon color
information.

The Usage (%) column contains a bar icon corresponding to the percentage value. The bar has different colors
depending on the percentage of used memory.

Green
Yellow

Red

Memory Details tab

Table 24. Memory Regions usage color

Less than 75% of memory used.

75% to 90% of memory used.

More than 90% of memory used.

The Memory Details tab of the Build Analyzer view contains information for the e1f file. Each section in the
Memory Details tab can be expanded so that individual functions and data can be seen. The tab presents
columns with name, run address, load address, and size information.
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Figure 234. Memory Details tab

10} O X
i Build Analyzer By oo
NUCLEO-FA01RE.elf - INUCLEO-FA01RE/Debug - Oct 25, 2019 11:15:52 AM
Memory Regions Memory Details
| Search
Name Run address (VMA) Load address (LMA) Size
v = RAM 0x20000000 96 KB
> & data 0x20000000 0x08004f49 128
> & bss 0x2000000c 78.25 KB
& ._user_heap_stack 0x2001390c 1.5 KB
» B FLASH 0x08000000 256 KB
> EEFLASH_ICONS 0x08040000 64 KB
v @ FLASH_IMAGES 0x08050000 128 KB
vk flash_images 0x08050000 0x08050000 117.19 KB
* image3 0x08064c08 0x08064c08 34.18 KB
* image2 0x080561a8 0x080561a8 58.59 KB
* image1 0x08050000 0x08050000 24.41 KB
v @ FLASH_SOUND 0x08070000 60 KB
> E flash_sound 0x08070000 0x08070000 52.25 KB
v B FLASH_D 0x0807f000 2 KB
> & flash_d 0x0807f000 8B
v ®EFLASH_V 0x0807f800 2 KB
> E flash_v 0x0807f800 0x0807f800 12B

The column information is described in Table 25.

Table 25. Memory Details tab information

I

Name of memory region, section, function, and data. A green icon is used to mark functions while the

Name ) . .
blue icon is used for data variables.

Run Address (VMA) | The Virtual Memory Address contains the address used when the program is running.

The Load Memory Address is the address used for load, for instance for the initialization values of

Load Address (LMA) global variables.

Size Used size (total size for Memory Regions).
Note: The memory region name is only displayed if a corresponding map file is found.
8.2.2.1 Size information

The size information in the Memory Details tab is calculated from the symbol size in the e1f£ file. If a
corresponding map file is investigated, it may contain a different size value. The size is usually correct for C
files but the value presented for assembler files depends on how the size information is written in the assembler
files. The constants used by the function must be defined within the section definition. At the end of the section,
the size directive is used by the linker to calculate the size of the function.
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Example: Reset_Handler in startup. s file

This example shows how to write the Reset Handler in an assembler startup file to include the constants
_sidata,_sdata,_edata, _sbss, and _ebss in the Reset Handler size information in the elf£ file. If these
constants are defined out of the Reset Handler section definition, their sizes are not included in the calculated
size of the Reset Handler. To include them in the size of the Reset Handler, these definitions must be
placed inside the Reset Handler section as presented in the code example below.

.section .text.Reset Handler
.weak Reset Handler
.type Reset Handler, %function

Reset Handler:
ldr sp, = estack /* set stack pointer */

/* Copy the data segment initializers from flash to SRAM */
movs rl, #0
b LoopCopyDatalInit

CopyDatalInit:
ldr r3, = sidata

/* initialization code data, bss, ... */

/* Call the application's entry point */
bl main
bx 1r

/* start address for the initialization values defined in linker script */
.word sidata

.word sdata

.word edata

.word sbss

.word ebss

.size Reset Handler, .-Reset Handler
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8.2.2.2 Sorting
The sort order of a Memory Details tab column can be changed by clicking on the column name.

Figure 235. Memory Details sorted by size

10} O X
o Build Analyzer = ®voo
NUCLEO-FA01RE.elf - INUCLEO-FA01RE/Debug - Oct 25, 2019 11:15:52 AM
Memory Regions Memory Details
'Search
Name Run address (VMA) Load address (LMA) Size 7
> ESFLASH 0x08000000 256 KB
v ®FLASH_IMAGES 0x08050000 128 KB
v & flash_images 0x08050000 0x08050000 117.19 KB
* image2 0x080561a8 0x080561a8 58.59 KB
= image3 0x08064c08 0x08064c08 34.18 KB
* image1 0x08050000 0x08050000 24.41 KB
v = RAM 0x20000000 96 KB
> E bss 0x2000000c 78.25 KB
% ,_user_heap_stack 0x2001390c 1.5 KB
> E data 0x20000000 0x08004f49 12B
> ESELASH_ICONS 0x08040000 64 KB
> mIFLASH_SOUND 0x08070000 60 KB
v ®FLASH D 0x0807f000 2 KB
>k flash_d 0x0807f000 8B
v ®FLASH_V 0x0807f800 2 KB
> & flash_v 0x0807f800 0x0807f800 12B
8.2.2.3 Search and filter
The information in the Memory Detailstab can be filtered by entering a string in the search field.
Figure 236 shows a search example for names including the string “sound”.
Figure 236. Memory Details search and filter
10E} O X
# Y =0

o Build Analyzer

NUCLEQ-F401RE.elf - INUCLEO-F401RE/Debug - Oct 25, 2019 11:15:52 AM

Memory Regions Memory Details

sound|

Name Run address (VMA) Load address (LMA) Size 7

v B FLASH_SOUND 0x08070000 60 KB

v & flash_sound 0x08070000 0x08070000 52.25 KB

= sound1 0x08070000 0x08070000 19.53 KB
* sound2 0x08074e20 0x08074e20 19.53 KB
= sound4 0x0807afc8 0x0807afc8 8.3 KB
" sound3 0x08079¢40 0x08079¢40 4.88 KB

UM2609 - Rev 6 page 212/245



m UM2609

Using the Build Analyzer

8.2.2.4 Calculate the sum of sizes

The sum of the sizes of several lines in the Memory Details tab can be calculated by selecting these lines in the
view. The sum of the selection is presented above the Name column in the view.

Figure 237. Sum of sizes

10} O X
a Build Analyzer = #voo
NUGLEO-FADIRE sif - NUCLEG-FADIREIDebug - Oct 25, 2018 11:15:52 AM
Memory Regions Memory Details
Selection: 92.77 KB
Search
Name Run address (VMA) Load address (LMA) Size 7
> B FLASH 0x08000000 256 KB
v BIFLASH_IMAGES 0x08050000 128 KB
v E flash_images 0x08050000 0x08050000 117.19 KB
* image2 0x080561a8 0x080561a8 58.59 KB
= image3 0x08064¢08 0x08064c08 34.18 KB
= image1 0x08050000 0x08050000 24.41 KB
> ERAM 0x20000000 96 KB
> mFLASH_ICONS 0x08040000 64 KB
v = FLASH_SOUND 0x08070000 60 KB
> E flash_sound 0x08070000 0x08070000 52.25 KB
> ®FLASH_ D 0x0807f000 2 KB
> BELASH_V 0x0807f800 2 KB
8.2.2.5 Display the size information in byte format

The Build Analyzer view can display size information in different format according to the [Show Byte], [Show
Hex] or [Show Human] selection. The icon in the Build Analyzer toolbar is used to switch between these
formats. Prefer [Show Byte] or [Show Hex] when copying and pasting of data into an Excel® document for later

calculations.
Figure 238. Show byte count
10 O X
- - + v o0
a6 Build Analyzer * -
NUCLE O-F401RE elf - INUCLE O-FA0 1RE/Debug - Oct 25, 2019 11:15:52 AM . Show Byte
Memory Regions Memory Details ::OW :ex
ow Human
Selection: 85000
Search
Name v Run address (VMA) Load address (LMA) Size
> =RAM 0x20000000 98304
> BFLASH_V 0x0807f800 2048
v BFLASH_SOUND 0x08070000 61440
> & flash_sound 0x08070000 0x08070000 53500
v B FLASH_IMAGES 0x08050000 131072
v & flash_images 0x08050000 0x08050000 120000
" image3 0x08064c08 0x08064c08 35000
= image2 0x080561a8 0x080561a8 60000
= image1 0x08050000 0x08050000 25000
> FLASH_ICONS 0x08040000 65536
> FLASH_D 0x0807f000 2048
> BFLASH 0x08000000 262144
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Figure 239. Show hex count

10E] O X
s Build Analyzer #veo
NUCLE Q-FA01RE.elf - INUCLE O-F401 RE/Debug - Oct 25, 2019 11:15:52 AM Show Byte
Memory Regions Memory Details [ show Hex
Show Human
Selection: 0x14c08
Search
Name Y Run address (VMA) Load address (LMA) Size
> =RAM 0x20000000 0x18000
> BEFLASH_V 0x0807f800 0x800
v B FLASH_SOUND 0x08070000 0xf000
>k flash_sound 0x08070000 0x08070000 0xdOfc
v B FLASH_IMAGES 0x08050000 0x20000
v & flash_images 0x08050000 0x08050000 0Ox1d4c0
= image3 0x08064c08 0x08064c08 0x88b8
* image2 0x080561a8 0x080561a8 Oxeab0
* imageT 0x08050000 0x08050000 Ox61a8
> B FLASH_ICONS 0x08040000 0x10000
> ®FLASH D 0x0807f000 0x800
> @ FLASH 0x08000000 0x40000
8.2.2.6 Copy and paste

The data in the Memory Details tab can be copied to other applications in CSV format by selecting the rows to
copy and typing Ctrl+C. The copied data can be pasted into another application with the Ctrl+V command.

Figure 240. Copy and paste

10} O X
o Build Analyzer =veoo
NUCLEO-F401RE elf - INUCLEO-FAD1RE/Debug - Oct 25, 2019 11:15:52 AM
Memory Regions Memory Details
Selection: 193500
Search
Name v Run address (VMA) Load address (LMA) Size
> = RAM 0x20000000 98304
> EEFLASH_V 0x0807f800 2048
v = FLASH_SOUND 0x08070000 61440
v E flash_sound 0x08070000 0x08070000 53500
* sound4 0x0807afc8 0x0807afc8 8500
= sound3 0x08079c40 0x08079c40 5000
= sound2 0x08074e20 0x08074e20 20000
= sound1 0x08070000 0x08070000 20000
v @ FLASH_IMAGES 0x08050000 131072
v u flash_images 0x08050000 0x08050000 120000
= image3 0x08064c08 0x08064c08 35000
= image2 0x080561a8 0x080561a8 60000
= image1 0x08050000 0x08050000 25000
v @ FLASH_ICONS 0x08040000 65536
v & flash_icons 0x08040000 0x08040000 20000
= icons 0x08040000 0x08040000 20000
> ®FLASH D 0x0807f000 2048
> = FLASH 0x08000000 262144
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3

The Ctrl+C copy of the lines selected in Figure 240 provides the Ctrl+V results below:

"sound4";"0x0807afc8";"0x0807afc8";"8500"
"sound3";"0x08079c40";"0x08079c40";"5000"
"sound2";"0x08074e20";"0x08074e20";"20000"
"soundl";"0x08070000";"0x08070000";"20000"
"image3";"0x08064c08";"0x08064c08";"35000"
"image2";"0x080561a8";"0x080561a8";"60000"
"imagel";"0x08050000";"0x08050000";"25000"
"icons";"0x08040000";"0x08040000";"20000"
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9 Static Stack Analyzer

9.1 Introduction to the Static Stack Analyzer

The STM32CubelDE Static Stack Analyzer calculates the stack usage based on the built program. It analyzes
the . su files, generated by gcc, and the e1£ file in detail, and presents the resulting information in the view.

The view contains two tabs, the List and Call Graph tabs.

The List tab is populated with the stack usage for each function included in the program. The tab lists one line per
function, each line consisting of the Function, Local cost, Type, Location and Info columns.

Figure 241. Static Stack Analyzer List tab

1DE} | X
= Static Stack Analyzer == a
List Call graph
Hide dead code
|
Function v Local cost Type Location Info A
9 main 88 STATIC  main.c:79
@ TIM_TI1_SetConfig 16 STATIC  stm32fdxx_hal_tim.c:4540
@ TIM_SlaveTimer_SetConfig 12 STATIC ~ stm32fdxx_hal_tim.c:4983
o TIM_CCxChannelCmd 8 STATIC  stm32fdxx_hal_tim.c:4739
© TIM_Base_SetConfig 0 STATIC  stm32f4xx_hal_tim.c:4481
@ Systemlnit 0 STATIC ~ system_stm32fdxx.c:148
© HAL_TIM_TriggerCallback 0 STATIC  stm32fdxx_hal_tim.c:4364
@ HAL_TIM_SlaveConfigSync... 16 STATIC  stm32fdxx_hal_tim.c:4143
@ HAL_TIM_ReadCapturedVal... 0 STATIC  stm32fdxx_hal_tim.c:4217
@ HAL_TIM_PeriodElapsedCal... 0 STATIC  stm32fdxx_hal_tim.c:4304
o HAL_TIM_PWM_PulseFinish... 0 STATIC  stm32fdxx_hal_tim.c:4349
© HAL_TIM_OC_DelayElapsed... 0 STATIC  stm32fdxx_hal_tim.c:4319
o HAL_TIM_IRQHandler 8 STATIC  stm32fdxx_hal_tim.c:2809
o HAL_TIM_IC_Start_IT 8 STATIC  stm32f4xx_hal_tim.c:1672 v
< >
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9.2
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The Call Graph tab contains an expandable list with functions included in the program. Lines representing
functions calling other functions can be expanded to see the call hierarchy.

Figure 242. Static Stack Analyzer Call Graph tab

= Static Stack Analyzer °
STMG2F 4o Nuclo.of - STMO2F i NuleolDebug - Ot 75 2019 120309 P
List Call graph
main
Function Max cost
< UsageFault_Handler
$¥ADC_IRQHandler
$¥BusFault_Handler
$¥HardFault_Handler
<r MemManage_Handler
[sis Reset_Handler
@ TIM4_IRQHandler
© NMI_Handler
© PendSV_Handler
s frame_dummy
@ SysTick_Handler
@ SVC_Handler
© DebugMon_Handler
ln__do_global_dtors_aux
oo _fini

Depth

v v

v
CO0OO0OO0O0O0O0O®a N~~~ =

OO 0O =000 W™~~~
OC0OO0OO0OO0OO0O0OO0O0OO0OO0 OO o

Local cost  Type

Location
STATIC  stm32fdxx_it.c:116
STATIC
STATIC
STATIC

stm32fdxx_it.c:103
stm32fdxx_it.c:77
stm32fdxx_it.c:90

STATIC
STATIC
STATIC

stm32fdxx_it.c:173
stm32f4xx_it.c:68
stm32fdxx_it.c:147

STATIC
STATIC
STATIC

stm32fdxx_it.c:156
stm32fdxx_it.c:129
stm32fdxx_it.c:138

Search... [V] Case sensitive

Info

Max cost uncertain. Recursive

Max cost uncertain. Recursive. No stack usage information available for this ...
Max cost uncertain. Recursive

Max cost uncertain. Recursive

Max cost uncertain. Recursive

Max cost uncertain. No stack usage information available for this function
Max cost uncertain

Max cost uncertain. No stack usage information available for this function

Max cost uncertain. No stack usage information available for this function
Max cost uncertain. No stack usage information available for this function

Using the Static Stack Analyzer

The Static Stack Analyzerview is by default open in the C/C++perspective. If the view is closed, it can be opened
from the menu. Select the menu command [Window]>[Show View]>[Static Stack Analyzer]. Another way to
open the Static Stack Analyzerview is to type “Static Stack Analyzer” in the [Quick Access search bar] and

select it from the views.

Figure 243. Open the Static Stack Analyzer view

E workspace_um1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE

File Edit Source Refactor Navigate Search Project Run Window Help

Bl ~R~@ivi@idig~-¢

& Project Explorer
v EZNUCLEO-F401RE
> ¥ Binaries
> wiIncludes
v #Core
> &lInc
v §=Src
> g main.c
> [g stm32f4xx_hal_msp.c
> lgstm32fdxx_it.c
» [ syscalls.c
> g sysconf.c
> ld sysmem.c
>l system_stm32f4xx.c
> =Startup
> (& Drivers
v (=Debug

New Window
Editor
Appearance

Show View

Perspective
Navigation

Preferences

W

W

& vi AE :-_-v..vQ:@var_‘)ﬂ

& main.c = STM32F40
.

¢ Build Analyzer

@ Build Targets

B C/C++ Projects

£ Console

-

g stm32f4xx_it.c

Alt+Shift+Q, C
% Include Browser

% Navigator (Deprecated)
&= Outline

& Problem Details

{2l Problems

‘3 Project Explorer

[T Properties

% Search

&= SFRs

= Static Stack Analyzer

¥ Tasks

Other...

Alt+Shift+Q, O

Alt+Shift+Q, X

Alt+Shift+Q, S

Alt+Shift+Q, Q
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The Static Stack Analyzer view is populated when a built project is selected in the Project Explorer. The project
must be built with option [Generate per function stack usage information] enabled, otherwise the view cannot
present any stack information.

How to setup the compiler to generate stack usage information is explained in the next section.

9.21 Enable stack usage information

If the top of the view displays the message No stack usage information found, please enable
in the compiler settings, the build configuration must be updated for the compiler to generate stack
information:

1. Open the project properties, for instance with a right-click on the project in the Project Explorer view

2.  Select Properties and, in the dialog, select [C/C++ Build]>[Settings]
3.  Select the Tool Settings tab
4. Select [MCU GCC Compiler]>[Miscellanous]
5. Select [Enable stack usage information (-fstack-usage)] as shown in Figure 244
6. Save the setting and rebuild the program
Figure 244. Enable generate per function stack usage information
[ZH properties for NUCLEO-F401RE O X
‘type filter text Settings R A
> Resource
v C/C++ Build -
Build Variables Configuration: Debug [ Active | ~ Manage Configurations...
Discovery Options
Environment .
Lodi & Tool Settings # Build Steps Build Artifact Binary Parsers @ Error Parsers <
ogging
Settings EMCU Settings Other flags 8D DE 8
» C/C++ General _ EMCU Post build outputs
CMSIS-SVD Settings v ®MCU GCC Assembler
Project References # General
Refactoring History Debugging
Run/Debug Settings (= Preprocessor

#Include paths

(#Miscellaneous
v ®MCU GCC Compiler

(= General

(2 Debugging

(& Preprocessor

ZlInclude paths

(#Optimization

(#Warnings

(**Miscellaneous
v ®MCU GCC Linker

(= General

(= Libraries

(2 Miscellaneous

[ verbose (-v)
[1Position Independent Code (-fPIC)
Enable stack usage analysis (-fstack-usage)

Restore Defaults Apply

@ Apply and Close Cancel
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9.2.2 List tab

The List tab contains a list of all functions included in the selected program with options to [Hide dead code]
functions and [Filter] visible functions.

Use the [Hide dead code] selection to enable or disable the listing of dead code functions.
If used, the [Filter] field restricts the display to functions matching the characters it contains.

Figure 245. Static Stack Analyzer List tab

10E | O X
= Static Stack Analyzer == 0
NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Oct 25, 2019 1:58:05 PM

List Call graph

[[JHide dead code

Function Local cost  Type Location Info I~

@ SystemClock_Config 88 STATIC  main.c:410

@ HAL_RCC_MCOConfig 56 STATIC  stm32fdxx_hal_rcc.c:749

@ MX_GPIO_Init 48 STATIC  main.c:487

@ HAL_UART_Msplnit 48 STATIC  stm32f4xx_hal_msp.c:88

@ HAL_DMA_PollForTransfer 48 STATIC  stm32f4xx_hal_dma.c:612

@ main 40 STATIC  main.c:183

@ NVIC_EncodePriority 40 STATIC  core cm4.h:1863

@ NVIC_DecodePriority 40 STATIC  core_cm4.h:1890

@ HAL_FLASH_Program 40 STATIC  stm32fdxx_hal_flash.c:156

@ HAL GPIO _Init 40 STATIC  stm32f4xx_hal_gpio.c:171

@ HAL_RCC_GetSysClockFreq 40 STATIC  stm32f4xx_hal_rcc.c:859

@ HAL_UART _Transmit 40 STATIC  stm32f4xx_hal_uart.c:1019

@ HAL UART Receive 40 STATIC  stm32f4xx_hal uart.c:1101

@ HAL_UART_IRQHandler 40 STATIC  stm32f4xx_hal_uart.c:1998

& niviba 22 CTATIC rain ~1NA N

The column information in the List tab is described in Table 26.

Table 26. Static Stack Analyzer List tab details

=

Function | Function name.
Local cost The number displays how many bytes of stack the function uses.

Tells if the function uses a STATIC or DYNAMIC stack allocation. When DYNAMIC allocation is used the actual

Type stack size is run-time dependent and the the Local cost value is uncertain due to the dynamic size of stack.
. Indicates where the function is declared. It is possible to double-click on a line and open the file with the defined
Location g )
function in the editor.
Info Additional information about the calculation.

The List tab sort order can be changed by clicking on a column name.

Note: By double-clicking on a line that displays the file location and line number in the List tab, the function is opened
in the Editor view.
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Call Graph tab

The Call Graph tab contains detailed program information in a tree view. Each function included in the program
but not called by any other function is presented at the top level. It is possible to expand the tree to see called
functions. Only functions available in the e1 £ file can be visible in the tab.

When used, the [Search...] button triggers the display of the functions matching the characters in the search field.
The search can be made case sensitive or not depending on the selection in checkbox [Case sensitive].

Figure 246. Static Stack Analyzer Call Graph tab

= o X
= Static Stack Analyzer ©®°0
NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Oct 25, 2019 1:58:05 PM
List Call graph
Search... [/] Case sensitive
Function Depth Max cost  Local cost  Type Location Info Q
$¥ADC_IRQHandler ? ? 0 Max cost uncertain. Recursive. No stack usage information available for this...
> [as Reset_Handler 16 248 0 Max cost uncertain. No stack usage information available for this function
> [a__swrite 3 48 0 Max cost uncertain. No stack usage information available for this function
> law__sread 2 32 0 Max cost uncertain. No stack usage information available for this function
> [a__sseek 2 24 0 Max cost uncertain. No stack usage information available for this function
> [ao__sclose 2 16 0 Max cost uncertain. No stack usage information available for this function
> © SysTick_Handler 1 12 8 STATIC  stm32fdxx_it.c:182
© NMI_Handler 0 4 4 STATIC  stm32fdxx_it.c:70
© DebugMon_Handler 0 4 4 STATIC  stm32fdxx_it.c:156
© MemManage_Handler 0 4 4 STATIC  stm32fdxx_it.c:98
© UsageFault_Handler 0 4 4 STATIC  stm32fdxx_it.c:128
@ PendSV_Handler 0 4 4 STATIC  stm32fdxx_it.c:169
© BusFault_Handler 0 4 4 STATIC  stm32fdxx_it.c:113
© HardFault_Handler 0 4 4 STATIC  stm32fdxx_it.c:83
©® SVC_Handler 0 4 4 STATIC  stm32fdxx_it.c:143
[ frame_dummy 0 0 0 Max cost uncertain. No stack usage information available for this function v

The column information in the Call Graph tab is described in Table 27.

Table 27. Static Stack Analyzer Call Graph tab details

= =

Function | Function name.

Specifies the call stack depth this function uses:
Depth 0: the function does not call any other functions
P . Number = 1: the function calls other functions

. ?: the function makes recursive calls or the depth cannot be calculated
Max cost | Specifies how many bytes of stack the function uses including stack needed for called functions.

Specifies how many bytes of stack the function uses. This column does not take into account any stack that may
be needed by the functions it may call.

Specifies if the function uses a STATIC or DYNAMIC stack allocation.

. STATIC: the function uses a fixed stack

. DYNAMIC: the function uses a run-time dependent stack

. Empty field: no stack usage information available for the function

Local cost

Type

Indicates where the function is declared. It is possible to double-click on a line and open the file with the defined

Location function in the editor.

Contains specific information about the stack usage calculation. For instance, it can hold a combination of the
following messages:

. Max cost uncertain:the reason can be that the function makes a call to some sub-function where
the stack information is not known, the function makes recursive calls, or others
Info . Recursive: the function makes recursive calls
. No stack usage information available for this function: no stack usage
information available for this function

. Local cost uncertain due to dynamic size, verify at run-time:the function
allocates stack dynamically, for instance depending on a parameter
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The Call Graph tab sort order can be changed by clicking on a column name.
By double-clicking on a line that displays the file location and line number in the tab, the function is opened in the
Editor view.

Note: The main function is usually called by the Reset Handler and can in those cases be seen when expanding
the Reset Handler node.

If unused functions are listed in the tab, check if linker option [dead code removal] is enabled to remove unused
code from the program. Read more on this in Section 2.5.2 Discard unused sections.

The small icon left of the function name in column Function column indicates the following:
. Green dot: the function uses STATIC stack allocation (fixed stack).
. Blue square: the function uses DYNAMIC stack allocation (run-time dependent).

. 010 icon: used if the stack information is not known. This can be the case for library functions or assembler
functions.

. Three arrows in a circle: used in the Call Graph tab when the function makes recursive calls.

Figure 247. Function symbols in Static Stack Analyzer

= Static Stack Analyzer
NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug
List Call graph

Function Depth
“FADC_IRQHandler ?
v [ Reset_Handler 16
v i LoopCopyDatalnit 15
v [ LoopFillZerobss 14
v @ main
» @ SystemClock_Config
> @ MX_USART2_UART _Init
> @ MX_GPIO Init
@ SystemCoreClockUpdate
> [aiprintf
@ readTemp
@ readSpeed
@ writeSpeed
@ writeTemp
@ Systemlnit
[sis FillZerobss

OOOOOO;O—‘J—‘-LH—\

9.24 Using the filter and search field

The List and Call Graph tabs contain a filter/search field, which can be used to search a specific function or
functions matching the characters entered in the field.
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Figure 248 displays the List tab where the [Filter] field is used to seek functions containing the “read” string in
their name.

Figure 248. Static Stack Analyzer List tab using search

10E} O X

=0

= Static Stack Analyzer

NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Oct 25, 2019 1:58:05 PM
List Call graph
Hide dead code

‘ read|

Function Local'cost Type Location Info
@ read 32 STATIC  syscalls.c:97

@ readSpeed 16 STATIC  main.c:133

@ readTemp 16 STATIC  main.c:146

Figure 249 shows a use example of the [Search...] field in the Call Graph tab for filtering functions with name
matching the “read” string.

Figure 249. Static Stack Analyzer Call Graph using search

10 [m} X
= Static Stack Analyzer ®°8
NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Oct 28, 2019 1:09:29 PM
List Call graph
read Search... @ Case sensitive
Function v Depth Max cost  Local cost  Type Location Info A
© _read 0 32 32 STATIC  syscalls.c:97
> lw__sclose 2 16 0 Max cost uncertain. No stack usage information available for this function
I __do_global_dtors_aux 0 0 0 Max cost uncertain. No stack usage information available for this function
© UsageFault_Handler 0 4 4 STATIC  stm32fdxx_it.c:128
> @ SysTick_Handler 1 12 8 STATIC  stm32f4xx_it.c:182
© SVC_Handler 0 4 4 STATIC  stm32f4xx_it.c:143
v Reset_Handler 16 232 0 Max cost uncertain. No stack usage information available for this function
v [ LoopCopyDatalnit 15 232 0 Max cost uncertain. No stack usage information available for this function
v s LoopFillZerobss 14 232 0 Max cost uncertain. No stack usage information available for this function
v @ main 13 232 32 STATIC  main.c:183 Max cost uncertain
© writeTemp 0 16 16 STATIC  main.c:164
© writeSpeed 0 16 16 STATIC  main.c:156
© readTemp 0 16 16 STATIC  main.c:146
© readSpeed 0 16 16 STATIC  main.c:133
> iprintf 12 24 0 Max cost uncertain. No stack usage information available for this function
© SystemCoreClockUpdate 0 32 32 STATIC  system_stm32f4xx.c:239
> @ SystemClock_Config 5 200 88 STATIC  main.c:410 Max cost uncertain o
< >
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9.2.5 Copy and paste

The data in the List tab can be copied to other applications in CSV format by selecting the rows to copy and
typing Ctrl+C. The copied data can be pasted into another application with the Ctrl+V command.

Figure 250. Copy and paste

10} O X
= Static Stack Analyzer ®=e
NUCLEO-F401RE.elf - /NUCLEO-F401RE/Debug - Oct 25, 2019 1:58:05 PM

List Call graph

Hide dead code

Function Local cost  Type Location Info N

@ SystemClock_Config 88 STATIC  main.c:410

@ MX_GPIO_|nit 48 STATIC  main.c:487

@ HAL_UART_Msplnit 48 STATIC  stm32f4xx_hal_msp.c:88

@ main 40 STATIC  main.c:183

@ NVIC_EncodePriority 40 STATIC  core_cm4.h:1863

@ HAL_GPIO_Init 40 STATIC  stm32f4xx_hal_gpio.c:171

@ HAL_RCC_GetSysClockFreq 40 STATIC  stm32fdxx_hal_rcc.c:859

© _write 32 STATIC  main.c:106

@ read 32 STATIC  syscalls.c:97

@ _write 32 STATIC  syscalls.c:109

@ SystemCoreClockUpdate 32 STATIC  system_stm32f4xx.c:239 ~

The Ctrl+C copy of the lines selected in Figure 250 provides the Ctrl+V results below:

"SystemClock Config";"88";"STATIC"; "main.c:410";""
"main";"40";"STATIC";"main.c:183";""
"HAL GPIO Init";"40";"STATIC";"stm32fd4xx hal gpio.c:171";""
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10 Installing updates and additional Eclipse® plugins

10.1 Check for updates

STM32CubelDE checks for available updates regularly and opens the Available Updates dialog when a new
update is detected. It is also possible to check for updates manually. Use menu [Help]>[Check for Updates] to
check if new software is available.

When updates are found, select the update to install and press [Next].

Figure 251. STM32CubelDE available updates

[F Available Updates O X
Available Updates H0>
A\
Check the updates that you wish to install. @
Name Version Id
@STMSZCubeIDE 1.02 com.st.stm32cube.ide.mcu.rcp.product
Select All ‘ ‘ Deselect All
Details
@ o [
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’ l Check for updates
Update details is displayed. Review and confirm the update. Press Next.
Figure 252. STM32CubelDE update details
EAvaiIabIe Updates O X
Update Details /<l>
AN
Review and confirm the updates. @
Name Version Id R
v [ STM32CubelDE 1.0.2 com.st.stm32cube.ide.mcu.rcp.prod...
@: STM32CubelDE ARM Toolchain Definition 1.0.2.201907121423 com.st.stm32cube.ide.feature.mcu.t...
@: STM32CubelDE Build 1.0.2.201907091052 com.st.stm32cube.ide.feature.mcu....
(- STM32CubelDE Build Analyzer 1.0.2.201907120816 com.st.stm32cube.ide.feature.mcu....
> @:STMSZCubeIDE Build UI 1.0.2.201907092029 com.st.stm32cube.ide.feature.mcu....
@: STM32CubelDE C/C++ Debugging Tools for MCU 1.0.2.201907120816 com.st.stm32cube.ide.feature.meu....
@: STM32CubelDE C/C++ Embedded Development Tools for MCU  1.0.2.201907121423 com.st.stm32cube.ide.feature.mcu.i...
@: STM32CubelDE Common Mx Services 1.0.2.201907091052 com.st.stm32cube.ide.feature.com...
@: STM32CubelDE Common Services 1.0.2.201907091052 com.st.stm32cube.ide.feature.com...
@: STM32CubelDE Common Ul 1.0.2.201907120816 com.st.stm32cube.ide.feature.com...
@: STM32CubelDE Common Utilities 1.0.2.201907091052 com.st.stm32cube.common.feature.... -
i
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Size: Unknown

Details

@ ‘ < Back ” Next > | Finish

Review Licenses details are displayed. Review the licenses, select [| accept the terms of the license
agreements] and press [Finish] to install the update.

Figure 253. STM32CubelDE update review licenses

[ Available Updates O X
Review Licenses /(L>
A
Licenses must be reviewed before the software can be installed. This includes licenses for software required to complete the install. @
Licenses: License text:
v Eclipse Foundation Software User Agreement ~ || STMicroelectronics Software License Agreement ~
Marketplace Client 1.7.7.v20190521-1752
v STMicroelectronics Software License Agreement SLA0048 Revd/March 2018

STM32CubelDE 1.0.2

STM32CubelDE ARM Toolchain Definition 1.0.2.201907121423
STM32CubelDE Build 1.0.2.201907091052

STM32CubelDE Build Analyzer 1.0.2.201907120816
STM32CubelDE Build Ul 1.0.2.201907092029

BY INSTALLING COPYING, DOWNLOADING, ACCESSING OR
OTHERWISE USING THIS SOFTWARE PACKAGE OR ANY PART
THEREOF (AND THE RELATED DOCUMENTATION) FROM
STMICROELECTRONICS INTERNATIONAL N.V, SWISS BRANCH
AND/OR ITS AFFILIATED COMPANIES (STMICROELECTRONICS), THE

STM32CubelDE C/C++ Debugging Tools for MCU 1.0.2.201907120816 RECIPIENT, ON BEHALF OF HIMSELF OR HERSELF, OR ON BEHALF
STM32CubelDE C/C++ Embedded Development Tools for MCU 1.0.2.2019071 OF ANY ENTITY BY WHICH SUCH RECIPIENT IS EMPLOYED AND/OR
STM32CubelDE Common Mx Services 1.0.2.201907091052 ENGAGED AGREES TO BE BOUND BY THIS SOFTWARE PACKAGE
STM32CubelDE Common Services 1.0.2.201907091052 LICENSE AGREEMENT.

STM32CubelDE Common Ul 1.0.2.201907120816
STM32CubelDE Common Utilities 1.0.2.201907091052
STM32CubelDE Core Toolchain Helper 1.0.2.201907091052

< > O do not accept the terms of the license agreements

® 1 accept the terms of the license agreements

@ Next > Finish | ‘ Cancel
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The progress bar displayed at the bottom of the STM32CubelDE window shows the installation completion rate.
Restart STM32CubelDE when the update is finished.

10.2 Install from the Eclipse® market place

It is possible to install additional third-party Eclipse® plugins in STM32CubelDE using the Eclipse Marketplace. To
install from Eclipse Marketplace, select menu [Help]>[Eclipse Marketplace...].

Figure 254. Eclipse Marketplace menu

Eworkspace_um1 - NUCLEO-F401RE/Core/Src/main.c - STM32CubelDE

File Edit Source Refactor Navigate Search Project Run Window Help

5 v . B Information Center e
- . @ Help Contents
‘& Projec % Search re?cmtl
Show Contextual Help figur
) o ) Clock
Show Active Keybindings... Ctrl+Shift+L | ~Jnec
ENU “x Tips and Tricks...
y 2 Cheat Sheets... R COC
> @ @ Eclipse User Storage ‘Open the Eclipse Marketplace Wizard|
“% Check for Updates R COL
veal® Chec p
. @ Install New Software... o
. 7 Eclipse Marketplace... tlall_
Data Refresh 0_Ini
Check for Updates
Manage embedded software packages RT2_L
ST-LINK Upgrade R COC
R CoC

[ About STM32CubelDE
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The Eclipse Marketplace dialog opens. Search for the plugin or use the tabs (Recent, Popular, Favorites) to find
the software wanted and install it.

Figure 255. Eclipse marketplace

[ Eclipse Marketplace O X
Eclipse Marketplace @
Select solutions to install. Press Install Now to proceed with installation.

Press the "more info" link to learn more about a solution.

Search Recent Popular Favorites Installed . Giving loT an Edge

Darkest Dark Theme with DevStyle Cl 2019.9.16 "

- Darkest Dark is now DevStyle - a free plugin providing an enhanced set of experiences for
Sl Eclipse. Included:  Darkest Dark theme - #1 in the Marketplace: True.. more info

by Genuitec, LLC, Commercial - Free
dark theme Darkest Dark Genuitec

#3048 # Installs: 987K (41,486 last month) Install

Spring Tools 4 - for Spring Boot (aka Spring Tool Suite 4)

4.4.1.RELEASE
‘ Spring Tools 4 is the next generation of Spring Boot tooling for your favorite coding v
Marketplaces
4
= e
@ < Back Install Now > Finish Cancel

Wait until the installation is finished and restart STM32CubelDE.

10.3 Install using [Install new software...]
Another way to install new software is to use menu [Help]>[Install New Software...].

Note: When installing a new toolchain, it is recommended to use the Toolchain Manager described in
Section 2.11 Toolchain Manager.
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Figure 256. Install new software menu

Eworkspace_um‘l - NUCLEO-F401RE/Core/Src/main.c - STM32Cube

File Edit Source Refactor Navigate Search Project Run Window Help
= v 1 @ Information Center

@ Help Contents
% Search

Show Contextual Help

‘& Projec
> Emyl

v [ENU
> i Show Active Keybindings... Ctrl+Shift+L

> @ #5 Tips and Tricks...
« ca( Cheat Sheets... ;

T TR

, @ Eclipse User Storage >
+ ‘@ Check for Updates -
4 Install New Software...
& Eclipse Marketplace...
Data Refresh
Check for Updates
Manage embedded software packages
ST-LINK Upgrade

L About STM32CubelDE

™

The Install dialog opens. Enter the plugin update site URL. If the URL is not known, use [--All Available Sites--].

Figure 257. Install new software

[EE install m} X

Available Software l |
[t}

Select a site or enter the location of a site.

Work with:” T v Add... Manage...
- type or select a site

(type filter t__a|l Available Sites-- L selectAll

Name http://download.eclipse.org/mpc/releases/1.7.7 Deselect All

OoTh http://download.eclipse.org/usssdk/updates/release/latest
http://sw-center.st.com/stm32cubeide/updatesite1
https://download.eclipse.org/releases/2019-09
http://www.genuitec.com/updates/devstyle/ci/

Details
Show only the latest versions of available software Hide items that are already installed
Group items by category What is already installed?

[[] show only software applicable to target environment

Contact all update sites during install to find required software

©) < Back Next > Finish Cancel
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If no direct Internet connection is available, the plugin can be downloaded into an archive on a computer with an
Internet connection, and then manually transferred to the computer with an STM32CubelDE installation. Add the
archived file by clicking on the [Add...] button and then select [Archive and select the downloaded file].

Figure 258. Install new software from computer

[iH Add Repository X
Name: ‘ ‘ ‘ Local... |
Location: ‘ http:// ‘ Archive...

@ Add Cancel

Select the appropriate plugins and install the software. Restart STM32CubelDE when installation is finished.
Remember:  Not all Eclipse® plugins are compatible with STM32CubelDE.

10.4 Uninstalling installed additional Eclipse® plugins
To uninstall a plugin that is no longer needed, select menu [Help]>[About STM32CubelDE].

Figure 259. About STM32CubelDE

[ About STM32CubelDE m| X

!ﬁ 5TM32CubelDE

Version: 1.4.0.20rc1

STM32 i' Build: 7141_20200610_1836 (UTC)

CubelDE (C) 2019 STMicroelectronics ALL RIGHTS RESERVED

SRS A v

(?)  Installation Details
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Press the [Installation Details] button to open the STM32CubelDE Installation Details dialog.

Figure 260. Installation details

ESTM3ZCubeIDE Installation Details [m] X

Installed Software Installation History Features Plug-ins Configuration

type filter text

Name Version Id Provider

> -DevStyle (includes Darkest Dark Theme) 1.11.0.201909171704 com.genuitec.eclipse.theming.feature feature.gr... Genuitec, LLC

> §-STM32CubelDE 1.1.0 com.st.stm32cube.ide.mcu.rcp.product

< >

DevStyle provides themes & more to enhance Eclipse’s style, including
the #1 Darkest Dark theme.

@ Update... Uninstall... Properties

Select the plugin to uninstall in the Installed Software tab and press [Uninstall...]. Restart STM32CubelDE when
the uninstallation is finished.

10.5 Update to new CDT™

When a new version of STM32CubelDE is installed based on a new version of Eclipse®, CDT™ or both, it
is recommended to create a new workspace instead of using a former workspace. The following warning is
displayed when trying to use an old workspace with a new STM32CubelDE.

Figure 261. Older workspace version warning

m Older Workspace Version X
@ Workspace 'C:/Users/ ~  /STM32CubelDE/workspace_um' was written with an older version of
the product and will be updated. Updating the workspace can make it incompatible with older

versions of the product.

Continue with this workspace?

D Do not warn again about workspace versions

Continue | |Change Workspace...‘ | Exit
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Table 28. STMicroelectronics reference documents

Reference Document short name Description Document source

[ST-01] DB3871 STM32CubelDE data brief
[ST-02] RNO114 STM32CubelDE release note
[ST-03] UM2553 STM32CubelDE quick start guide
[ST-04] UM2563 STM32CubelDE installation guide
www.st.com
[ST-05] UM2578 Migration guide from to STM32CubelDE

Migration guide from System Workbench to

[ST-06] UM2579 STM32CubelDE

[ST-07] UM2576 STM32CubelDE ST-LINK GDB server

Refer to STM32CubelDE
in the “Tools” section of
wiki.st.com/stm32mpu

[ST-08] Getting started with projects based on the STM32MP1 Series in
STM32CubelDE"

Getting started with projects based on

[ST-09] AN5361 dual-core STM32H7 microcontrollers in

STM32CubelDE

Getting started with projects based on the

[ST-10] ANS394 STM32L5 Series in STM32CubelDE
Getting started with projects based on

[ST-11] AN5564 dual-core STM32WL microcontrollers in
STM32CubelDE

www.st.com
Use STM32F3/STM32G4 CCM SRAM with
IAR Embedded Workbench®, Keil® MDK-
- AN42 ’

[ST-12] % ARM, STMicroelectronics STM32CubelDE
and other GNU-based toolchains
License agreement applicable to

[ST-13] SLA0048 STM32CubelDE

[ST-14] UM1718 STM32CubeMX for STM32 configuration and

initialization C code generation

1. Legacy application note AN5360 remains available on www.st.com.
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https://www.st.com/resource/en/user_manual/dm00598966.pdf
https://www.st.com/resource/en/user_manual/dm00603964.pdf
https://www.st.com/resource/en/user_manual/dm00613834.pdf
https://www.st.com/resource/en/user_manual/dm00613836.pdf
https://www.st.com/resource/en/user_manual/dm00613038.pdf
https://wiki.st.com/stm32mpu
https://www.st.com/resource/en/application_note/dm00629855.pdf
https://www.st.com
https://www.st.com/resource/en/application_note/dm00652038.pdf
https://www.st.com/resource/en/application_note/dm00736854.pdf
https://www.st.com/resource/en/application_note/dm00083249.pdf
https://www.st.com/sla0048
https://www.st.com/resource/en/user_manual/dm00104712.pdf
https://www.st.com/resource/en/application_note/dm00629854.pdf
https://www.st.com
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Table 29. External reference documents

Reference Description Document source

[EXT-01] GNU Assembler

[EXT-02] GNU Compiler Collection

[EXT-03] GNU C Library

[EXT-04] GNU C Preprocessor

[EXT-05] GNU Linker

[EXT-06] GNU Binary Utilities GNU tool suite!"
[EXT-07] Red Hat Newlib C Library

[EXT-08] Red Hat Newlib C Math Library

[EXT-09] Newlib nano readme

[EXT-10] Debugging with GDB

[EXT-11] GDB Quick Reference Card

[EXT-12] GNU Tools for STM32 Patch list Information Center

1. For GNU documentation principles, refer to www.gnu.org.
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Table 30. Document revision history

24-Jul-2020 1 Initial release.
Document updated for STM32CubelDE v1.5.0:
. Only one toolchain installed by default
. The SFRs view displays Arm® Cortex® core registers node
. Debug with OpenOCD supports SWV and live expressions
2-Nov-2020 2 . Added Preferences - Build variables

. Added Toolchain Manager

. Added RTOS-aware debugging with FreeRTOS™ information
. Added General debug and run launch flow

. Added Post-build with makefile targets

Document updated for STM32CubelDE v1.6.0:

. Added the Azure RTOS ThreadX section into chapter RTOS-aware
debugging. Reorganized the FreeRTOS section

. Updated the Toolchain Manager section for the support of local
toolchains
18-Feb-2021 3 . Updated the Project C/C++ build settings section, MCU toolchain
selection moved
. Updated Information Center
. Updated the entire document for the “SWV packet” terminology
. Updated References

. Removed Section 4.3.3 SWV Exception Timeline Graph

Document updated for STM32CubelDE v1.7.0:

. Added Section 2.7 Thread-safe wizard for empty projects and CDT
projects

. Added Section 3.8 Import STM32 Cortex-M executable
. Added Section 6.3 RTOS-kernel-aware debug

. Updated Information Center — Home page
5-Jul-2021 4 . Updated Headless build description
. Updated Section 2.5.6 Linker script with new memory map layout figure
and additional description
. Updated Position-independent code description

. Updated debug configuration descriptions for ST-LINK GDB server,
OpenOCD and SEGGER in Debug using different GDB servers

. Updated FreeRTOS Task List view

Document updated for STM32CubelDE v1.8.0:
. Added Section 1.3.3 Videos
. Added Section 6.1.10 Azure RTOS TraceX tool

17-Nov-2021 5

. Updated Section 2.2.2 Creating a new STM32 static library project

. Removed Section 1.3.3 Technical documentation and Section 1.3.4

Closing the Information Center

Document updated for STM32CubelDE v1.10.0:

. Updated Table 2. Key shortcut examples

. Added a note in Section 2.5.7.3 Place variables at specific addresses
13-Jun-2022 6 about the possible linker garbage collection of nonreferenced variables

. Updated figures about debug configurations and tabs: Figure 137,
Figure 143, Figure 145, Figure 146, Figure 147, Figure 148, Figure 156,
Figure 164, and Figure 223
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